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Getting Started 
Introduction 
The Mx3000P™ real-time PCR system is a fully integrated real-time PCR detection system. The 
system includes a state-of-the-art thermal cycler, a quartz-tungsten halogen lamp to excite 
fluorescence, a photomultiplier tube for high-sensitivity detection, and real-time quantitative 
detection and analysis software. With the Mx3000P real-time PCR system, monitoring PCR in 
real time is fast, easy, and reliable. The Mx3000P system has an open format that allows closed-
tube real-time PCR detection with many detection chemistries including SYBR® Green dye and 
fluorogenic probe systems. The Mx3000P system supports both real-time and plate-read 
experiments.  

The software features a variety of specific experiment types with customized plate setup, thermal 
profile setup, and analysis screens that streamline the process of collecting and analyzing data for 
specific applications. Some of the features that differentiate the Mx3000P real-time PCR system 
from other real-time detection instruments include the following: 

• View and analyze data in multiple formats, including: amplification plots, scatter plots, 
sample value screens that display all dyes for the entire plate, fluorescence intensity 
screens, final call results, melting curves, annealing range and text reports 

• Enhanced analysis algorithms, including adaptive baseline, to improve results and reduce 
the need for manual adjustments 

• Melting curve analysis for Molecular Beacon confirmation with automatic melting 
temperature (Tm) calculation 

• Ability to plot individual dyes and wells from an experiment without exporting data  

• Real-time amplification plots can be viewed and results analyzed during PCR run 

• All results available as raw data 

Real-Time Experiments 

Real-time experiments monitor and report the accumulation of PCR product, as detected by 
increased fluorescence, during thermal cycling. Data collection during the early exponential 
phase of PCR allows the software to accurately calculate initial template quantities. In addition, 
the status of the experiment may be monitored as the run progresses. 

Plate Read Experiments 

Plate read experiments add flexibility to the laboratory. A one-time fluorescence reading can be 
taken on a set of samples and the results viewed immediately. The Mx3000P system can also be 
used to take and analyze pre-cycling and post-cycling readings for a set of samples that are 
cycled in another thermal cycler. 

Revision #044002 Copyright © 2004 by Stratagene. 
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Getting Started 

Getting Started with the Mx3000P Instrument 

Instrument Status Indicator LED’s  

The status indicators on the front of the Mx3000P instrument consist of two LED's.  

The lower LED is a power status indicator. When this LED is lit, the Mx3000P instrument is 
plugged in and powered on. 

The upper LED is a ready status indicator for the instrument and has three separate modes.  

Steadily lit mode: the Mx3000P control software is operational and the unit is ready to run an 
experiment. 

Blinking mode: The unit is not currently available to run an experiment. Either an experiment is 
already in process or a self-test is being conducted. 

Off mode: The unit is not currently available to run an experiment. Either the power is off or the 
Mx3000P instrument control software is not operational. 

Cautions and Warnings 

Safety Symbols  

 
On/Off power supply indicator 

 

Caution 

 

Caution, hot surfaces 

 

Other Warnings 

Be careful when loading or unloading samples from the thermal block; the thermal block can be 
hot. 

Never touch the glass areas of the filters or the lamp. 

Do not open the instrument door during a run. When an experiment is running on the instrument 
the upper LED on the instrument front is in blinking mode. Opening the door while the 
instrument is running will abort the run. A warning dialog box will appear on screen if the door 
has been opened and the run has been aborted. 

Mx3000P™ Real-Time PCR System 2 
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Sample Loading and Unloading 

Mx3000P Thermal Block Hardware 

Use care when loading and unloading the samples; the thermal block can be hot.  

Prior to loading samples, verify that the status LED (upper LED on the instrument front) is 
solidly lit (glowing green), indicating that the instrument is Ready for use. (If the LED is not 
illuminated, the instrument is not powered on. If the LED is blinking, the instrument is warming 
up or a run is in progress and the door should not be opened.) 

Open the door located at the front of the instrument by sliding it all the way to the top.  

Open the hot-top assembly to expose the thermal block by pulling forward on the hot-top handle 
and then lifting the hot-top up and away from the thermal block. The hot-top assembly is shown 
below in the closed (left) and opened (right) positions. 

Note The hot-top assembly houses a 96-hole grid (used by the instrument for light path entry) 
which may be mistaken for a thermal block. Ensure that the hot-top is raised, exposing the 
thermal block, prior to loading samples. 

                                                              

Use of the Perfect Fit Frame with Single Tubes and Strip Tubes 

When using individual tubes or strip tubes, insert the Perfect Fit frame (shown below in the 
proper orientation for installation) on the thermal block platform before loading the samples.  

Mx3000P™ Real-Time PCR System 3 
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The Perfect Fit frame optimizes the contact between the sample tubes and the hot-top. It is not 
necessary to use the Perfect Fit frame with 96-well plates. One Perfect Fit frame is supplied with 
the Mx3000P System; additional frames are available from Stratagene (Catalog #401421). 

To install the Perfect Fit frame, position the frame around the border of the thermal block. When 
properly installed, each of the six notches on the bottom of the frame will be positioned in the 
spaces between wells on the perimeter of the thermal block surface. The Perfect Fit frame should 
be seated on the thermal block platform with limited freedom of movement. There are no audible 
sounds associated with the installation. (The frame does not “click” into place.)  

Preparation of Samples Prior to Loading 

Application of Caps 

Wear powder-free gloves while applying caps to the sample containers. Caps should be placed 
on the samples before the samples are loaded into the instrument. For best results, apply the caps 
while the samples are firmly seated in a 96-well working rack. Apply direct downward force to 
each cap, and then view the rack from the side to make sure all the caps are seated evenly. 
Alternatively, caps can be applied using a Corning Storage Mat Applicator.  

Centrifugation of Samples 

Prior to loading samples in the Mx3000P thermal block, briefly centrifuge the tubes or 96-well 
plate to collect any drops of liquid on the tube sides or lid. 

Positioning of Tube Strips in the Thermal Block 

When using tube strips, the 8-tube strips must be oriented vertically in the 8-position columns. 
Do not load strip tubes horizontally within the 12-position rows. 

Consumables  

Plasticware that meets the performance specifications of the Mx3000P system may be purchased 
from Stratagene: 
96-well PCR plates, 0.2-ml, non-skirted, Stratagene Catalog #410088 
8× strip tubes, 0.2-ml, Stratagene Catalog #401428 
8×optical strip caps, Stratagene Catalog #401425 
Single PCR reaction tubes (without caps), 0.2-ml, Stratagene Catalog #410023 

Accessories 
Stratagene Centrifuges  

Tube-Strip PicoFuge®, for 8-tube 200-µl tube strips or individual 200-µl tubes [Catalog #400540 
(115-120V) Catalog #400542 (230V)]. 
96-Well Working Racks 

 96-well benchtop working racks are available from Stratagene (Catalog #410094). 
Storage Mat Applicator 

A storage mat applicator may be used for seating caps on tubes [Corning Model #3081 (sold by 
VWR Scientific, Catalog #29445-134)]. 
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Multiple Instrument Set-Up: Optional Use of Multiple 
Instrument Control  

When multiple Mx3000P instruments are used in a laboratory, the instruments may be set up to 
be controlled either each by individual computers or all by a shared computer. To set up the 
instruments using single instrument control by individual computers, simply follow the setup 
instructions provided on the Installation Guide poster or in the Setup and User’s Guide. To set up 
the instruments to be controlled by a shared computer, follow the guidelines below. 

Hardware Connections for Multiple Instrument Control 

Using the Multiple Instrument Control mode of the Mx3000P software, up to six instruments 
may be controlled simultaneously from a single computer.  

1. Assess the availability of ports on the computer for connection to Mx3000P instruments. 
Each instrument will be connected using the provided serial cable (Stratagene part #22316-
00). Any serial port on the computer may be used without any additional hardware. Any 
available USB port may also be used, after connecting the port to a USB-to-serial adapter 
(Stratagene part #22490). If additional ports are required to accommodate a greater number 
of instruments, a USB hub along with the appropriate number of USB-to-serial adapters may 
be used. 

2. Connect each of the instruments to a power source. Verify that the power switch located at 
the rear of the instrument is toggled off. Attach the power cord to the plug port, adjacent to 
the power switch. Plug the instrument into a properly grounded outlet.  

3. For each instrument, connect either end of the provided serial cable to the RS-232 serial port 
at the rear of the instrument.  

4. Connect the free end of the serial cable to the computer, connecting either to a serial port or 
to a USB port outfitted with a USB-to-serial adapter.  

5. Start-up the system. Power up each of the Mx3000P instruments using the switch located on 
the back of the instrument. Power up the PC. When the Windows® desktop appears, click on 
the Mx3000P icon to start the Mx3000P application.  

Setting Up the Mx3000P Software for Multiple Instrument Control 

To establish the associations between the computer and multiple instruments in the Mx3000P 
software, expand the Multiple Instrument Control section of the Instrument menu and then select 
Add Instruments.  

 

Note It is recommended that instruments not be running experiments while setting up multiple 
instrument control or while adjusting the settings. 
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A Wizard will guide you through the process of adding instruments. After a short series of 
advisory dialog boxes, the following dialog box will appear with newly detected instruments in 
the list. 

Clicking the Identify button associated with a particular communications port causes the front 
LED of the instrument connected to that port to flash, allowing identification of the detected 
computers in the list. 

To add an instrument to the group of instruments controlled by the computer, click the 
corresponding Add button. When the Add Instrument – COM# dialog box appears, enter the 
Instrument name and then click OK. 

 

Repeat this process for any other instruments connected to other communications ports. When all 
instruments have been added and their names entered, click Next, and the Wizard will guide you 
through completion of the process. 

Using the Mx3000P Software in Multiple Instrument Control Mode 

Selection of Instrument at Start-Up 

Once the computer has been set up to recognize multiple instruments, you will be prompted to 
specify the instrument to be used each time you launch the Mx3000P software application.  
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Each open copy of the Mx3000P application may only be connected to a single instrument. After 
launch, the specific instrument connected to the Mx3000P application is indicated in the title bar. 

 

Simultaneous Use of Multiple Instruments 

The multiple instruments controlled by a single computer may be used simultaneously by 
launching multiple copies of the Mx3000P application on the computer.  Each time an additional 
application is launched, select the appropriate instrument from the Multiple Instrument Control 
dialog box.  

 

Instruments that are unavailable are indicated by an In-Use status. Typically an instrument is 
unavailable because it is being used by another Mx3000P application. Other possible reasons 
include that the instrument is not powered on or that communications between the computer and 
the instrument are disrupted (e.g. disconnection of the serial cable or adapter).  

After launch, each copy of the application will show the connected instrument in the title bar. 
Navigate between Mx3000P applications connected to the different instruments by selecting the 
appropriate application/instrument from the Mx3000P software Window menu or by using the 
taskbar at the bottom of the screen. 

 

Administration of Multiple Instrument Control 

To add, remove or rename instruments controlled by the computer, or to change the instrument 
connected to a specific copy of the Mx3000P application, use the commands available from the 
Multiple Instrument Control section of the Instrument menu.  
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Adding an Instrument to the Group Controlled by the Computer 

Adding an instrument after initial setup involves the same steps used during the initial setup of 
multiple instrument control. First, establish the hardware connections between the new 
instrument and the computer (see Hardware Connections for Multiple Instrument Control). Next, 
complete the software setup steps, beginning by selecting Add Instruments from the Multiple 
Instrument Control menu. Follow the steps outlined by the Wizard. (See Setting Up the Mx3000P 
Software for Multiple Instrument Control, above, for more information). 
Renaming or Removing an Instrument 

To rename an instrument or to remove an instrument from the group of instruments controlled by 
the computer, select Rename/Remove Instruments from the Multiple Instrument Control menu. A 
Wizard will guide you through the process. After one or more advisory dialog boxes, the 
following dialog box will appear: 

 

To verify the identity of the instrument to be renamed or removed, click the Identify button 
associated with the instrument name. The front LED of the specified instrument will then flash. 

When ready to proceed, click the appropriate Rename/Remove button. 

To rename an instrument, select the Rename radio button, enter the new name in the box, and 
then click OK. The Wizard will guide you through completion of the process. 
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To remove the instrument, select the Remove radio button and then click OK. The Wizard will 
guide you through completion of the process, providing advice or instructions for the following 
special cases:  

If you are removing the instrument that is currently connected to the open Mx3000P application, 
the Wizard will direct you to select another instrument for connection to the application.  

If, after removing instruments, only one instrument remains connected, the Wizard will notify 
you that the computer is being switched to the single-instrument control mode. 

If you attempt to remove the last instrument, the Wizard will prevent this action, since running 
an instrument-connected version of the Mx3000P application requires that at least one instrument 
be connected to the computer. If you wish to run the application without connection to an 
instrument, open an additional Standalone copy of the Mx3000P application. 
Changing the Instrument Connected to the Software Application 

To change the instrument connected to the open copy of the Mx3000P software application, click 
Change Connected Instrument from the Multiple Instrument Control menu. When the following 
dialog box appears, select an Available instrument and then click OK. The newly selected 
instrument name will appear in the title bar for the open application. 
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Choosing a Detection Chemistry and Experiment Type 

Overview of QPCR and Detection Chemistries  

Overview of Quantitative PCR 

The quantitative PCR method represents an important technique for quantifying messenger RNA 
levels (gene expression) and DNA gene levels (copy number) in biological samples.  The amount 
of a specific target nucleic acid is generally too low in biological samples for direct detection; the 
target must therefore  be amplified by using PCR or other protocols to achieve detection. 
Endpoint analysis of PCR product accumulation does not allow accurate quantitation of the 
initial amounts of the target in the samples. As amplification proceeds, reagents may become 
limiting, PCR inhibitors may accumulate, and any small differences in PCR performance among 
samples are magnified. Thus PCR product accumulation measured at the end of cycling fails to 
accurately reflect the initial amount of target in the sample.  In contrast, in real-time quantitative 
PCR analysis, accumulation of the amplified target is monitored during the early exponential 
phase of the amplification process when reagents are not limiting, and differences due to other 
factors are minimized, providing a significantly more accurate quantification of initial RNA or 
DNA levels. Additional benefits of real-time quantitative PCR include sensitivity and a wide 
dynamic range. As few as 10 copies of an RNA target can be detected and the linearity of 
detection is greater than six orders of magnitude. 

Mx3000P system quantitative PCR experiments use fluorescence-labeled probes or SYBR Green 
I fluorescent dye for both RNA and DNA detection, allowing real-time monitoring of PCR 
product formation during the PCR amplification process in a closed-tube format.  

Detection using Fluorescence-Labeled Probes 

Fluorescence-labeled oligonucleotides, most commonly molecular beacons and TaqMan® probes, 
are employed for QPCR detection when the most accurate quantitation of PCR product 
accumulation is desired. Both of these types of probes are designed as oligonucleotides that 
contain a region complementary to a sequence within the nucleic acid sequence being amplified. 
Both also contain a fluorophore and a quencher moiety, usually at opposite ends of the 
oligonucleotide. For both probe types, fluorescence is quenched prior to amplification due to the 
action of the quencher on the fluorophore. The process of amplification separates the fluorophore 
from the quencher (using two different mechanisms that are described below), allowing the 
fluorophore to fluoresce. As a result, the amount of fluorescence at any given cycle is directly 
proportional to the amount of specific product present at that time.  

For both types of fluorescent probes, as PCR proceeds the fluorophore will produce fluorescent 
light of a color that is characteristic of the fluorophore used. The existence of a variety of 
spectrally distinct fluorophores available for labeling either molecular beacons or TaqMan 
probes introduces the possibility of multiplexing, or quantitating multiple targets with different 
probes in the same reaction well.  
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Molecular Beacons Probes  

Molecular beacons assume a hairpin-structure when free in solution, bringing the end-bound 
fluorophore and quencher into close proximity, thereby allowing quenching of the fluorescence 
signal. The binding of the probe to its target disrupts the hairpin structure, resulting in a spatial 
separation of the fluorophore from the quencher, thereby allowing fluorescence. When the DNA 
polymerase extends the upstream primer, the bound probe is displaced and resumes its hairpin 
structure. The transition from free (quenched) to quantitatively bound (fluorescent) is repeated in 
each subsequent amplification step, allowing the real-time measurement of target levels at each 
cycle.  

 
TaqMan Probes 

TaqMan probes are linear oligonucleotides which are designed to allow a close proximity of the 
fluorophore and quencher in the intact, unstructured probe. This detection chemistry employs the 
cleavage of probe molecules during the amplification process to physically separate the 
fluorophore from the quencher moiety. TaqMan probes are complementary to a region of the 
target located between the upstream and downstream primer binding sites. As the DNA 
polymerase extends the upstream primer, it encounters the bound probe. The 5' to 3' exonuclease 
activity of the polymerase cleaves the probe, releasing the fluorophore into solution, where it is 
allowed to fluoresce. Quantitative release of additional free fluorophore is repeated in each 
subsequent amplification step, allowing the real-time measurement of target levels at each cycle. 
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Detection using SYBR Green Dye 

When the most accurate quantitative data are not required, the accumulation of double-stranded 
DNA (dsDNA), as indicated by a fluorescent dsDNA-binding dye, can be used to quantitate the 
accumulation of a PCR product in a QPCR assay. The dsDNA-binding dye that is most 
commonly used in QPCR is SYBR Green I dye.  

SYBR Green I dye has a higher affinity for dsDNA than for single-stranded DNA (ssDNA) or 
RNA, making it ideal for reporting the accumulation of dsDNA. Upon binding DNA, the 
magnitude of SYBR Green fluorescence emission   increases by approximately 1000-fold, 
making this dye a sensitive indicator for the quantity of dsDNA present in the reaction mixture at 
any given time. 

Specific and non-specific double-stranded PCR products generate the same fluorescence signal 
upon binding SYBR green dye. To distinguish between fluorescence derived from specific and 
non-specific products, SYBR green dye-based QPCR assays include a dissociation curve. During 
the dissociation curve, dsDNA product is melted into ssDNA by a stepwise increase in 
temperature, with fluorescence data being collected at each step. The magnitude of the reduction 
in fluorescence intensity at the melting temperature of the specific PCR product of interest 
provides a qualitative indicator of the proportion of dsDNA attributable to the specific PCR 
product.  

A major advantage of this approach is that no fluorescence-labeled probes are required. SYBR 
Green I stain is compatible with fluorescence-detection instruments equipped with filters in the 
520 nm range (e.g. filters for detecting 6-FAM). 
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Overview of Mx3000P System Experiment Types 

Real-Time vs. Plate Read Experiments 

The Mx3000P real-time PCR system software allows you to select from a variety of experiment 
types, providing setup and analysis screens that are specialized for the specific application.  Both 
real-time experiments that monitor and report the accumulation of PCR product during thermal 
cycling, and plate-read (sometimes referred to as endpoint) experiments types are available.  

Real-Time Experiments 

Real-time experiments should be used when accurate quantitation of the levels of a specific RNA 
or DNA target is required. In real-time experiments, accumulation of the amplified target is 
monitored during the early exponential phase of the amplification process when reagents are not 
limiting, and differences due to other factors are minimized, providing a significantly more 
accurate quantification of initial RNA or DNA levels. See Overview of Quantitative PCR for a 
more detailed discussion of the advantages of using real-time analytical methods.  

Note  The term quantitative PCR is often used to describe a variety of experimental approaches 
using different detection chemistries and analysis algorithms to achieve a quantitative 
analysis of target levels by monitoring PCR product accumulation. The Mx3000P software 
includes the experiment type Quantitative PCR describing a specific assay type in which 
fluorogenic oligonucleotide probes are used to quantitate target levels by way of a 
standard curve. Other specific experiments which fall under the general usage of 
quantitative PCR are featured in other experiment types. 

The Mx3000P system includes the following specific real-time experiment types: 

• Quantitative PCR: This experiment type uses a standard curve to quantitate the amount of 
target present in an Unknown sample with high accuracy using a fluorescence-labeled 
probe for detection. A series of Standard samples, containing dilutions of a known 
amount of target, are amplified to generate a curve that relates the initial quantity of the 
specific target to the Ct. The standard curve is then used to derive the initial template 
quantity in Unknown wells based on their Ct values. This method is sometimes referred to 
as absolute quantitation or as standard-curve quantitation in the literature. This 
experiment type is also useful for primer/probe optimization experiments in the absence 
of a standard curve. 

• Comparative Quantitation: This experiment type is a form of relative quantitation, 
comparing the levels of a target gene in test samples (referred to as Unknowns) relative to 
a sample of reference (referred to as the Calibrator). For example, the Calibrator sample 
might contain RNA from untreated cells, while the Unknowns might contain RNA from 
cells treated with different agents of interest. This experiment type provides an efficient 
method for comparing levels of RNA or DNA across samples when information about 
the absolute amounts of target in any sample is not required. 
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• SYBR Green (with Dissociation Curve): This experiment type uses a standard curve to 
quantitate the amount of target present in an Unknown sample using SYBR Green I dye 
for detection. This experiment type is also useful for SYBR Green assay optimization 
experiments in the absence of a standard curve. The thermal profile includes a 
dissociation curve, used to discriminate between specific and non-specific PCR products.  

• Allele Discrimination/SNP's Real-Time: This experiment type uses fluorescence-labeled 
probes to determine the allelic composition of DNA samples. Two fluorogenic probes, 
labeled with two spectrally distinct dyes, are used to discriminate between two different 
alleles that may differ by as little as a single nucleotide. The presence or absence of a 
given allele is based on the Ct value determined for the allele-specific probe.  

• Molecular Beacon Melting Curve: This experiment type analyzes the melting 
characteristics of a molecular beacon for the determination of the experimental melting 
temperature (Tm) and optimal annealing temperature for subsequent PCR experiments. 
Melting curves are typically performed with the molecular beacon alone and in the 
presence of both perfectly-matched and mismatched oligonucleotide targets in order to 
determine the temperature that results in maximum specificity. 

Plate Read Experiments  

Plate read experiments are appropriate for applications that allow endpoint analysis of 
fluorescence values. The plate-read function may be used to take fluorescence readings for a set 
of samples that are cycled in another thermal cycler, collecting either a one-time fluorescence 
reading or pre-cycling and post-cycling readings.  

The Mx3000P software offers two specific plate-read experiment types: 

• Quantitative Plate Read: This experiment type uses a standard curve to estimate the 
amount of target present in an Unknown sample using a fluorescence-labeled probe for 
detection. A series of Standard samples, containing dilutions of a known amount of 
target, are included in the experiment to generate a curve that relates the quantity of the 
specific target to the final fluorescence reading. The standard curve is then used to 
estimate the template quantity in Unknown wells based on their fluorescence readings. 

• Plate Read/Allele Discrimination: This experiment type is used both for general plate-
reading tasks and for allele discrimination assays with endpoint detection. In both cases, 
samples may be called as positive or negative for the presence of a specific sequence 
based on whether the endpoint fluorescence readings meet user-defined statistical criteria. 
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Menu Commands 
Menu commands available in the Mx3000P real-time PCR system software are used to 
manipulate files, to customize and use the experimental setup and analysis features of the 
software, to initiate several instrument actions and to access Help functions. Click on the menu 
name below for more information on the software commands accessed through each individual 
menu. 

File Menu 

Edit Menu 

Instrument Menu 

Tools Menu 

Options Menu 

Section Menu 

View Menu 

Window Menu 

Help Menu 
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File Menu 

The File menu contains commands used to open, close, save and print files. The menu also 
contains commands for exporting and converting files as well as a list of recently-opened 
experiments. 

 

New - Create a New Experiment  

To create a new experiment, click New in the File menu, press Ctrl+N, or click the new 

experiment button  on the toolbar. The New Experiment Options dialog box will open, 
allowing you to select the type of experiment to be created. Click the radio button next to the 
desired experiment type and then click OK. Checking Turn lamp on for warm-up? will apply 
power to the lamp once OK is clicked. The lamp should be warmed-up for 20 minutes before an 
experiment is run. 
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After OK is clicked, the software will proceed to the Plate Setup screen for the specific type of 
experiment selected.  

Open - Open an Existing Experiment  

To open an existing experiment, click Open in the File menu, press Ctrl+O, or click the open 

button  on the toolbar. The Open dialog box will appear. Select the experiment to be opened. 
(Use the Look in menu to browse to other storage locations if necessary.) Click the Open button 
at the bottom of  the dialog box. 

 

Close - Close the Current Experiment 

To close an experiment without closing the Mx3000P software, click Close in the File menu. If 
the experiment has been modified, the Save Current Experiment dialog box will appear. Click Yes 
to save the changes and close the experiment, click No to close the experiment without saving 
the changes, or click Cancel to return to the experiment without saving any changes. If the Yes 
button is clicked to save the experiment, the Save As dialog box will appear, allowing you to 
specify the name that the file will be saved under. 
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Save  

To save an experiment, click Save in the File menu, press Ctrl+S, or click the save button   on 
the toolbar. If the experiment has already been saved, no dialog box will be displayed and the 
experiment will be saved under its current name. If the experiment has not already been saved, 
the Save As dialog box will open (see below), allowing you to specify a file name and directory 
for storing the experiment. 

If the experiment has not been modified since it was last saved, the Save command and button 
will be disabled. The Mx3000P software automatically saves the experiment at the end of a run, 
therefore Save is disabled at the conclusion of a run. If any changes are made to the experiment 
after completion of the run, Save will be enabled.  

To save an experiment under a different name, use the Save As command in the File menu. 

Save As 

To save a new experiment or to save an existing experiment under a new name, click Save As in 
the File menu or press Ctrl+A, and the Save As dialog box will open. If the experiment was 
previously saved, the name of the experiment will appear in the File name field where it may be 
modified. If the experiment has not yet been saved, a default file name will appear in the File 
name field. You can elect to either use the default file name or specify another file name. 
Experiment files are stored in the default data directory (C:\Program Files\Stratagene\ 
Mx3000P\Storage directory). The default storage location and the default file name structure 
may be changed on the File tabbed page of the Preferences dialog box (accessed from the Options 
menu). 
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Import Well Names 

 

Well names may be imported from a Microsoft® Excel file or from certain ASC files into the 
open experiment. The Mx3000P software associates well names with well ID’s (A1–H12) using 
a mechanism appropriate to the input file type.  

Import Well Names from Excel File 

Well names may be imported from a Microsoft Excel file formatted as shown below with 
column A containing Well ID’s and column B containing the well names to be imported. The 
Well ID’s may appear in any order but must contain the syntax A1–H12 or A01–H12. 

 

To import the well names into the Plate Setup for the open experiment, first ensure that all wells 
to be associated with an imported well name are defined (have at least a Well type assignment). 
Select Import Well Names from Excel File from the expanded File menu. When the Well Name 
Import dialog box appears, browse to the Microsoft Excel file location and then click Open.  

Well names may be visualized in the Full Screen Plate view. 

Import Well Names from ASC File 

Import Well Names from ASC File is a specialized feature that allows import of well names from 
files generated using some other automated instruments. The ASC files do not contain 
destination (well ID) information. For this reason, the destination wells are specified within the 
Mx3000P experiment and the well names must be listed in the ASC file in a specific structure. 
The supported structure of well names in the ASC file is vertical, left-to-right. In other words, 
well names imported from the ASC file are directed to user-specified wells in the Mx3000P 
experiment in the order of A1–H1, A2–H2…A12–H12.   

To use this well name import feature, first specify the destination wells using the Plate Setup 
screen. The specified wells must be defined with at least a Well type assignment. Do not assign 
replicate symbols prior to import. Select the wells to be associated with well names from the 
ASC file with the mouse on the Plate Setup screen (all defined wells or a subset of the defined 
wells may be selected).  
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Next, select Import Well Names from ASC File from the expanded File menu. The following 
dialog box will appear. Select the appropriate description of the wells to be associated with a 
well name under Import destination, and then click Continue. 

 

In the next dialog box, browse to the ASC file location, select the file name, and then click Open.  

Well names may be visualized in the Full Screen Plate view. 

Exporting Data to Other Applications 

The File menu export commands allow raw instrument data, chart data, or text report data to be 
exported to a Microsoft Excel file, a text file or an XML file in a variety of formats. In addition, 
Mx3000P software screens may be exported to Microsoft PowerPoint® or image files. Each of 
the menu items marked with arrows may be expanded to reveal output file options and 
formatting options. 
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Exporting Data to Excel  

Raw instrument data (cycle-by-cycle fluorescence readings), chart data points, or text report data 
may be exported to the Microsoft Excel application. 
Selecting Export Instrument Data to Excel, Export Chart Data to Excel, or Export Text Report to 
Excel from the File menu exports the corresponding data to Microsoft Excel. To maintain the new 
file as an Excel workbook, execute the Save As command from the Excel application and select 
the Excel workbook file type from the Save as type menu. If you exit the Excel software without 
saving the file as a workbook, then the file will be saved as a tab-delimited text file.   
Formatting options for instrument or chart data output to the Excel file are described below. 
Exporting Data to a Text File  

Raw instrument data (cycle-by-cycle fluorescence readings), chart data points, or text report data 
may be exported to a tab-delimited text (.txt) file. The text file can be opened in any word-
processing program.  
 
Formatting options for instrument or chart data output to the text file are described below. 
Exporting Data to an XML File  
Raw instrument data (cycle-by-cycle fluorescence readings), chart data points, or text report data 
may be exported to an Extensible Markup Language (XML) file to allow viewing in a browser 
window and to allow importing of the data into databases.  
Selecting Export Instrument Data to XML File, Export Chart Data to XML File, or Export Text Report 
to XML File from the File menu exports the corresponding data to an XML file (filename.xml). At 
the same time, two support files (filename.xsl and filename.xsd) are also created. All three files 
are stored in the same folder [by default, the Mx3000P data storage folder specified in the 
Preferences-File dialog box (e.g., C:\Program Files\Stratagene\Mx3000P\Storage)].  

Note The .xml, .xsl and .xsd files should be maintained in the same file directory to allow 
browser viewing. 

The XML file may be opened using your computer’s browser (typically, double-clicking on the 
XML file icon is sufficient). 
Formatting options for instrument or chart data output to the XML file are described on the 
following pages. 
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Formatting Options for Exported Instrument Data 

Three different formats are available from the Export Instrument Data to Excel and the Export 
Instrument Data to Text File and Export Instrument Data to XML File submenus. Examples of the 
three formats are shown below. 

Format 1--Columnar -- Cycle-by-cycle data are listed for each well. 

 

Format 2--Grouped by Dye -- Cycle-by-cycle data for each well are grouped by dye paths. 
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Format 3--Grouped by Wells (dye columns) -- Cycle-by-cycle data are grouped by wells with the 
data for each dye path shown in separate sets of columns. 

 

  

Formatting Options for Exported Chart Data 

Two different formats are available from the Export Chart Data to Excel and the Export Chart 
Data to Text File and Export Chart Data to XML File submenus. Examples of the two formats are 
shown below. 

Format 1—Vertically Grouped by Plot – The coordinates of each plotted data point are listed for 
each well/dye vertically. (The contents of the x- and y-coordinate columns are dependent on the 
specific chart type.) 

 

Mx3000P™ Real-Time PCR System 23 



Navigating in the Mx3000P Software 

Format 2—Horizontally Grouped by Plot – The coordinates of each plotted data point are listed 
with each well/dye shown in a separate column. (The contents of the x- and y-coordinate 
columns are dependent on the specific chart type.) 

 

Exporting Content to a PowerPoint File 

Selecting Export to PowerPoint exports the contents of the active section of the experiment to a 
Microsoft PowerPoint file. This command may be used to export the content of the screens from 
any section (Setup, Run, or Analysis) of the Mx3000P software. The PowerPoint application is 
automatically launched when this command is executed, and the content of the current screen is 
copied into a new slide. 

Exporting Content to an Image File 

Selecting Export to Image File exports the contents of the active section of the experiment to a 
bitmap (.bmp) image file. This command may be used to export the content of the screens from 
any section (Setup, Run, or Analysis) of the Mx3000P software.  By default, the new image file is 
stored in the Mx3000P data folder (e.g., C:\Program Files\Stratagene\Mx3000P\Storage) and can 
be opened using a variety of graphics applications.  

Convert to New Experiment Type  

After an experiment has been set up and run as one experiment type, the data may be reanalyzed 
as different experiment type. When the Convert to New Experiment Type command is executed, 
the Mx3000P software creates a new experiment file and applies the analysis algorithms and 
display schemes of the newly selected experiment type to the existing data, using the well 
assignments and fluorescence readings from the original run. If well assignments made in the 
original run are unavailable in the new experiment type, a dialog box containing information 
about well type assignment incompatibilities will appear. The Mx3000P software will convert 
any of the available experiment types to any other available experiment type. 

E-mail Experiment  

The E-mail Experiment command is a shortcut for creating an email that contains the open 
experiment file in the Mx3000P System file format (.mxp). Clicking E-mail Experiment launches 
Microsoft Outlook® and creates a new message with the open Mx3000P experiment file attached 
to the new message. 
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Print Page Setup 

Print Page Setup is used to adjust the size of the image printed when either Print or Print Screen is 
executed. To adjust the image size, click Print Page Setup. When the dialog box appears, enter 
the desired image size (25–100% of the original size) in the Scale box and then click OK. 

 

Chart printing using most printers will be enhanced by using the High resolution chart printing 
option. If you are experiencing chart print quality problems, try deselecting the High resolution 
chart printing checkbox. Limitations of certain printer drivers cause incompatibilities with this 
option.  

Print  
To print any view within the Mx3000P software, click Print in the File menu, press Ctrl+P, or 
click the print button on the toolbar. 

To resize the image prior to printing, use the Print Page Setup dialog box.  

If you want to print the contents of the full screen, including toolbars and taskbars, use Print 
Screen instead of Print. 

Print opens the printer driver dialog box which allows printing configuration and execution. 

Print Screen  
To print the full contents of the screen including toolbars and taskbars, click  Print Screen in the 

File menu, press Alt+P or click the print screen button  on the toolbar.  

To resize the image prior to printing, use the Print Page Setup dialog box.  

If you want to print only the active Mx3000P software module view, use Print instead of Print 
Screen. 

Print Report 
To print a text report of the well-based information from Plate Setup, click Print Report on the 
File menu. The printer driver dialog box opens and allows printing configuration and execution. 
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Print Preview 
Clicking the Print Preview command generates a new window that displays the image that would 
be printed after the execution of a Print command. You may print directly from the Print Preview 
screen by clicking the Print button. 

Recent Experiments 
The File menu displays a list of the six most recently used experiments. Any experiment in the 
list may be opened by clicking on its file name. 

Exit 
To exit the program, click the Exit command in the File menu or click the Close button  in the 
upper right-hand corner of the screen. If the open experiment  has not been saved, the Save 
Current Experiment dialog box appears. 

 
Note  A running experiment must be either completed or aborted before exiting the program. 
If you attempt to exit the software while the lamp is on, a dialog box will appear that prompts 
you to turn off the lamp.  
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Edit Menu 

 

The Edit menu features two pairs of commands: the Undo and Redo command pair and the Copy 
and Paste command pair.  

Undo  
Undo allows you to undo multiple actions in Plate Setup or Thermal Profile Setup. Select Undo to 
effect each undo action. 

Redo  

Select Redo to reinstate the last action undone by the Undo command. (These commands are 
available for use during Plate Setup or Thermal Profile Setup.) 

Copy 
The Copy command is available in Plate Setup, allowing you to copy the information from one or 
more selected wells to the clipboard for later pasting into other well positions within the same 
experiment. To copy well information, first select the wells that contain the information to be 
copied by clicking on one well and then dragging the cursor across the set of wells to be selected. 
Release the mouse button, then click Copy on the Edit menu or press Ctrl+C. 

Paste 

The Paste command is available in Plate Setup, allowing you to paste well  information from the 
clipboard into a selected set of wells. Using the mouse, first select the wells that you want to 
paste into. To paste the well information, click Paste on the Edit menu or press Ctrl+V. 
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Instrument Menu 

The Instrument menu contains commands that control several functions of the instrument.  

 

Multiple Instrument Control 

Multiple Mx3000P instruments may be controlled using a single PC. The multiple instrument 
control mode is set up and administered by using the Multiple Instrument Control portion of the 
Instrument menu. See Multiple Instrument Set-Up: Optional Use of Multiple Instrument Control 
in the Getting Started section of the manual for more information on the use of this feature. 

Qualification Test 

Clicking Qualification Test opens the Instrumentation Qualification Test - Start dialog box.  

A Qualification Test is completed during the initial instrument setup, using the predispensed 
qualification plate that was supplied with the instrument. This test verifies that the biological 
performance of the instrument is within factory specifications for a Quantitative PCR 
experiment. The Qualification Test run uses a preconfigured plate setup and thermal profile setup. 
The software provides test results upon completion of the run. 

The first time that a new experiment is opened using instrument-connected software, the 
Instrumentation Qualification Test - Start dialog box will automatically open. To initiate the run, 
click Next. Follow the instructions that are presented in subsequent dialog boxes for completing 
the run and analyzing the results. If Cancel is selected, the dialog box will open every time a new 
experiment is opened, until the test has been completed. 
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Self-Test 

The Self-Test command initiates a set of tests run by the Mx3000P instrument to validate a 
variety of performance parameters. When the self-test is complete, a dialog box will appear 
indicating that instrument passed or failed. In case of a failure result, subsystem failures will be 
specified; contact Technical Services for assistance. 

 

Lamp Off 

This command turns off the quartz-tungsten halogen lamp. Turning the lamp off when it is not 
needed extends the life of the bulb. 

Lamp On 

This command turns on the quartz-tungsten halogen lamp. Turn the lamp on at least 20 minutes 
prior to a run in order to allow the lamp to warm up. Stratagene recommends that no data be 
taken during this 20-minute warm up period. 

Lamp Reset and Utilities 

Lamp Reset and Utilities is used to reset the lamp timer to 0 after the quartz-tungsten halogen 
lamp has been changed. The Lamp Reset and Utilities dialog box displays the Total time of lamp 
usage accrued, the Last date the lamp was reset, and whether or not the lamp is within 
operational limits (the lamp has an average life expectancy of 2000 hours). To reset the timer, 
click the Reset button. The Total time will be set to 0 and the current date will appear in the Last 
date reset field.  

 

Mx3000P™ Real-Time PCR System 29 



Navigating in the Mx3000P Software 

Filter Set Gain Settings 

Filter Set Gain Settings determine the amplification of the fluorescence signal readings for each 
of the four optical paths. Select Filter Set Gain Settings from the Instrument menu to open the 
Filter Set Gain Settings dialog box, in which the gain settings may be viewed and modified. 

 

Factory Defaults are gain settings calibrated to the four filters (optical paths) fitted in the 
Mx3000P instrument during manufacturing.  

If you want to adjust the gain settings (for example, if the relative signal levels for your samples 
are not optimal using the current settings), use the Filter set gain multiplier dropdown menus to 
change the appropriate gain value(s). Click OK for the settings to take effect. To save new 
settings as Lab Defaults, select the Save as lab defaults check box before clicking OK. Only one 
set of Lab Defaults can be stored at a time.  

Click Load Factory Defaults to retrieve the original factory settings. Click Load Lab Defaults to 
retrieve the last user-defined defaults saved by using the Save as lab defaults checkbox. 

Note  The fluorescence signal is saturated at 65536 and the accuracy of the fluorescence signal 
is reduced above 35000. As a general guideline, the gain should be set to a value that 
causes the highest signals seen from samples to be less than 35000. 

Update Filter Configuration 

The Mx3000P software stores filter configuration settings that specify the four filters fitted in the 
optical paths of the instrument during manufacturing. During routine use of the software 
connected to an individual instrument, these settings do not need to be changed.  

If it is necessary to change or reinstate the filter configuration settings (e.g. if the software is 
used in conjunction with multiple Mx3000P instruments with different filters installed), use the 
Update Filter Configuration command to revise the filter configuration settings. When  Update 
Filter Configuration is selected from the Instrument menu, a dialog box similar to the one shown 
below will appear. Click Yes to update the filter configuration used by the software to the 
configuration of the connected instrument.  
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Download Data from Instrument 

In rare situations, when an instrument-connected Mx3000P application is re-started, such as after 
a PC hardware or instrument communication problem, a dialog box similar to the one below may 
be displayed.  

 

This dialog box indicates that there may be data on the instrument that can be recovered, and in 
this case, that the run may be resumed. Selecting Yes will perform the necessary data download 
and resume the run, if appropriate.  

Alternatively, the Download Data from Instrument command can be executed through the 
Instrument menu. 

The downloaded data will automatically be stored in the last open experiment, retaining its 
original filename. The instrument stores data only for the last run started on the instrument.  
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Tools Menu 

The Tools menu provides access to tools located outside of the Mx3000P software. 

 

Windows Explorer 

Clicking on Windows Explorer opens the Windows Explorer application and displays the 
contents of the current Mx3000P software data storage folder.  

QPCR Internet Links 

If the computer is connected to the Internet, clicking QPCR Internet Links will open Microsoft 
Internet Explorer to a Stratagene web page that contains a number of useful links for 
primer/probe design and other QPCR-related topics. 
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Options Menu 

The Options menu is used to access several dialog boxes which contain important instrument and 
software settings. The menu commands are summarized below; see the manual subsections (on 
following pages) dedicated to each of the three menu commands for more details.  

 

Optics Configuration 

The Optics Configuration dialog box is used for making Dye Assignments to filters, for defining 
properties of Dyes & Filters and for specifying the Scan Order. 

Analysis Term Settings 

Clicking  Analysis Term Settings opens the appropriate dialog box: Analysis Term Settings-Real-
Time or Analysis Term Settings-Plate Read. These are used for managing several settings that 
impact data analysis including specifications for background, threshold, curve smoothing and 
confidence interval calculations. 

Preferences 

The Preferences dialog box allows you to personalize several software settings. These include 
File storage and naming conventions, Colors used in the software displays, screen Display options 
and the use of  Defaults in experimental setup and analysis. 
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Options-Optics Configuration 

Optics Configuration - Dye Assignment 

To assign a specific dye to an optical path, select Optics Configuration from the Options menu. 
When the Optics Configuration dialog box opens, click the Dye Assignment tab. 

 

When the software is running on an instrument-connected PC, the Filter sets shown correspond to 
the four filter sets installed in the instrument. To assign a specific dye, select from the dyes 
associated with the Filter set from the corresponding menu and then click OK. Note that if the dye 
to be assigned is a custom dye, its association with a particular filter set must first be defined in 
the Dyes & Filters tabbed page of the dialog box.  

When running the software on a PC that is not connected to an instrument, a dye may be 
assigned to any of the filter positions by selecting the appropriate dye from the dropdown menu 
corresponding to each path. The Filter set associated with each filter position will change 
accordingly. When assignments are complete, click OK.  

Specific information about dye and filter set compatibility is available by clicking Additional Dye 
Information. 

Changing a Dye Assignment After Data Collection 

To change a dye/filter position assignment in a post-run experiment, two steps are required. First, 
open the Dye Assignment page of the Optics Configuration dialog box and select the new dye 
from the dropdown menu corresponding to the appropriate filter set. (Menus will be available 
only for the filter sets that are compatible with multiple dyes.) Second, go to the Plate Setup 
screen for the open experiment. Using the Collect fluorescence data checkboxes, deselect the dye 
that was originally assigned to the path. The newly-assigned dye will now appear under Collect 
fluorescence data; re-select the dye checkbox to display the newly-assigned dye on all screens 
within the experiment.   
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Optics Configuration - Dyes & Filters  

To define a custom dye or filter set, or to view the properties of defined dyes and filter sets, 
select Optics Configuration from the Options menu. When the Optics Configuration dialog box 
opens, click the Dyes & Filters tab. 

 

Dye Definitions 

The Dye definitions section allows you to view the Filter set associated with a dye, to view or 
modify the display Color assigned to a dye, and to add new custom dyes. To view information 
about a particular dye, select the dye from the Name menu. The filter set associated with that dye 
is displayed; for the pre-defined dyes, the assigned Filter set may not be changed. The display 
color for the selected dye is shown. To change the color, click the Color button and the Color 
dialog box will open, allowing you to select a new color. 

To add and define a custom dye: enter the new dye Name, select the Filter set with which the dye 
should be associated, and then click Add. The Define New Dye Color dialog box opens. Select a 
display color for the dye and click OK. The custom dye will then be available for assignment to a 
filter position on the Dye Assignment tabbed page of the Optics Configuration dialog box. 

Filter Set Definitions 

When the software is running on an instrument-connected PC, the Filter set definitions section of 
the dialog box will report the excitation and emission wavelength for each of the four filter sets 
installed in the instrument. Select the filter of interest from the Name menu to view the 
wavelength information.  

When running the software on a PC that is not connected to an instrument, you may view 
information for any defined filter set by selecting the filter set of interest from the Name menu. 
In addition to defining custom dyes, you may also define a custom filter set. To do this, enter the 
custom filter set Name, enter the Excitation wavelength and the Emission wavelength, and then 
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click Add. The custom filter set will then be available for dye assignment under Dye definitions. 
To change the wavelengths defined for a custom filter set, enter new wavelength value(s) and 
then click Update.  

Dye Information Dialog Box 

The Dye Information dialog box provides information about each dye: its associated filter set, 
excitation wavelength, and emission wavelength.  This dialog box may be accessed by clicking 
the Additional Dye Information button at the bottom of the Dye Assignment tabbed page of the 
Optics Configuration dialog box.  

 

Selecting the Detected dyes radio button displays the filter sets installed in the instrument and 
lists the defined dyes that are compatible with each of the installed filter sets.  
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Optics Configuration - Scan Order 

Filter sets are scanned in the order shown on the Scan Order page of the Optics Configuration 
dialog box (accessed from the Options menu). 

To change the order in which the four filter sets are scanned, select the filter set label to be 
placed in a different position, and then use the arrow buttons to change the position of the filter 
set in the list. Alternatively, by using the mouse, drag the filter set label to the new position. 
Click OK to institute the new scan order. 
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Options-Analysis Term Settings for Real-Time Experiments 

Analysis Term Settings - Real-Time - Threshold Fluorescence 

The Threshold Fluorescence tabbed page of the Analysis Term Settings-Real Time dialog box 
allows you to select an automatic threshold-determination algorithm. Options include 
Amplification-based and Background-based threshold determination algorithms. For each 
algorithm, the result is one threshold value for each dye, excluding the reference dye. The 
threshold fluorescence may also be manually adjusted for each individual dye in any given 
experiment. 

The threshold value is used in determining the dye's individual well product threshold cycle (Ct) 
results. Real-time final results, such as initial template quantities for Unknown wells, are based 
on Ct values. 
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Amplification-based Threshold 

When the Amplification-based threshold radio button is selected, the Mx3000P software 
automatically determines threshold values by one of two methods. The first method performs a 
search of fluorescence values within product exponential amplification to minimize Ct spread 
among replicates. The fluorescence associated with minimum Ct spread is assigned as the dye-
specific threshold value. The second method assigns fluorescence associated with a fixed 
amplification position as the threshold value. The search range for the first method, and the fixed 
position used in the second method, can be set through the Advanced Settings dialog box. 
Method 1 

A minimum Ct spread algorithm is used for experiments that include at least two wells per 
replicate set for all replicates measuring a given dye. The algorithm calculates the Ct standard 
deviation for each replicate at each potential fluorescence value within the search range. The 
result is the fluorescence where the overall spread of the Ct standard deviation is minimized for 
all replicates, indicating the best overall position during amplification. The algorithm takes into 
account experiments with large dynamic ranges. Typically, the exponential amplification phase 
of all plots of interest (Standards and Unknowns) is included in the search. Whether or not all 
products' amplification are included is primarily determined by the search range specified under 
Advanced Settings. 
Method 2 

If method 1 cannot be performed due to an insufficient number of wells per replicate (i.e. fewer 
than two wells per replicate), a fixed amplification position is used. When it is necessary to 
employ this backup method, the software assigns the fluorescence associated with the midpoint 
of the search range (specified under Advanced Settings) as the threshold value. 
 
Advanced Settings for Amplification-based Threshold 

To view or modify the algorithm Search range, click the Advanced Settings button to open the 
Amplification-based Threshold dialog box. Valid Search range entries are between 0% and 
100%, and the Original Settings are 5% to 60%.  
The 0% position on an amplification plot is the point at which amplification begins to be 
detected. Typically for baseline corrected data, this point has a fluorescence value very close to 0 
(e.g. 0.001). The 100% fluorescence value represents the maximum of the first derivative. It is 
near the ending of the exponential amplification phase and is sufficiently past the optimal search 
range of interest. 
The algorithm will use the Ct spread minimization method (method 1) if two or more wells per 
replicate set are included in the experiment. The appearance of the Amplification-based 
Threshold dialog box under these conditions is shown below.  
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Changing the Lower % and Upper % range limits biases the threshold result accordingly. For 
example, if the threshold result is consistently too high (based on personal preference), the Upper 
limit may be lowered, resulting in a lower threshold result. If the threshold result is consistently 
too low, the Lower limit may be increased. This modification will further separate the beginning 
of the search range from the noise level and may improve results derived from certain data, 
increasing the confidence of the individual plot results. Alternatively, raising the Lower limit can 
be avoided by increasing the number of wells per replicate.  
If fewer than two wells per replicate are included, the midpoint of the specified range is used for 
the fixed position method of threshold determination (method 2). When this occurs, the 
Amplification-based Threshold dialog box appears as shown below, specifying the range 
midpoint used. The Upper and Lower limits of the range may be modified, biasing the threshold 
result accordingly. 
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Background-based Threshold 

 

To analyze data from the experiment using a threshold fluorescence that is determined based on 
the noise in the background, select the Background-based threshold radio button. Enter the 
desired settings in the Background cycle range and Background sigma multiplier spin boxes.  

Background cycle range specifies the cycles that will be used to calculate the threshold 
fluorescence levels. Threshold fluorescence is determined by calculating the standard deviation 
(sigma) of the raw fluorescence for all selected wells for the specified cycles and multiplying this 
value by the Background sigma multiplier constant. Typically, the Background cycle range should 
encompass only early cycles, before the PCR process starts to affect the fluorescence values. The 
Original Settings values for the background cycle range are cycles 5 through 9, and for the 
Background sigma multiplier is 10. 

See Preferences-Defaults for information about the use of the Defaults menu and the application 
of defaults sets to the settings specified in this dialog box. 
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Analysis Term Settings - Real-Time - Baseline Correction 

The Baseline Correction tabbed page of the Analysis Term Settings-Real Time dialog box allows 
you to specify how baseline fluorescence should be determined in order to generate baseline-
corrected fluorescence (dR) data.  
For each plot, the raw fluorescence data over a specified range of cycles are fit to a line using a 
linear least mean squares algorithm to produce a baseline. The value of the baseline function is 
calculated for every cycle and subtracted from the raw fluorescence to produce baseline 
corrected fluorescence (dR). The cycles used to determine the baseline may be the same for all 
plots in the experiment or may be defined differently for each individual plot.  

 
The Baseline Correction page is divided into two sections. Use the Active settings section to 
specify the baseline corrections settings prior to analysis. During experimental analysis, use the 
Resulting cycle range section to view and adjust the baseline corrections cycle ranges determined 
for each plot. 
Options for baseline correction include Adaptive baseline, where the Mx3000P automatically 
determines the optimal baseline cycle range for each dye in each experiment, or Non-adaptive 
baseline, where user-defined settings are used to determine the baseline. 
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Active Settings-Adaptive Baseline 

When Adaptive baseline is selected, the Mx3000P software will automatically determine the 
optimal background cycle range for each plot individually, resulting in the most accurate Ct 
value for each well/dye combination. After the experiment is run and analyzed using an adaptive 
baseline calculation, the resulting cycle range may be modified for any or all plots by the user as 
described in Baseline Correction-Resulting Cycle Range. 
Note  If you want use the Mx3000P software to analyze data that was collected using 

Stratagene's Mx4000® software (versions 1.00 to 3.00), select the Use Mx4000 v1.00 to 
3.00 algorithm checkbox.  

Active Settings-Non-adaptive Baseline 

When Non-adaptive baseline is selected, the Mx3000P software will determine the baseline 
function using the range of cycles specified in the Start cycle and through menus. The starting 
and ending cycles in the software's Original Settings are 3 and 15, respectively. 
See Preferences-Defaults for information about the use of the Defaults menu and the application 
of defaults sets to the settings specified in this dialog box. 

Resulting Cycle Range 

After running the experiment, use the Resulting cycle range section to view and adjust the 
baseline correction cycle ranges for each plot. Prior to completing the run, this section will be 
empty. After the run is complete, the starting and ending cycles being used to calculate the 
baseline are listed in this section. If Adaptive baseline is selected, the starting and ending cycles 
listed will be variable, since the Mx3000P software calculates the optimal baseline cycle range 
for each plot individually. If Non-adaptive baseline is selected, the starting and ending cycles 
listed will be constant and equal to the values entered in the Active settings section. 
The baseline correction cycle range for one or more plots may be modified manually. To specify 
the range of cycles used to calculate the baseline for a particular plot, select a well/dye 
combination by highlighting its entry in the Resulting cycle range list. Multiple plots can be 
selected by holding down the Ctrl key when selecting, or all plots can be selected by clicking the 
Select All button. Once the desired well/dye combinations are selected, click the Edit Range 
button. The Edit Cycle Range dialog box appears. 

 
In the spin control boxes, enter the desired start and ending cycle for the baseline algorithm to 
use to calculate the baseline correction. 
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The top menu provides 3 options for choosing the endpoints for the baseline calculation. Both 
start and ending cycle allows you to set both endpoints for all selected wells. Start cycle only 
allows the start cycle to be set for all selected wells without changing the ending cycle values. 
Ending cycle only allows the ending cycle to be set for all selected wells without changing the 
start cycle values. 
To reset the start and end cycles to the Active settings values (for Non-adaptive baseline) or to 
the Mx3000P system-calculated values (for Adaptive baseline), select the desired well/dye 
combinations and then click Reset.  
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Analysis Term Settings - Real-Time - Smoothing 

 
The Smoothing tabbed page of the Analysis Term Settings-Real Time dialog box allows you to 
apply curve-smoothing to amplification plots and dissociation curve plots. 
Moving Average  

Moving average is an optional algorithm enhancement that uses curve-smoothing to help 
improve the precision and accuracy of the Ct determination from amplification plots and the Tm 
determination from dissociation curves by decreasing the effect of signal noise. When this 
enhancement is selected, the value for each data point in the curve represents the average of the 
values for a specified range of cycles surrounding a given point. Selecting a greater number of 
points increases the magnitude of curve smoothing that is achieved but decreases the resolution 
of the curve data. 
To perform amplification data analysis employing a moving average calculation, select the 
Moving average checkbox and select the number of data points to be averaged in the 
Amplification averaging points box.  
To perform dissociation data analysis employing a moving average calculation, select the Moving 
average checkbox and select the number of data points to be averaged in the Dissociation 
averaging points box. 
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Graphical Temperature Resolution  

Graphical temperature resolution is a second optional algorithm enhancement available for 
dissociation curve smoothing. This algorithm is based on collapsing data by averaging adjacent 
data points to arrive at the desired point separation. Application of this algorithm increases the 
ratio of dissociation peak height to noise level. 
To perform dissociation data analysis employing this algorithm, select the Graphical temperature 
resolution checkbox. Next, select the desired Dissociation Point Separation. Note that as the point 
separation is increased, the ratio of peak height to noise will increase. Note also that in some 
cases, the ability to differentiate between products with unusually closely spaced melting 
temperatures may decrease as the point separation is increased. The final results are displayed in 
the dissociation chart display. 

See Preferences-Defaults for information about the use of the Defaults menu and the application 
of defaults sets to the settings specified in this dialog box. 
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Analysis Term Settings - Real-Time - Replicates 

 
Wells identified as replicates in Plate Setup may be treated either individually or collectively 
during Analysis. Selecting Treat individually under Replicates will cause the software to analyze 
each well independently and display or report results for each well separately. Selecting Treat 
collectively will cause the software to average the data from the replicate wells and report data 
from all replicate wells as a group, effectively treating the measurements as if they came from 
the same well. See Treatment of Replicates in the How-To (Detailed Protocols) section for more 
information on replicate treatment during analysis. 
See Preferences-Defaults for information about the use of the Defaults menu and the application 
of defaults sets to the settings specified in this dialog box. 
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Analysis Term Settings - Real-Time - Efficiency Settings 

When the Analysis Term Settings - Real Time dialog box is opened from a Comparative 
Quantitation experiment, the dialog box includes a tabbed page for Efficiency Settings. This 
dialog box is accessed through the Options menu. 

 

This feature allows you to specify the amplification efficiency for the gene of interest and 
Normalizer targets used in a Comparative Quantitation experiment, in order to compensate for 
any difference in the efficiencies while calculating results. The amplification efficiency for each 
target is determined by performing a Comparative Quantitation Standard Curve.  

After the standard curve slopes have been determined, enter the Slope from the standard curve 
for each dye. Alternatively, enter the amplification Efficiency for each dye. (The efficiency may 
be calculated from the slope using the Amplification Efficiency Calculator on the Standard 
Curve results screen.) The efficiency settings recorded in Analysis Term Settings are used by the 
Mx3000P software in calculating the Relative quantity results. 

See Preferences-Defaults for information about the use of the Defaults menu and the application 
of defaults sets to the settings specified in this dialog box. 
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Options-Analysis Term Settings for Plate Read Experiments 

 

Confidence Level For Calls (%) 

The user-defined confidence level for calls is the statistical probability required before the 
algorithm will call an amplification occurrence in a well as positive. See Positive and Negative 
Calling in the How-To (Detailed Protocols) section for more information. In the Confidence level 
for calls box, type or select the desired value. The factory-set default confidence level is 99%. 

See Preferences-Defaults for information about the use of the Defaults menu and the application 
of defaults sets to the settings specified in this dialog box. 
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Options-Preferences 

Preferences - File 

To view or change the default file storage and file naming settings, select Preferences from the 
Options menu. When the Preferences dialog box opens, click the File tab. 

 

The default storage location for saved Mx3000P experiments is specified using the Mx3000P 
data folder box.  The factory default location is C:\Program Files\Stratagene\Mx3000P\Storage. 
If you wish to specify a different default file storage location, type the directory address into the 
text box or click Browse to navigate to another directory.  

The Auto-filenaming feature allows you to select the contents of the default file name for all 
Mx3000P instrument experiments. Three components (Experiment type, Date, and Time) can be 
excluded or included using the selection checkboxes, and the format of the date may be selected 
using the radio button controls. View the resulting filename structure under Example filename. 
In the Export decimal using box, specify the form of the decimal used in the numerical values 
reported in Text Reports as either Point (period character) or Comma by selecting the appropriate 
radio button. 
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Preferences - Colors 

To view or change the color settings for the various elements of the Mx3000P software screens, 
select Preferences from the Options menu. When the Preferences dialog box opens, click the 
Colors tab. 

 

Color Schemes 

By using color schemes, you can define new sets of colors for various software elements and 
save the settings as a group. The Color Scheme menu allows you to select one of several built-in 
color schemes or to add and delete user-defined color schemes. To add a scheme, type in a new 
scheme name (e.g. Lab Defaults, in the example above) and click the Add Scheme button. The 
scheme will be added and the colors can then be defined under Scheme Colors.  

To change the color scheme used by the software, select the scheme of interest from the color 
scheme menu and then click OK. 

To restore the colors of all software elements to the colors that were in place when the 
instrument was originally installed, click Original Settings and then click OK. 

Scheme Colors 

The colors of individual Mx3000P software display components can be defined in the Scheme 
Colors section of the dialog box. The components whose colors may be defined are grouped into 
five categories under Color Category pull-down menu: Application, Charts, Plate Wells, Stock 
Well Types and Thermal Profile. Selecting one of these categories causes a corresponding list of 
graphical elements to appear in the list below the menu. To display the color used for a specific 
element, click the element name in the list and the color assigned to that element will appear in 
the color box to the left. 
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To change the color for any specific element, select the element name and then click the Edit 
Color button. The Color dialog box opens. Select any color from the Basic colors grid and click 
OK to use this color. Alternatively, click Define Custom Colors to set a custom color. 

  
Custom Colors 

To define a custom color, click the Define Custom Colors button and the dialog box will expand 
to include a palette for choosing custom colors. 

Custom colors can be defined by clicking and dragging the mouse within the color matrix (the 
large rectangle with colors blending together). The color that the cursor is selecting will appear 
in the Color Solid box. The color's brightness can be adjusted by using the dark/light vertical 
adjustment slider on the right-hand side of the dialog box. Custom colors may also be defined by 
entering numerical values directly in the Hue, Sat, and Lum boxes or in the Red, Green and Blue 
boxes. 

To add the color that appears in the Color Solid box to the available custom colors, click Add to 
Custom Colors. 
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Preferences - Display 

The Display tabbed page of the Preferences dialog box allows you to modify the display 
properties of several Mx3000P software features. To access the dialog box, select Preferences 
from the Options menu and then click the Display tab. 

 

Toolbar Size 

The size of the buttons displayed on the toolbar may be modified by selecting the appropriate 
radio button under Toolbar size. Sizes of other software features are not affected. 

Display Tooltips 

When Display tooltips is selected, tips summarizing the function of a variety of software features 
appear on-screen when the mouse cursor rests over the feature icon. See below for an example of 
a displayed tooltip. 

 
When viewing Results screens with Display tooltips selected, you may view the information 
associated with a specific data point by placing the cursor over the point of interest.  
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Enable Well Type Colors 

When Enable well type colors is selected, a horizontal color bar is displayed across the top of 
each well. The color of this bar corresponds to the well type selected to allow a quick 
identification of well types. Well type colors can be changed in the Colors tabbed page of the 
Preferences dialog box. When Enable well type colors is selected, wells appear as shown below. 

 
The same cells are shown below with Enable well type colors cleared. 

 
Prompt for New Experiment Type at Start-up 

When Prompt for new experiment type is selected, the New Experiment Options dialog box will 
open each time the Mx3000P software is started. 
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Preferences - Defaults 

The Mx3000P system will store a variety of user-defined default settings in addition to the 
software's Original Settings. For example, if different users of the Mx3000P system wish to 
maintain differentiated settings over the course of multiple experiments, this may be facilitated 
by creating a different default set for each user. Once a new default set has been created, it may 
be used for the setup and analysis of new experiments, expediting the application of uniform 
customized settings across experiments.  

The active default set dictates the default settings with which each new experiment is opened. 
These settings may include well definitions in Plate Setup, the properties of the default thermal 
profile used for Thermal Profile Setup, and the well selection and analysis settings in Analysis 
Selection and Setup. Any of the settings contributed by the default set in a new experiment may 
be modified during the course of experimental setup or analysis. Conversely, a default set 
containing established experimental setup and analysis parameters may be created for a routine 
assay, and runs may be performed with no further modifications to the default settings. 

To create and manage default sets for use by the Mx3000P software, open the Defaults tabbed 
page of the Preferences dialog box (accessed through the Options menu). 

 

Creating a New User-Defined Default Set 

To create a new user-defined set of defaults, open an experiment that was set up and analyzed 
using the desired settings. Open the Defaults page of the Preferences dialog box. Expand the 
pulldown menu under Choose set and select <ADD SET>. Type the name under which the new 
the default set should be stored (e.g. BRCA Allele Discrimination in the example above). Next, 
define the segments of the open experiment (Plate Setup, Thermal Profile Setup, and Analysis 
settings) that should be included in the default set by selecting the appropriate checkboxes under 
Include. For any segments that are not selected, the settings comprising the original software 
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settings will be used in new experiments. In the example shown above, the new default set BRCA 
Allele Discrimination will contain the thermal profile and the analysis settings specified in the 
open experiment, but will contain a generic (blank) plate setup segment. When finished naming 
and defining the segments to be included in the new default set, click Add Set.  

Click OK to establish the new default set as the active default set used for new experiments. 
Click Cancel to restore the previous default set as the active set. 

Modifying Settings Stored in a User-Defined Default Set 

Once a default set has been created, the individual settings that comprise the set may be changed 
from the appropriate software view. For example, to change the confidence level value stored in 
a default set, access the Analysis Term Settings-Plate Read dialog box. Enter the desired value in 
the Confidence level for calls box. To change the default set setting to this value, click the 
Defaults menu arrow, then select Save. The default set that the new value will be saved into is 
indicated in the last entry of the Default menu, Change Default set (Currently <set name>).  

 

Viewing the Active Default Set 

To view the identity of the active default set, open the Defaults tabbed page of the Preferences 
dialog box (accessed through the Options menu). When this dialog box is first opened, the active 
default set appears in the Choose set menu. 

 
The active default set may also be identified from any of the software sections containing a 
default set (Defaults) menu, by clicking the Defaults arrow. The active default set is indicated in 
the final entry of this menu: Change Default Set (Currently <set name>).  
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Changing the Default Set 

To change the default set used in the open experiment, open the Defaults page of the Preferences 
dialog box (accessed from the Options menu). Select the name of the desired default set from the 
Choose set menu. Click OK to apply the selected default set to the open experiment and to use 
the selected default set when creating new experiments. 

 

Changing the default set causes the software to apply all of the settings stored in the default set to 
the open experiment, as relayed by the warning dialog box that opens when a new default set is 
selected. Click Yes in the warning dialog box to continue with changing the setup and analysis 
properties of the open experiment, or click No to return to the Defaults page without changing 
default sets or changing any experimental settings.  
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Changing the Default Set in a Post-Run Experiment 

When changing the default set in a post-run experiment, Plate Setup and Thermal Profile Setup 
information cannot be applied to the open experiment, and a warning dialog box like the one 
shown below will appear. Click OK to change the active default set and apply only the default set 
analysis settings to the open post-run experiment. 

 
 
Changing the Default Set from Other Software Screens 

Changing the default set may be initiated from any of the command panels or dialog boxes that 
contain settings stored in a default set. One example is shown below. From any of the software 
sections containing a default set settings menu, click the Defaults arrow and then select Change 
Default Set (Currently <set name>). The Preferences dialog box will open to the Defaults page, 
allowing you to select a different default set from the Choose set menu.  
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Reinstating the Software's Original Settings 

The original software setup and analysis settings (Original Settings) that were in place when the 
software was first installed have been designed to provide generally-applicable settings for the 
new user and to maximize experimental flexibility. These settings are stored separately from the 
default sets, and unlike the default sets, may not be modified. This ensures the ability to reinstate 
these settings at any time, after any number of modifications have been made to default sets. 
Reinstating the software setup and analysis Original Settings may be initiated from the Defaults 
tabbed page of the Preferences dialog box. 

 

Clicking the Original Settings button in this dialog box will reset the active default set to the 
original software settings. If you wish to reinstate the original software settings without altering 
any existing default sets, first create a new default set, and then click Original Settings to apply 
the original software settings to the new default set. Click OK to activate the new default set 
(containing the original software settings) in the open experiment. 

The original color settings for the software may be accessed through the Colors tab of the 
Preferences dialog box. 
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Section Menu 

Use the Section menu commands to move between the Setup, Run, and Analysis areas of the 
application. These commands mirror the Setup, Run, and Analysis selection buttons in the upper 
right-hand corner of the screen. 
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View Menu 

 

Full-Screen Plate 

The Full-Screen Plate view command changes the display on the screen to a full-screen view of 
the Plate Setup for the open experiment.  

Zoom In/Zoom Out 

Use the Zoom In command to magnify a rectangular portion of a chart or plot from a Results 
screen. To use this feature, click Zoom In. The cursor will change to cross-hairs when it is 
positioned over a chart or graph. Click at one corner of  the rectangle to be enlarged and drag the 
mouse until the area to be enlarged is enclosed by the rectangle. Release the mouse button and 
the rectangle contents will be enlarged. The resulting expanded chart can be further enlarged 
multiple times by repeated use of the Zoom In command. Clicking Zoom Out returns a chart or 
plot that has been enlarged to its normal view.  
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Window Menu 

 

The Window menu commands Tile Plots and Cascade Plots control the format of expanded 
amplification plots displayed when viewing  Raw Data Plots in the Run section of the software. 
(These commands are disabled on all other software screens.)  

Tile Plots 
Clicking Tile Plots causes the plots for individual wells to be displayed in a tile format, with plots 
lined up in rows and columns.   

 

Cascade Plots 
Clicking Cascade Plots causes the plots to be layered one on top of the other.  
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Help Menu 

The Help menu accesses the Mx3000P software help system. Selecting the first command, 
Mx3000P Help, causes a help topic appropriate to the current screen to be displayed. This feature 
can also be accessed from anywhere within the program by pressing the F1 key. 

Contents and Index of Topics provide access to the help system in a broad manner to allow 
browsing or searching for help on any topic. Selecting one of the remaining options opens the 
Mx3000P help system to a specific, applicable area. 

 

Selecting Stratagene's Website will open the Stratagene home page, www.stratagene.com if the 
computer is connected to the World Wide Web. 

Selecting About will open a dialog box which lists the software version of the Mx3000P system 
interface and the firmware version of the instrument software. 
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Toolbar 

 

A toolbar containing shortcut buttons provides convenient access to many of the frequently-used 
functions of the Mx3000P system. The buttons on the toolbar perform the same function as the 
similarly-named commands in dropdown menus or dialog boxes. 

New 

The New button  allows you to create a new experiment. Pressing the New button opens the 
New Experiment Options dialog box.  

Open 

Use the Open button  to open an existing experiment. Pressing this toolbar button causes the 
Open dialog box to appear. 

Save 

To save an experiment, click the Save button in the toolbar . If the experiment has already 
been saved, no dialog box will be displayed and the experiment will be saved with any 
modifications under its current name. If the experiment has not yet been saved, the Save As 
dialog box will open.  

Print 

To print any view within the Mx3000P software, click the Print button  on the toolbar. The 
printer driver dialog box opens to allow printing configuration and execution. 

Print Screen 

Use the Print Screen button  to print any screen in the Mx3000P software. The image printed 
using the Print Screen command can be sized from 25% to 100% by using the Print Page Setup 
dialog box (accessed by selecting Page Setup from the File menu). 

Undo 
Undo allows you to undo multiple actions when working on Plate Setup and Thermal Profile 

Setup screens. Click the Undo button  to effect each undo action. 
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Redo 

Click the Redo button  to reinstate the last action undone by the Undo command. The Redo 
function is available on Plate Setup and Thermal Profile Setup screens. 

Lamp On/Off 

Click the Lamp On/Off button  to switch the lamp on or off.  The warm-up time for the lamp 
is 20 minutes. Stratagene recommends that no data be taken during this period. Turning the lamp 
off when it is not needed extends the life of the bulb.  

The button is also an indicator of  lamp status. If the lamp is off, the bulb shown in the button 

will be red.  

If the lamp is warming up, the bulb will be yellow.  

If the lamp is warmed up and ready, the bulb will be green.  

Optics Configuration 

Click the Optics Configuration button  to open the Optics Configuration dialog box. 

Replicate Wells Treatment Setting  

The Replicate Wells Treatment Setting button  is a shortcut for changing the analysis algorithm 
used for the open experiment such that wells defined as replicates are treated either collectively 
or individually during analysis. When the button appears with the replicate symbol underlined 

, the replicate wells are treated collectively. When the replicate symbol appears without an 

underline , the replicate wells are treated individually. Clicking on this button will switch the 
treatment of the replicate wells from individually to collectively or from collectively to 
individually. See Treatment of Replicates for more information. 

Term Settings  

The Term Settings button  opens the Analysis Term Settings dialog box, where you can 
modify several data analysis settings. Click here for more information on Analysis Term Settings 
Real-Time or here for more information on Analysis Term Settings Plate Read.  
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Full-Screen Plate View  

The Full-Screen Plate View button  changes the view displayed on the screen to a full-screen 
view of the Plate-Setup for the open experiment.  

Zoom In 

Use the Zoom In button  to magnify a rectangular portion of a chart or plot from a Results 
screen. To use this feature, click the Zoom In button. The cursor will change to cross-hairs when 
it is positioned over a chart or graph. Click at one corner of  the rectangle to be enlarged and drag 
the mouse until the area to be enlarged is enclosed by the rectangle. Release the mouse button 
and the enclosed rectangle will be enlarged. The resulting expanded chart can be further enlarged 
multiple times by repeating the Zoom In function. 

Zoom Out 

Clicking the Zoom Out button  returns a chart or plot that has been enlarged to its normal 
view.  

Help 

The Help button opens the Mx3000P help system, giving access to help by contents, index, 
or searching. 

In addition, context-sensitive help is available at any time by pressing the F1 key. The 
appropriate help screen will automatically open. 
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Navigating in the Mx3000P Software 

Shortcut Keys 
Shortcut keys allow rapid execution of common commands and facilitate movement between the 
different sections of the Mx3000P software. 

Section Movement Shortcuts 

Alt+S takes you to the Setup section.      

Alt+R takes you to the Run section.         

Alt+A takes you to the Analysis section.   

Ctrl+<tab> takes you to the next tab within a section. For example, when on the Plate Setup 
screen of the Setup section, pressing Ctrl+<tab> takes you to the Thermal Profile screen. 

Menu Commands Shortcuts 

Menu commands may be executed by using keystroke shortcuts. Once a menu has been 
expanded (caused to drop down) by using a keystroke shortcut (Alt + the underlined letter in the 
menu name), the individual menu choices can be executed by pressing the key for the underlined 
letter within the command. For example, when the File menu is expanded by pressing Alt + F, 
pressing the C key will cause the experiment to close.  

 

The keystroke combinations listed below will execute their associated command even if the 
menu has not been expanded. 

File Menu 
New experiment -- Ctrl+N 
Open an existing experiment -- Ctrl+O 
Save an experiment -- Ctrl+S 
Save as-- Ctrl+A 
Print -- Ctrl+P 
Print Screen -- Alt+P 
Export to PowerPoint -- Ctrl+W 
Export to Image File -- Ctrl+I

Mx3000P™ Real-Time PCR System 
Edit Menu 

Undo -- Ctrl+Z 

Redo -- Ctrl+Y 

Copy -- Ctrl+C 

Paste -- Ctrl+V 

View Menu 

Zoom In -- Alt+Z 

Zoom Out -- Alt+O 
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Quick Protocols 
Plate Setup Quick Protocol 
Plate setup is performed by selecting a well or wells and then assigning well information for the 
selected well(s) using the command panel at the right of the screen. The command panel should 
generally be used in a top-to-bottom order, beginning with Well type assignment.  

1. Select the well or wells to be configured. 

2. Define the well type using the Well type menu. Available well types are specific to the 
type of experiment. 

3. Using the Collect fluorescence data check boxes, choose the dyes for which data should 
be collected in the selected well(s). 

4. If one of the dyes selected is a passive reference dye used for normalization, choose the 
dye from the Reference dye menu. (If all sample wells on the plate will contain the same 
passive reference dye, depress the All wells button.) 

5. If the well is a Standard, select the name of the standard dye and then enter the known 
amount of  template in Standard quantity. Select the units from the Standard units menu. 
The Auto-Increment feature expedites assigning quantities to Standards set up using a 
dilution series. 

6. Where appropriate, designate replicates by choosing the appropriate replicate set number 
from the Replicate symbol menu. It is often beneficial to define all wells on the plate 
according to steps 1–5 prior to replicate assignment. This facilitates using the Auto-
Increment feature to automatically assign sequential replicate numbers to the replicate 
sets on the plate.  

When Plate Setup is complete, for real-time experiments, click on the Next button to proceed to 
Thermal Profile setup. Plate read experiments may be initiated from the Plate Setup screen. 
Time-Saving Tips 

The Mx3000P software features several plate setup shortcuts including options for the  Import of 
an existing setup, for the use a Default setup, and for rapidly specifying collection of data for all 
dyes in all wells by using Quick Setup.  

Within a given experiment, information from groups of wells may be copied from one set of 
wells and pasted into another set of wells by using the Copy and Paste commands on the Edit 
menu or using the corresponding shortcut keys (Ctrl+C and Ctrl+V). 
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Quick Protocols 

Thermal Profile Setup Quick Protocol 
When a new Thermal Profile screen is opened, a default thermal profile appropriate to the 
experiment type appears on screen. Modify the default thermal profile as required for the new 
experiment. 
Adding and Modifying Plateaus 

To add a plateau in a segment, first select the plateau that will be positioned just before the new 
plateau. Next, under Add on the control panel, click Plateau with Ramp. A plateau will be added 
after the selected plateau, with a default  temperature of 25° C and duration of 30 seconds. 

To add a plateau to the beginning of a segment, select the whole segment then click Plateau with 
Ramp. 

Adjust the duration and  temperature of a plateau by double-clicking on the plateau to open the 
Plateau Properties dialog box.  Enter the Duration and the Temperature for the plateau in the First 
cycle section of the dialog box. If all cycles should have the same Duration and the Temperature 
as the First cycle, enter null values in the Cycle increments section of the dialog box. To 
incrementally change the  Duration or the Temperature for the plateau at each successive cycle, 
enter the appropriate increment or decrement in the Cycle increments section of the dialog box. 

The plateau temperature may also be adjusted by grabbing the plateau with the mouse and 
dragging it up or down. 
Adding and Modifying Segments 

To add a segment, first select the segment that will be positioned just before the new segment, 
and then click Normal Segment. A new segment will be added with a default plateau temperature 
of 25°C and duration of 30 seconds. 

Adjust the number of cycles for a segment by double-clicking in the segment to open the 
Segment Properties dialog box, and then entering the Number of Cycles. 
Adding and Modifying Data Collection Markers 

To add a data collection marker, grab the Endpoints data collection marker or the All points 

data collection marker and drag the icon to the appropriate plateau or ramp on the thermal 
profile. To remove a data collection marker, drag the marker icon from the thermal profile to any 
other part of the screen. The number of collection points appears at the upper right of the marker, 
and can be changed by clicking on the number to open a spin control. 

When Thermal Profile Setup is complete, click Start Run to begin thermal cycling and data 
collection. 
Time-Saving Tip 

The Mx3000P software features thermal profile setup shortcuts including the ability to Import the 
profile from of an existing experiment, and to store and retrieve user-defined Default thermal 
profiles. 
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Quick Protocols 

Running the Experiment Quick Protocol 

Real-Time Experiments  

Verify that the lamp is ready and, after loading the samples, that the instrument door is closed. 

 

Start the run from the Thermal Profile Setup screen by clicking the Start Run button. When the 
Run Status dialog box opens, click Start. 

The Run Status dialog box remains open for the duration of the run, reporting the run status. 
During thermal cycling, the status of the run can also be monitored on the Thermal Profile Status 
screen. The vertical green marker tracks the progress through the thermal cycling profile. 

To view accumulated fluorescence data during the run, click on the Raw Data Plots tab. On the 
Raw Data Plots screen, amplification plots for each dye in each well are displayed. The 
amplification plots can be expanded by selecting wells of interest and clicking Show Plots. 

When the thermal profile is complete, the software will automatically proceed to the Analysis 
section to analyze the data.  

Plate-Read Experiments 

Verify that the lamp is ready and, after loading the samples, that the instrument door is closed. 

 
On the Plate Setup screen, click Set Read Properties, and then enter the temperature and number 
of reads for the run. 

Start the run by clicking the Start Run button on the Plate Setup screen. 

When the Run Status dialog box opens, initiate collection of the appropriate set of data by 
clicking either Pre-Read or Post-Read.  

Single-Reading Experiments 

For single-read experiments, either Pre-Read or Post-Read may be used. Click here for more 
information on how this selection affects the reporting of results.  

Pre- and Post-Read Experiments 

For an experiment that utilizes pre-read and post-read data, complete the Pre-Read run and then 
exit and save the experiment. When ready to complete the post-read run, open the saved 
experiment, click Start Run from the Plate Setup screen, and then click the Post-Read button in 
the Run Status dialog box.   

During data collection, the status of the run is reported in the Run Status dialog box, which 
remains open for the duration of the run. The run can also be monitored on the Raw Data Plots 
screen.  

When the read is complete, the software will automatically proceed to the Analysis section to 
analyze the data.  
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Quick Protocols 

Quantitative PCR Analysis Quick Protocol 
After the thermal profile has run, the Analysis Selection/Setup screen will appear. 

1. Select the wells to be analyzed. 

2. Select the data set to be analyzed from the list under Select data collection ramp/plateau. 

Only ramps or plateaus associated with a collection marker may be selected. 

3. Select preferences for treatment of  Replicates and for the use of Algorithm 
enhancements: Amplification-based threshold, Adaptive baseline and Moving average. If 
you wish to review or modify other settings that will be used for analysis, click Analysis 
Term Settings or Adv. Algorithm Settings. 

4. Select the Results tab. 

5. Select the type of data analysis to be performed under Area to analyze: 

The Amplification plots screen shows a plot of cycles versus fluorescence for each well 
and dye for which data was gathered. Plots of baseline-corrected fluorescence (dR or dRn) 
allow the threshold fluorescence (used to determine Ct values) to be displayed and 
adjusted. 

The Plate sample values screen displays Fluorescence or Ct values for the sampled wells 
in a plate format.  
The Standard curve screen shows a plot of the log of the initial template quantity versus 
Ct values for the Standard wells. Standard curves are used to determine (by interpolation) 
the initial template quantities for Unknown wells. 

The Initial template quantity screen displays interpolated quantities of template in 
Unknown wells before thermal cycling. The interpolation is based on the standard curve.  

The Dual color scatter plot screen displays a scatter plot of Fluorescence or Ct for any two 
dyes assigned to the same wells. This plot helps in assessing the suitability of a specific 
control target by displaying any correlation between amplification of a gene of interest 
and amplification of the control target. 

The Text report screen shows the run data in text format. The columns included in the 
report are specified using the Column check boxes. 
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Quick Protocols 

Comparative Quantitation Analysis Quick Protocol 
After the thermal profile has run, the Analysis Selection/Setup screen will appear. 

1. Select the wells to be analyzed. 

2. Select the segment (Amplification or Dissociation) to be analyzed by clicking the 
corresponding button on the command panel. From the dialog box that opens, select the 
data set to be analyzed from the list. Only ramps or plateaus associated with a collection 

marker may be selected. 

3. Select preferences for treatment of  Replicates and for the use of Algorithm 
enhancements: Amplification-based threshold, Adaptive baseline and Moving average. If 
you wish to review or modify other settings that will be used for analysis, click Analysis 
Term Settings or Adv. Algorithm Settings. 

4. Select the Results tab. 

5. Select the type of data analysis to be performed under Area to analyze: 

The Amplification plots screen shows a plot of cycles versus fluorescence for each well 
and dye for which data was gathered. Plots of baseline-corrected fluorescence (dR or dRn) 
allow the threshold fluorescence (used to determine Ct values) to be displayed and 
adjusted. 

The Dissociation curve screen displays the fluorescence data collected during a 
dissociation segment of the run as a function of temperature. When performing SYBR 
Green dye-based detection, these data are used to verify that the predominant PCR 
products are amplicons of the gene of interest or the Normalizer targets. 

The Plate sample values screen displays Fluorescence or Ct values for the sampled wells 
in a plate format.  

The Standard curve screen shows a plot of the log of the initial template quantity versus 
Ct values for the Standard wells. The slope of the standard curve is used to calculate 
amplification efficiency for both the gene(s) of interest and the Normalizer targets. 

The Relative quantity chart screen displays a graphical representation of the amount of 
target present in Unknowns relative to the Calibrator (after correction using the 
Normalizer target). Results may be displayed as either a bar graph (default) or a scatter 
plot.  

The Relative quantity plate screen shows, in plate format, the relative quantities for each 
well and dye corresponding to a gene of interest (the Normalizer and Reference dyes are 
not quantified). Calibrators are defined as 1.0 and values for all Unknowns are relative to 
this benchmark.  

The Text report screen shows the run data in text format. The columns included in the 
report are specified using the Column check boxes. 
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Quick Protocols 

SYBR Green Analysis Quick Protocol 
After the thermal profile has run, the Analysis Selection/Setup screen will appear. 

1. Select the wells to be analyzed. 

2. Select the segment (Amplification or Dissociation) to be analyzed by clicking the 
corresponding button on the command panel. From the dialog box that opens, select the 
data set to be analyzed from the list. Only ramps or plateaus associated with a collection 

marker may be selected. 

3. Select preferences for treatment of  Replicates and for the use of Algorithm 
enhancements: Amplification-based threshold, Adaptive baseline and Moving average. If 
you wish to review or modify other settings that will be used for analysis, click Analysis 
Term Settings or Adv. Algorithm Settings. 

4. Select the Results tab. 

5. Select the type of data analysis to be performed under Area to analyze: 

The Amplification plots screen shows a plot of cycles versus fluorescence for each well 
and dye for which data was gathered. Plots of baseline-corrected fluorescence (dR or dRn) 
allow the threshold fluorescence (used to determine Ct values) to be displayed and 
adjusted. 

The Dissociation curve screen displays the fluorescence data collected during the 
dissociation segment of the run as a function of temperature. These data are used to verify 
that the predominant PCR products are amplicons of the gene of interest. Plotting the 
temperature versus the first derivative of the fluorescence (–R´(T) or –Rn´(T)) generates a 
dissociation profile with peaks that identify the melting temperatures of each of the major 
product populations in the reaction mixture. 

The Plate sample values screen displays Fluorescence or Ct values for the sampled wells 
in a plate format.  
The Standard curve screen shows a plot of the log of the initial template quantity versus 
Ct values for the Standard wells. Standard curves are used to determine (by interpolation) 
the initial template quantities for Unknown wells. 

The Initial template quantity screen displays interpolated quantities of template in 
Unknown wells before thermal cycling. The interpolation is based on the standard curve.  

The Text Report screen shows the run data in text format. The columns included in the 
report are specified using the Column check boxes. 
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Quick Protocols 

Allele Discrimination Real-Time Analysis Quick 
Protocol 
After the thermal profile has run, the Analysis Selection/Setup screen will appear. 

1. Select the wells to be analyzed. 

2. Select the data set to be analyzed from the list under Select data collection ramp/plateau. 

Only ramps or plateaus associated with a collection marker may be selected. 

3. Select preferences for treatment of  Replicates and for the use of Algorithm 
enhancements: Amplification-based threshold, Adaptive baseline and Moving average. If 
you wish to review or modify other settings that will be used for analysis, click Analysis 
Term Settings or Adv. Algorithm Settings. 

4. Select the Results tab. 

5. Select the type of data analysis to be performed under Area to analyze: 

The Amplification plots screen shows a plot of cycles versus fluorescence for each well 
and dye for which data was gathered. Plots of baseline-corrected fluorescence (dR or dRn) 
allow the threshold fluorescence (used to determine Ct values) to be displayed and 
adjusted. 

The Plate sample values screen displays Fluorescence or Ct values for the sampled wells 
in a plate format.  

The Dual color scatter plot screen displays a scatter plot of Fluorescence or Ct for any two 
dyes assigned to the same wells.  Each point represents the coordinates of the 
Fluorescence or Ct for the two dyes in a single well. The plot provides a simple method 
for grouping the sample wells according to the amplification events indicated by either 
single dye (i.e. homozygous for one of  two alleles) or by both dyes (i.e. heterozygous for 
the two alleles).  

The Final call results screen provides a simple depiction of whether product was 
accumulated for each dye in each well. A plus sign (+) signifies accumulation of 
product, while a minus sign (–) signifies that product accumulation was not detected. 
Calling is based on Ct, where + is returned if the Ct is less than the last cycle for which 
data was collected. 

The Text report screen shows the run data in text format. The columns included in the 
report are specified using the Column check boxes. 
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Quick Protocols 

Molecular Beacon Melting Curve Analysis Quick 
Protocol 
After the thermal profile has run, the Analysis Selection/Setup screen will appear. 

1. Select the wells to be analyzed. 

2. Select the data set to be analyzed from the list under Select data collection ramp/plateau. 

Only ramps or plateaus associated with a collection marker may be selected. 

3. Select preferences for treatment of  Replicates. If you wish to review or modify the read 
statistic that will be used for analysis, click Adv. Algorithm Settings. 

4. Select the Results tab. 

5. Select the type of data analysis to be performed under Area to analyze: 

The Annealing range screen displays the optimal annealing range for the beacon(s) 
tested. The optimal range is the temperature range in which the molecular beacon plus 
perfectly- matched oligo (MBO) has a greater fluorescence than the beacon plus 
mismatched oligo (MBMO) and in which the background fluorescence is low. 

The Melting curves/temperature screen calculates and displays the optimal melting 
temperature for the beacon(s) tested. 
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Quick Protocols 

Quantitative Plate Read Analysis Quick Protocol 
After the read is complete, the Analysis Selection/Setup screen appears. 

1. Select the wells to be analyzed. 

2. Select preferences for treatment of  Replicates. If you wish to review or modify other 
settings that will be used for analysis, click Analysis Term Settings or Adv. Algorithm 
Settings. 

3. Select the Results tab. 

4. Select the type of data analysis to be performed under Area to analyze. 

The Plate sample values screen displays Fluorescence values for the sampled wells in a 
plate format.  
The Standard curve screen shows a plot of the log of the initial template quantity versus 
Fluorescence values for the Standard wells. Standard curves are used to determine (by 
interpolation) the initial template quantities for Unknown wells. 

The Initial template quantity screen displays interpolated quantities of template in 
Unknown wells. The interpolation is based on the standard curve.  

The Dual color scatter plot screen displays a scatter plot of Fluorescence for any two dyes 
assigned to the same wells. This plot helps in assessing the suitability of a specific control 
target by displaying any correlation between amplification of a gene of interest and 
amplification of the control target. 

The Fluorescence Intensity Values screen displays a colorized image of final calls and 
fluorescence intensities. A plus sign (+) indicates a positive call and a minus sign (–) 
indicates a negative call. A spectrum of colors is used to indicate the relative fluorescence 
readings for each dye in each well. 

The Final call results screen provides a simple depiction of whether product was 
accumulated for each dye in each well. A plus sign (+) signifies accumulation of 
product, while a minus sign (–) signifies that product accumulation was not detected. 
Calling is based on fluorescence, where + is returned if the fluorescence value is 
statistically greater than the value measured for the control. 

The Text report screen shows the run data in text format. The columns included in the 
report are specified using the Column check boxes. 
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Quick Protocols 

Plate Read/Allele Discrimination Analysis Quick 
Protocol 
After the read is complete, the Analysis Selection/Setup screen appears. 

1. Select the wells to be analyzed. 

2. Select preferences for treatment of  Replicates. If you wish to review or modify other 
settings that will be used for analysis, click Analysis Term Settings or Adv. Algorithm 
Settings. 

3. Select the Results tab. 

4. Select the type of data analysis to be performed under Area to analyze: 

The Plate sample values screen displays Fluorescence values for the sampled wells in a 
plate format.  

The Dual color scatter plot screen displays a scatter plot of fluorescence for any two dyes 
assigned to the same wells.  Each point represents the coordinates of the Fluorescence for 
the two dyes in a single well. The plot provides a simple method for grouping the sample 
wells according to the amplification events indicated by either single dye (i.e. 
homozygous for one of  two alleles) or by both dyes (i.e. heterozygous for the two 
alleles).  

The Fluorescence intensity values screen displays a colorized image of final calls and 
fluorescence intensities. A plus sign (+) indicates a positive call and a minus sign (–) 
indicates a negative call. A spectrum of colors is used to indicate the relative fluorescence 
readings for each dye in each well. 

The Final call results screen provides a simple depiction of whether product was 
accumulated for each dye in each well. A plus sign (+) signifies accumulation of 
product, while a minus sign (–) signifies that product accumulation was not detected. 
Calling is based on comparing the experimentally determined p-value (probability that a 
reading differs from the control readings) for each dye in each well to the user-defined 
Confidence level for calls. 

The Text report screen shows the run data in text format. The columns included in the 
report are specified using the Column check boxes. 
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How-To (Detailed Protocols) 
How to Set Up a New Experiment 
To set up an experiment on the Mx3000P real-time PCR system, choose the experiment type 
from the New Experiment Options dialog box (accessed by clicking the New button  on the 
toolbar). 

The setup consists of two steps for a real-time experiment:  

1.  Plate Setup: In this step, the plate is configured including assigning well types and dyes 
to wells 

2. Thermal Profile Setup: In this step, the thermal profile is configured for temperature 
cycling and data collection parameters 

For plate read experiments, only Plate Setup is required. 

Some aspects of  the contents of the Plate Setup and Thermal Profile Setup screens for a new 
experiment are determined by the properties of the software's active default set. For example, 
user-defined default sets may be set up to include the plate configuration as well as the thermal 
profile and analysis settings. See Preferences-Defaults in the Navigating in the Mx3000P 
Software section for more information on creating and managing default sets. 

If the experiment will be started within the next 20 minutes, and the lamp is off, turn the lamp on 
to allow it to warm to operating temperature by the time the experiment begins. To turn on the 
lamp, click the  Lamp On/Off button  on the toolbar. 
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How-To (Detailed Protocols) 

Plate Setup 

Introduction to Plate Setup 

To access the Plate Setup window, click the Setup button on the toolbar and then click the Plate 
Setup tab. Use the Plate Setup window to provide the specifications for sample wells in the 
experiment. 

Adding well information during plate setup consists of two steps: 

1) Select the wells to be configured 

2) Assign the appropriate characteristics to the selected wells 

Alternatively, plate setup may be accomplished using one of three shortcuts: using Import plate 
setup, using a Default plate setup or using Quick Setup. 

Most features of the plate setup can be modified before, during, and after a run.  

Comments can be entered in the Plate setup comments text box at the lower right-hand corner of 
the screen and the comments will be saved along with the experiment. 

After all plate setup functions are complete, for real-time experiments, click Next in the lower 
right-hand corner to proceed to the Thermal Profile Setup screen. For plate read experiments, you 
may start the run from the Plate Setup screen.  

 

Mx3000P™ Real-Time PCR System 80 



How-To (Detailed Protocols) 

Plate Setup Display Options 

A number of modifications to the appearance of the Plate Setup screen may be made to facilitate 
the plate setup process. Using any of these display modification features will not affect the data 
collected or the analysis available for the experiment. 
Displaying or Hiding Dyes 

The dyes in use on the plate may be displayed or hidden by using the Dyes shown selection bar at 
the lower left-hand corner of the screen. When the button is depressed (like FAM in the picture 
below), the dye's well assignments are displayed, but when the button is released (like ROX in the 
picture below), the dye's well assignments are hidden from display. Note that using this feature 
does not affect data collection. 

 
Displaying or Hiding Specific Well Types 

The well types that are displayed on the plate are controlled by using the buttons in the Well 
types shown selection bar. Any of the well type buttons may be depressed in order to display the 
information for wells of the indicated type or may be released to hide the information. For 
example, if you want to view only the Unknown wells on the plate, depress the Unknown button 
and release all other well type buttons (such as the NTC button in the example below). Note that 
using this feature does not affect data collection. 

 
Color Coding Well Types 

The Enable well type colors command, accessed on the Display tabbed page of the Preferences 
dialog box, causes a horizontal color bar to be displayed across the top of each well. The color of 
this bar corresponds to the well type selected to allow a quick identification of well types. Well 
type colors can be changed in the Colors tabbed page of the Preferences dialog box. When Enable 
well type colors is selected, wells appear as shown below. 

 
When Enable well type colors is cleared, the same wells appear as shown below. 
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Selecting Wells 

The first step of Plate Setup is selecting the wells to which well information will be assigned. 
Wells must be selected/highlighted before well types and other information can be assigned. 

 

To select an individual well, single click in that well.  

To select an entire row or column, click on the row header or column header. 

To select all wells in the plate, click All in the upper left-hand corner of the plate. 

Select a contiguous block of wells by dragging across the range of wells with the mouse while 
holding the left mouse button down. A visible rectangle will appear. Release the left mouse 
button to select the cells included in the rectangle. 

Select a group of non-contiguous wells by holding down the Ctrl button on the keyboard while 
selecting wells. 

To deselect a well, hold down the Ctrl key and click on the well to be deselected. To rapidly 
deselect many wells, click the All button twice. This will select and then deselect all wells. 
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How-To (Detailed Protocols) 

Assigning Well Types and Dyes for Data Collection 

Plate Setup is accomplished using the selection boxes and commands on the command panel at 
the right of the screen. The command panel is designed to be followed in a top-to-bottom order, 
beginning with Well type assignment. All other selections are unavailable until after Well type 
has been assigned. 

 

Assigning the Well Type 

After selecting one or more wells, assign the well type to the selected wells. 

To assign the well type, click on the arrow in the Well type menu. A list of well types specific to 
the experiment type will appear. Select the well type to be assigned to the well(s). 

Selecting the Dyes for Data Collection 

Once a well type is assigned, select the dyes for which fluorescence data are to be collected for 
the well(s) using the Collect fluorescence data checkboxes. Data can be collected for up to four 
dyes. Fluorescence data are collected for only those dyes selected for each well.  

Clearing Wells 

To clear the information assigned to selected well(s), including well type, data collection 
specifications and replicate set designations, click the Clear Selected Wells button. 

Use of Copy/Paste for Entering Well Information 

Within a given experiment, information from groups of wells may be copied from one set of 
wells and pasted into another set of wells by using the Copy and Paste commands on the Edit 
menu or using the corresponding shortcut keys (Ctrl+C and Ctrl+V). 
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How-To (Detailed Protocols) 

Assigning a Reference Dye 

Passive reference dyes are used for normalization of the fluorescence signal, in order to 
compensate for non-PCR related variations in fluorescence. Typically, ROX is used as the 
reference dye. Only dyes assigned to optical paths in the Optics Configuration dialog box are 
available for assignment as reference dyes. 

If a dye was added as a passive reference dye in the experiment, select the dye from the 
Reference dye menu. The assignment of that dye as a reference dye will be indicated in the 
selected well(s) by the presence of the text REF in the position of the dye in the well. 

If all sample wells on the plate will contain the same passive reference dye, depress the All Wells 
button. This will cause the selected dye to be assigned as a reference dye for all sample wells on 
the plate. 
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Assigning Quantities to Standard Wells 

If a sample type of Standard is assigned to the selected well(s), specify the quantity of the 
standard added and the unit of measurement using the Standard quantity box and the Standard 
units menu. This section of the command panel is enabled only when wells assigned as 
Standards are selected.  

First, select the dye associated with the standard from the pulldown menu following Standard 
quantity. Next, enter the quantity of the standard added to the selected well(s) in the rightmost 
box following Standard quantity as a decimal number (for example, 500 or 1.234). Specify the 
units for the quantity in the Standard units menu. The standard quantity value will be converted 
to scientific notation and will appear in the selected wells in the position of the designated dye. 
When using a dilution series to generate a standard curve, the Auto-Increment utility can be used 
to expedite the process of assigning quantities to Standard wells. See below for more information 
on the use of this feature. 

                 
Time-Saving Tip - Using the Auto-Increment Feature 

When using a dilution series to generate a standard curve, the Auto-Increment utility may be used 
to expedite standard quantity assignments during plate setup. When using this feature, given one 
quantity in the dilution series, the software will automatically assign standard quantities to 
sequential sets of Standard wells according to the specified dilution factor. 
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To assign Standard quantities using Auto-Increment, first complete the well type and data 
collection assignments for all of the Standard wells in the dilution series. When finished, select 
all replicates of the first set of Standard wells in the dilution series. Select the dye associated 
with the target, and then enter the quantity of target in the box to the right of the dye. Specify the 
standard quantity units for this dilution series from the Standard units menu.  

 

After the assignment of the first replicate set in the dilution series is complete, click the Auto-
Increment: 10x menu to expand the menu. Select the appropriate description of the dilution series 
from the menu. Note that if you begin the process with the wells containing the lowest 
concentration of target in the dilution series, a positive increment (e.g. 10× or 2×) should be 
selected such that the subsequent wells will be assigned with multiples of the dilution factor. 
Conversely, if you begin the process with wells containing the highest concentration of target, a 
negative increment (e.g. –10× or –2×) should be selected. If the dilution factor used in the 
current experiment is not listed in the menu, select Custom to access the Custom Auto-Increment 
dialog box, in which user-defined increment values may be entered. Note that positive custom 
increment values should be entered when starting assignments with the lowest concentration in 
the series and negative custom increment values should be entered when starting assignments 
with the highest concentration in the series. 

              

When the cursor is moved to the plate area on the screen, it will change to a hand symbol 
containing the incrementally-adjusted standard quantity value. 

 

 Using the hand-cursor, select the range of cells corresponding to the next set of Standards in the 
dilution series. When the mouse button is released, the quantity that had shown in the cursor will 
appear in the wells that had been selected and the number showing in the cursor will change 
incrementally.  
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Repeat the standard quantity assignment process using the hand-cursor until all members of the 
dilution series have been assigned, and then click on the Auto-Increment: 10x button again to 
restore the standard cursor. 

Converting Standard Quantity Units 

To convert standard quantity units in assigned wells, select a Standard well that contains the 
original standard quantity defined in the original units and then select the new unit description 
from the Standard units menu. When the basic unit type is the same (e.g. milligrams to 
micrograms) the conversion will occur automatically. When the units describe different 
properties of the sample (e.g. moles to grams), the Standard Quantity Unit Conversion dialog box 
will open and prompt for the molecular weight.  

 

To complete the conversion, which will change the numerical value in the Standard wells in 
addition to changing the units, enter the molecular weight and then click Convert. The 
conversion will be applied to all Standard wells on the plate.  

To change the units while retaining the numerical values assigned to Standards (e.g. to simply 
correct erroneous units for a correct numerical value) click Don't Convert. To return to Plate 
Setup without changing any numerical values or unit designations, click Cancel. 
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Assigning Replicates 

Identify replicate wells on the plate by assigning the same replicate symbol to the group of wells 
that make up a replicate set. Assigning replicates allows the option of treating the wells 
collectively during analysis. See Treatment of Replicates for more information on the effects of 
treating replicates individually or collectively during analysis. Note that although replicates are 
assigned on the Plate Setup screen, you can choose whether or not to use replicates during data 
analysis on the Analysis Selection/Setup screen.  

Identifying Samples as Replicates 

To specify replicates during Plate Setup, select those wells which contain the replicated samples 
and then select the appropriate replicate set number from the Replicate symbol menu. 

 

Replicates are assigned to the selected wells as soon as the replicate number is selected.  

 
Time-Saving Tip - Using the Auto-Increment Feature 

The Auto-Increment utility may be used to expedite replicate set assignments during plate setup. 
This utility is used to sequentially assign a series of different replicate sets with increasing 
replicate symbol numbers using an automatic counting mechanism.  

To assign replicates using Auto-Increment, first assign well types and dye collection attributes to 
all of  the wells that will be assigned with replicate symbols. When finished, click on any sample 
well to enable the Auto-Increment feature. Click the Auto-Increment button in the Identify 
replicates section of the command panel.  

 

Mx3000P™ Real-Time PCR System 88 



How-To (Detailed Protocols) 

When the cursor is moved to the plate area on the screen, it will change to a hand symbol 

containing the next available replicate set number  . Using the hand-cursor, select a range of 
cells to be grouped as replicates. When the mouse button is released, the replicate symbol that 
had shown in the cursor will appear in the wells and the number in the cursor will increase 

incrementally.  

Select the next set of replicate wells with the hand-cursor to assign the new replicate symbol to 
those wells. Repeat this process until all replicates have been assigned. When finished making 
assignments, click on the Auto-Increment button again to restore the standard cursor. 

Invalid Replicate Sets 

Only identically assigned wells should be designated as replicates. The software uses a number 
of methods to prevent incompatible wells from being assigned as replicates. If the warning below 
appears, non-identical wells have been assigned the same replicate number.  

 

Clicking the Invalid Sets button opens a dialog box that indicates which replicate sets have a 
conflict. To resolve these conflicts, reassign replicates such that only wells with the same 
attributes are grouped. 

 

Entering Custom Well Information 

Each well in Plate Setup has a comment box available for entering a well name (48-character 
maximum) and well-specific comments. The Well Information dialog box is accessed by double-
clicking on the well while in Plate Setup. The well name is visible in the well in the Full-Screen 
Plate view (first 10–14 characters) and may be included in the Text Report (all characters). 
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Using Import Plate Setup 

The Import Plate Setup function allows you to recall a plate setup from an existing experiment. 
Clicking Import Plate Setup on the Plate Setup screen causes the software to display the Import 
Plate Setup From dialog box. 

The Import Plate Setup From dialog box lists Mx3000P experiments stored in the Mx3000P data 
storage folder. Select the experiment that includes the desired plate setup information, then click 
Open. 

 

If the experiment selected is not compatible with the experiment being set up, a warning dialog 
box appears as shown below. If this warning appears, click the OK button and select another 
experiment of the same type as the one being set up. 
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Using a Default Plate Setup 

Plate setup may be completed by incorporating a user-defined default plate configuration into the 
Plate Setup for new experiments.  

Using a default plate setup requires creating a default set containing the desired plate 
configuration. Note that the Plate Setup checkbox under Include must be selected when the 
default set is created in order for Plate Setup information to be included in the default set. 

Once the appropriate default set is created, select this default set as the active default set in the 
Choose set menu of the Preferences-Defaults dialog box and then click OK. The plate 
configuration stored in the active default set, including all well assignments, will automatically 
be applied to the open experiment and to all new experiments, until the active default set is 
changed again.  
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The plate configuration in an existing default set may also be applied to the plate setup in an 
open experiment by using the Defaults menu on the control panel of the Plate Setup screen. To 
retrieve the plate configuration from the active defaults set, click Defaults to expand the menu, 
and then select Get.  

See Preferences-Defaults for more information about creating and using default sets to 
streamline experimental setup and analysis. 
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Using Quick Setup 

Clicking the Quick Setup button on the Plate Setup screen automatically enters well information 
for all wells, such that fluorescence data are collected for all four dyes in all 96 wells. This 
feature saves up-front setup time. Because all other parts of Plate Setup can be modified during 
and after a run, using Quick Setup allows you to collect all dye data for all wells and then 
configure the plate after the run. 
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Using the Full-Screen Plate View 

To enlarge the view of the plate to cover the full screen, click the Full-Screen Plate button at the 
bottom of the command panel (lower right-hand corner of the Plate Setup screen). No 
modifications to the plate setup parameters can be performed in the full-screen view.  

To print the plate from full-screen plate view, click Print in the upper right of the screen. If you 
want to print all contents of the screen, including title bars and toolbars, select Print Screen from 
the File menu. The size of either type of printed image can be altered by selecting Page Setup 
from the File menu, which opens the Print Page Setup dialog box. The valid size range is from 
25% to 100%. 

If a Name was assigned to a well under Well Information, it will be visible in Full-Screen Plate 
view. To see or edit Comments recorded in the Well Information dialog box, select the well of 
interest, and then click Name & Comments. Alternatively, double-click on the well of interest to 
access the Well Information dialog box for that well. 

To return to Plate Setup in order to continue with experimental setup, click the Return to Setup 
Screen button. 
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Thermal Profile Setup 

Thermal Profile Introduction 

The Mx3000P real-time PCR system thermal profile is a visual representation of the temperature 
cycling program that directs the instrument to incubate samples at specific temperatures at 
specific times. The programmed temperatures represent the desired fluid temperatures of the 
reaction samples. The Mx3000P system thermal profile consists of plateaus, ramps and 
segments. Thermal profiles are used only in real-time experiments; in plate read experiments, 
samples are held at a single temperature. 

Elements of the Mx3000P Thermal Profile 

A plateau is a temperature held over a period of time. It is represented with a solid horizontal 
line in a thermal profile. The valid temperature range is 25° (ambient) to 99°C. The valid range 
for a plateau duration is 1 second to greater than 18 hours. 

A ramp is the transition between two plateaus. 

A segment is a group of 1 to 127 plateaus and the intervening ramps that has been set to cycle at 
least one time. Segments are delineated in the thermal profile by vertical dotted lines. 

A cycle is one pass through a segment. Each segment can be set to cycle up to 255 times. 
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Data Collection During Thermal Cycling 

The Mx3000P system can collect data during the plateaus and ramps of a thermal profile. 

Two types of data collection are available: Endpoints and All Points. See Data Collection for 
more detailed information on how readings are taken and analyzed using these collection 
settings. 

Data collection markers show the points designated for data collection on the Thermal Profile 
display. 

Endpoint collection, indicated by the Endpoint data collection marker causes the system to 
take readings at the end of a plateau or ramp.  

All points collection, indicated by the All points data collection marker causes the system to 
take readings as often as possible during a plateau or ramp.  
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Thermal Profile Setup Procedures 

When the Thermal Profile Setup tab is selected in a new experiment, a default thermal profile 
appropriate to the experiment type appears. The default thermal profile offers a starting point for 
creating the appropriate thermal profile for the experiment. Instructions for modifying the default 
thermal profile by adding or changing segments, plateaus and ramps are provided below. 

 For information on importing a thermal profile from another experiment, see Import Thermal 
Profile Setup. For more background information on the nomenclature and functions of the 
thermal profile components, see Thermal Profile Introduction. 

 

Adding a Normal Segment 

To add a normal segment, go to the Add section of the command panel and click the Normal 
Segment button. The segment added will have one plateau with a default temperature of 25°C 
and a default cycle number of 1 cycle. See Adding a Plateau to a Segment, below, for 
information on adding or modifying plateaus in the new segment. 
Position of the Added Segment 

If no segment is selected when the Normal Segment button is clicked, the new segment will be 
added to the beginning of the profile. If an entire segment is selected when the Normal Segment 
button is clicked, the new segment will be added after the selected segment.  
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Properties of the Added Segment 

To adjust the number of cycles for the segment, double-click in the segment to open the Segment 
Properties dialog box, and then enter the Number of Cycles. Alternatively, click on the cycle 
number text below the segment to change the value. 

If you want to add a descriptive label for the segment, double-click in the segment to open the 
Segment Properties dialog box, and then enter the desired text in the Label box. 

For more information, see Segment Properties Dialog Box. 

Adding a Plateau to a Segment 

To add a plateau, go to the Add section of the command panel and click the Plateau with ramp 
button. When a plateau is added, ramps leading to and from the new plateau are also added by 
the software. 
Position of the Added Plateau 

If no segment or plateau is selected when the Plateau with ramp button is clicked, the new 
plateau will be added at the beginning of the first segment of the profile. If an entire segment is 
selected when the Plateau with ramp button is clicked the plateau will be added to the beginning 
of the segment. If a plateau is selected when the Plateau with ramp button is clicked, the new 
plateau will be added after the selected plateau within the same segment.  
Properties of the Added Plateau 

The default temperature for a new plateau is 25°C and the default duration is 30 seconds. 

The plateau temperature and duration may be modified by any of the following methods: 

• Grab the plateau with the mouse and drag it up or down to change the temperature 

• Double-click on the plateau to open the Plateau Properties dialog box 

• Click on the temperature or duration value associated with the plateau on the Thermal 
Profile screen; this action opens a spin box in which the value may be changed 

A data collection marker may be added to the plateau by using the Plateau Properties dialog box 

or by dragging the appropriate collection marker  from the command panel to the plateau on 
the Thermal Profile screen. 

For more information, see Plateau Properties Dialog Box. 

Modifying Ramps 

When a plateau is added, ramps leading to and from the new plateau are automatically added. 
Likewise, when a segment or plateau is deleted, the associated ramps are deleted or modified as 
necessary to connect adjacent plateaus.  
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A data collection marker may be added to the ramp by using the Ramp Properties dialog box or 

by dragging the appropriate collection marker  from the command panel to the ramp on the 
Thermal Profile screen. 

For more information, see Ramp Properties Dialog Box. 

Deleting a Plateau or Segment 

A plateau or segment can be deleted by selecting the plateau or segment and then clicking the 
Delete button in the Selection section of the command panel. If a plateau is deleted, the 
associated ramps are also deleted or modified as necessary to connect adjacent plateaus. 

Modifying Data Collection Settings 

Data collection events are shown on the Thermal Profile screen as either Endpoint or All 

points data collection markers. A data collection marker may be added to any ramp or 
plateau, by dragging the appropriate collection marker from the command panel to the plateau on 
the Thermal Profile screen. See Data Collection for a detailed description of data collection 
options.  

Adding Comments 

Information about the thermal profile can be entered in the Thermal profile comments text box at 
the lower right-hand corner of the screen. The comments are saved as part of the experiment. 
Note that the Thermal profile comments  are distinct from any comments entered on the Plate 
Setup screen. 

Displaying a Full-Screen Thermal Profile 

If the profile becomes too wide to fit on the screen, a horizontal scroll bar will appear below the 
profile. The entire profile can be seen on the screen by clicking on the Full Screen Profile button 
in the lower right-hand corner of the screen. In full-screen view, the profile cannot be edited. To 
edit the profile, press the Return to Thermal Profile button in the lower right-hand corner. 

Starting the Run 

When finished setting up the Thermal Profile, click on the Start Run button at the lower right-
hand corner of the screen. This will save the experiment and start the run. If the experiment has 
not already been saved, the Save As dialog box will appear. 
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Thermal Profiles for Individual Experiment Types 

Additional information on Thermal Profile Setup specific to the individual experiment types is 
found in the individual experiment sections: 

Quantitative PCR Thermal Profile Setup 

Comparative Quantitation Thermal Profile Setup 

SYBR Green Thermal Profile Setup 

Allele Discrimination/SNP's Real-Time Thermal Profile Setup 

Molecular Beacons Melting Curve Thermal Profile Setup 

Plate read experiments do not use a thermal profile; the temperature is constant during the read. 
See Running a Plate-Read Experiment. 
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Plateau Properties Dialog Box 

The Plateau Properties dialog box is used to modify the properties of a plateau, including 
temperature, duration, and data collection. To access this dialog box, do one of the following: 

• Double-click on the plateau. 

• Select the plateau. Go to the Selection section of the command panel and click Edit 
Properties. 

 

Temperature and Duration (First Cycle) 

Set the Temperature and Duration of the first cycle in the First cycle section of the dialog box. 
The values listed under First cycle will be used for all cycles unless the Cycle increments default 
null values are modified. Duration and Temperature values may be typed directly or may be 
selected by using the spin controls. 

When data are collected for a plateau, the plateau has a minimum duration based on the time 
required for data collection. The amount of time required for data collection depends both on the 
configuration of wells from which data are being collected and on the number of data collection 
points specified. If the duration specified for the plateau is not sufficient to allow the specified 
data collection routine, a dialog box similar to the one shown below will appear. Adjust either 
the plateau Duration or the Data collection settings accordingly. 
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Cycle Increments 

The Cycle Increments controls allow you to set the instrument to incrementally increase or 
decrease the temperature or duration of a plateau with each cycle within the segment.  

Setting Time to a positive number will cause the duration of the plateau to increase by the 
specified amount of time with each cycle. Setting Time to a negative number will cause the 
plateau duration to be shortened by the specified amount of time each cycle. 

Similarly, setting Temperature to a positive number will cause the temperature to increase by the 
specified number of degrees with each cycle and setting the Temperature to a negative number 
will cause the temperature to decrease by the specified number of degrees with each cycle. This 
setting can be adjusted in 0.1-degree increments.  
 
Example of Thermal Profile using Cycle Increments 

An important use of cycle increments is in performing a dissociation curve. A thermal profile for 
a SYBR Green experiment is shown below and includes a Dissociation segment that is set up with 
a 1.0 degree Cycle increment. On the Thermal Profile, the incremental change in plateau 
temperature is indicated by the upward-arrow adjacent to the plateau temperature text. In this 
segment of this experiment, the temperature of the plateau in the first cycle will be 55°C and then 
will increase by 1.0°C at every cycle. 
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Data Collection Settings in Plateau Properties 

In the Plateau Properties dialog box, each plateau will have one of the following Data collection 
settings: None, Endpoints or All Points.   

 

To set the instrument to collect data for the plateau, select either Endpoints or All Points from the 
Type menu. Selecting Endpoints will enable the #of endpoints selection box. Type or select the 
number of reads to be taken at the end of the plateau period in each cycle.  

See the Data Collection section for a detailed discussion of how the Data collection settings 
options affect data collection and analysis. 
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Ramp Properties Dialog Box 

The Ramp Properties dialog box is used to modify the properties of a ramp, including whether 
and how data are collected during the ramp.  To access this dialog box from the Thermal Profile 
screen, do one of the following: 

• Double-click on the ramp. 

• Select the ramp. Go to the Selection section of the command panel and click Edit 
Properties. 

 
 

Data Collection Settings in Ramp Properties 

In the Ramp Properties dialog box, each ramp will have one of the following Data collection 
settings: None, Endpoints or All Points. 

To set the instrument to collect data for the ramp, select either Endpoints or All Points from the 
Type menu. Selecting Endpoints will enable the #of endpoints selection box. Type or select the 
number of reads to be taken at the end of the ramping period in each cycle.  

See the Data Collection section for a detailed discussion of how the Data collection settings 
options affect data collection and analysis. 
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Segment Properties Dialog Box 

The Segment Properties dialog box is used to modify the properties of a segment. To access this 
dialog box, do one of the following: 

• Double-click on the segment (but not directly on a ramp or plateau). 

• Select the plateau. Go to the Selection section of the command panel and click Edit 
Properties. 

 
Number of Cycles 

Enter or select the number of times that the segment should be repeated (cycled) in the Number 
of cycles box. The acceptable range is 1–255. 
Label 

To add a descriptive label to the segment, which will appear below the number of cycles on the 
Thermal Profile, type the desired text in the Label box. The maximum length is 22 characters. 
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Data Collection 
The points at which data should be collected by the Mx3000P instrument during thermal cycling 
are specified on the Thermal Profile. Two types of data collection are available: Endpoints or All 
Points.  

Data collection markers  show the points designated for data collection on the Thermal 
Profile display.  

In the Plateau Properties or Ramp Properties dialog box, each plateau or ramp will have a Data 
collection setting of  None, Endpoint or All Points in the Type menu.    

 

Endpoint Data Collection 

Endpoint data collection causes the system to take readings at the end of a plateau or ramp. 
Setting the number of data collection points (the range is 1–31) specifies how many data points 
will be collected. The system calculates the time necessary to read the plate the specified number 
of times and then begins reading when that amount of time remains in the plateau or ramp. For 
example, if reading a plate takes 7 seconds and the specified number of data collection points is 
3, the system will begin collecting data when 21 seconds remain in the plateau or ramp. How the 
multiple endpoint readings are handled during analysis is specified using the Advanced 
Algorithm Settings dialog box during Analysis Selection/Setup. 

To include an Endpoint data collection step in a ramp or plateau, in the Plateau Properties or 
Ramp Properties dialog box (accessed by double-clicking the ramp or plateau) select Endpoint 
from the Type menu. Enter the desired number of data collection points in the # of endpoints spin 
box. 

Identical results are achieved on the Thermal Profile display screen by dragging an Endpoints 

data collection marker from the command panel to the desired plateau or ramp. Once the 
marker is in place, the number of collection points appears at the upper right of the marker, and 
can be changed by clicking on the number to open a spin control. 
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All Points Data Collection 

All Points data collection causes the system to take readings as often as possible during a plateau 
or ramp. How the multiple readings for each cycle are handled during analysis is specified using 
the Advanced Algorithm Settings dialog box during Analysis Selection/Setup. 

To include an All Points data collection step in a ramp or plateau, in the Plateau Properties or 
Ramp Properties dialog box (accessed by double-clicking the ramp or plateau) select All Points 
from the Type menu. Identical results are achieved on the Thermal Profile display screen by 

dragging an  All points data collection marker from the panel on right-hand side of the screen 
to the desired plateau or ramp. 

No Data Collection 

In the Plateau Properties or Ramp Properties dialog box (accessed by double-clicking the ramp or 
plateau) a setting of None in the Type menu causes no data to be collected during the plateau or 
ramp. This is the default setting for new plateaus or ramps added to a thermal profile.  

Plateaus or ramps that currently have data collection settings of Endpoint or All Points may be 
changed to None by selecting None from the Type menu or by dragging the appropriate data 
collection marker off of the Thermal Profile display area. 

Data Collection-Based Constraints on the Thermal Profile 

A plateau has a minimum duration needed to acquire data. If the duration specified is not 
sufficient for the indicated data collection on the plateau, a dialog box similar to the one shown 
below will appear. Adjust either the plateau Duration or the Data collection settings accordingly. 

 

The plateau minimum duration for acquiring data varies based on the Plate Setup configuration. 
The configuration determines the minimum duration by specifying the number of well rows 
collected and the amount of data collected per well. Consequently, if changes are made to the 
Plate Setup such that the duration of a plateau becomes insufficient to allow the specified data 
collection settings, a dialog box similar to the one shown below will appear upon exiting the 
Plate Setup screen. The plateau duration will automatically be increased to the minimum required 
time. 
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Using Import Thermal Profile Setup 

The Import function of Thermal Profile Setup allows you to recall the thermal profile from an 
existing experiment when setting up a new experiment.  

To use an existing thermal profile for the new experiment, click the Import button on the 
command panel. The Import Thermal Profile Setup From dialog box will appear. 

This dialog box lists Mx3000P experiments stored in the Mx3000P data storage folder. Select the 
experiment that includes the desired thermal profile setup information, and then click the Open 
button. 

 

If the experiment you selected is not compatible with the experiment being set up, a warning box 
will appear. If this warning appears, click the OK button and select another experiment of the 
same type as the one being set up. 
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Using a Default Thermal Profile Setup 

In addition to the pre-configured default thermal profiles supplied by the Mx3000P software (as 
part of the Original Settings), user-defined default thermal profiles may be created and retrieved 
for setting up new experiments.  

Using a user-defined default thermal profile for Thermal Profile Setup requires creating a default 
set containing the desired thermal profile. Once the appropriate default set is created, select this 
default set as the active default set in the Choose set menu of the Preferences dialog box and then 
click OK. The thermal profile stored in the active default set will automatically be applied to the 
open experiment and to all new experiments, until the active default set is changed again. 
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The thermal profile in an existing default set may also be applied to the thermal profile setup in 
an open experiment by using the Defaults menu on the Thermal Profile Setup screen. To retrieve 
the thermal profile from the active defaults set, click Defaults to expand the menu, and then 
select Get.  

See Preferences-Defaults for more information about creating and using default sets to 
streamline experimental setup and analysis. 
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How to Run a Real-Time Experiment 
Preparing for the Run 
Either open an existing experiment or set up a new experiment. Complete both Plate Setup and 
Thermal Profile Setup steps. In preparation for running the experiment, verify that the lamp is 
ready. Place the samples in the instrument and close the instrument door. The indicators at the 
bottom of the screen should appear as shown below. 

 

The warm up time for the lamp is 20 minutes. Stratagene recommends that no data be taken 
during this period. If a run is started before the warm-up time is complete, a dialog box appears 
displaying the remaining warm-up time. Click Run After Warm-Up to automatically start the run 
at the end of the warm-up period. Click Run Now to proceed with the experiment before the lamp 
is warmed-up (not recommended).  

 

Starting the Run 
Initiate the run from the Thermal Profile Setup screen by clicking the Start Run button.  

 

The Run Status dialog box will appear. If you want to Turn the lamp off at end of run select the 
checkbox at the bottom of the dialog box. Click Start to begin the run.  

 

Note that a run can only be started once for any given experiment to ensure that data are not 
mistakenly overwritten. 
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Monitoring the Run 
Run Status Dialog Box 
The Run Status dialog box is displayed throughout the run, reporting the Time remaining in the 
run, the Temperature (estimated current temperature of the sample reactions within the tubes) 
and the current cycling status of the run (the Segment, Cycle, and Plateau in progress). The dialog 
box may be moved to a different position on the screen by dragging the box from the title bar. 

 

 If desired, additional cycles may be added to the currently-running segment of the thermal 
profile by clicking the Add Cycles button. The Add Cycles dialog box will appear. Use the spin 
controls to specify the number of cycles to be added to the currently-running segment and then 
click OK. 

 

Thermal Profile Status 
By default, the Thermal Profile Status screen is displayed during the run to provide a graphical 
representation of the progress of the thermal cycling. (The view may also be switched to Raw 
Data Plots during the run.) 
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Analyzing Data During the Run 
To analyze data during a run, click the Analysis tab. The following dialog box will appear.  

 

If you choose to open a standalone Mx3000P application, a second copy that does not have 
communications with the instrument, the data collected from the beginning of the run to that 
point will be available for analysis. Unless you abort the run, data collection will continue and 
the complete data set will be saved at the end of the experiment. 

Aborting the Run 

To stop a running experiment, click Abort in the Run Status dialog box. 

  

The Abort Running Experiment dialog box will appear. Click Yes to stop the experiment. To save 
the already-collected raw data from the run, select the Save collected data checkbox before 
clicking Yes. To allow the run to continue, click No. 

 

If the real-time experiment is aborted very early, then in some cases it may be possible to begin 
again, cycling the samples and generating useful data.  In many cases, however, the samples will 
no longer be useful for generating data. For example, if some rounds of amplification have 
already occurred when a run is aborted, it is not possible to generate legitimate standard curves 
or determine initial template quantities from the samples in a new run. 
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Viewing the Thermal Profile Status 

By default, the Thermal Profile Status screen is displayed during the run to provide a graphical 
representation of the progress of the thermal cycling. During the run, a yellow dot and green 
status line are displayed on the thermal profile image to indicate the current status of the run with 
respect to the profile. If, instead, you want to monitor product accumulation during the run, click 
the Raw Data Plots tab. Likewise, clicking the Thermal Profile Status tab returns the view to the 
Thermal Profile Status screen.  
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Viewing Raw Data Plots 

During the run, raw data plots can be viewed to give an immediate indication of product 
accumulation. To view the full-screen raw data amplification plots while the thermal profile is 
running, click on the Raw Data Plots tab. (Raw data plots may also be viewed after the run by 
clicking the Run section button, and then clicking the Raw Data Plots tab.) The plots shown are 
raw fluorescence (R) on the Y-axis versus cycle number on the X-axis. For a more detailed view 
of the plot in an individual well, double-click on the well to open the well's expanded 
amplification plot.  
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Display Options for Raw Data Plots 
Selecting the Ramp or Plateau to Display 

After the run, it is possible to view raw data amplification plots for each ramp and plateau for 
which data was collected. Select the ramp or plateau of interest from the list under Select 

ramp/plateau. A magnifying glass indicates that the ramp or plateau has had data collected; a 
gray dash  indicates that the ramp or plateau was not selected for collection, so there is no data 
to display. 

 

Displaying or Hiding Dyes 

The dyes in use on the plate may be displayed or hidden by using the Dyes shown selection bar at 
the lower left-hand corner of the screen. When the button is depressed (like FAM in the picture 
below), the dye's well assignments are displayed, but when the button is released (like ROX in the 
picture below), the dye's well assignments are hidden from display. Note that using this feature 
does not affect data collection. 

 

Displaying or Hiding Well Type Assignments 

The well types that are displayed on the plate are controlled by using the buttons in the Well 
Types Shown selection bar. Any of the well type buttons may be depressed in order to display the 
information for wells of the indicated type or may released to hide the information. For example, 
if you want to view only the Unknown wells on the plate, depress the Unknown button and 
release all other well type buttons (such as the NTC button in the example below). Note that 
using this feature does not affect data collection. 
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Setting the Range of the Y-axis 

The minimum and maximum Y-axis values for the plots can be set using the Y-axis display range 
slider controls on the command panel. By adjusting the Y-axis range, the scale can be expanded 
or contracted  to show better differentiation between curves. The minimum value is 0 and the 
maximum value is 65535. 

The X-axis value is fixed to include the number of cycles that are being collected. 

 

 

Viewing Expanded Amplification Plots (Real-Time 
Experiments) 

When viewing Raw Data Plots for a real-time experiment, an individual well's plot can be 
expanded for a clearer picture of product accumulation in that well. To expand a well's plot, 
double-click on the well. The plot will appear as shown: 

 

Display Options for Expanded Amplification Plots  

Multiple wells can be shown (up to a maximum of 9 wells) by selecting a group of wells and 
then clicking on the Show Plots button on the command panel.  
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When Consolidate Plots is selected, the selected plots appear together in a single window. 

 

When Consolidate Plots is cleared, the selected plots appear in individual windows, in a tiled 
format by default. To change the arrangement of plots to a cascade format, select Cascade Plots 
from the Window menu. 

A plot can be resized by dragging any side or corner with the cursor.  

A plot can be moved by pressing and holding the left mouse button down in the title bar of the 
plot box and dragging the plot to a different location.  

Using the panel of colored buttons below the plot, an individual dye can be shown in the plot (by 
depressing the corresponding color button) or hidden (by releasing the corresponding color 
button).  

The Y-axis range displayed for the expanded plots can be adjusted using the Y-axis display range 
slider controls on the command panel.  The minimum value is 0 and the maximum value is 
65535. 

To hide a single displayed plot, click the plot's Close button . To hide all plots, click Hide Plots 
on the command panel. Clicking Clear Selection will clear (deselect) any highlighted wells. 
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How to Run a Plate-Read Experiment 
Preparing for the Run 

Either open an existing experiment or set up a new experiment. Complete the Plate Setup. In 
preparation for running the experiment, verify that the lamp is ready. Place the samples in the 
instrument and close the instrument door. The indicators at the bottom of the screen should 
appear as shown below. 

 

The warm up time for the lamp is 20 minutes. Stratagene recommends that no data be taken 
during this period. If a run is started before the warm-up time is complete, a dialog box appears 
displaying the remaining warm-up time. Click Run After Warm-Up to automatically start the run 
at the end of the warm-up period. Click Run Now to proceed with the experiment before the lamp 
is warmed-up (not recommended).  

 

Starting the Run 

Starting a plate-read run requires the following steps, each of which are detailed below: 

1. Set the Read Properties (temperature and number of reads) 

2. Start the run using the Start Run button on the Plate Setup screen 

3. Initiate data collection and specify whether the run is a Pre-read or Post-Read in the Run 
Status dialog box 

Step 1: Specify the read properties by clicking the Set Read Properties button on the Plate Setup 
screen. The Set Read Properties dialog box opens, allowing you to set the temperature and 
number of readings to be taken.  
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Step 2: Click the Start Run button at the bottom of the Plate Setup screen. The Run Status dialog 
box opens when the Start Run button is clicked, allowing you to initiate the plate read run.  

 

Step 3: Click either the Pre-Read or the Post-Read button in the Run Status dialog box to initiate 
data collection by the instrument. 

A plate read run can be completed as either a one-time read or a pre- and post-read sequence.  
One-time Plate Read Experiments 
One-time plate readings may be initiated by clicking either the Pre-Read or the Post-Read button 
in the Run Status dialog box. Note that once the run is complete, fluorescence data type 
selections on Results screens are affected by the choice made in the Run Status dialog box. If the 
run was initiated using the Pre-Read button, select fluorescence data types of Rpre or Rn,pre on 
Results screens. If the run was initiated using the Post-Read button, select fluorescence data types 
of Rpost or Rn,post on Results screens. 
Pre-Read and Post-Read Sequence Experiments 
To run a pre-read/post-read sequence, start the pre-read segment by clicking the Pre-Read button. 
When the read is complete, exit and save the experiment. To run the post-read segment for the 
same samples after cycling, open the saved experiment (containing the pre-read data), click Start 
Run from the Plate Setup screen, and then click the Post-Read button in the Run Status dialog box.  

Monitoring the Run 

The Run Status dialog box is displayed throughout the run, reporting the Time remaining in the 
run and the Temperature (estimated current temperature of the sample reactions within the 
tubes). 

 

During the run, the Raw Data Plots screen is also displayed, showing readings for each well while 
data collection occurs.  
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Aborting the Run 

To stop a running experiment, click Abort Pre-Read or Abort Post-Read in the Run Status dialog 
box.  

The Abort Running Experiment dialog box will appear. Click Yes to stop the experiment. To save 
the already-collected raw data from the run, place a check mark in the box next to Save collected 
data before clicking Yes. To allow the run to continue, click No. 

 

Note that, for plate read experiments, if a run is aborted the read can generally be taken again. 

Setting the Read Properties for a Plate-Read Experiment 

To access the Set Read Properties dialog box, click the Set Read Properties button on the 
command panel of the plate-read experiment Plate Setup screen.  

 

Set the temperature (25–99°C) at which the samples should be held during the run by using the 
Read temperature spin controls. Set the number of times for the plate to be read by using the 
Number of reads spin controls. If the run includes multiple reads, you can specify whether the 
data should be reported as the average, the minimum value, the maximum value, or the endpoint 
of the read series by clicking the Advanced Algorithm Settings button on the Analysis 
Selection/Setup screen. 
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Viewing Raw Data Plots for Plate-Read Experiments 

During the run, the Raw Data Plots are displayed to give immediate indication of fluorescence 
readings for the samples. (Raw data plots may also be viewed after the run by clicking the Run 
section button, which opens to the Raw Data Plots screen.) The plots shown are bar graphs of raw 
fluorescence (R) on the Y-axis versus pre-read and/or post-read data collection points on the X-
axis. For a more detailed view of the plot in an individual well, double-click on the well to open 
an expanded plot for that well.  

 

Display Options for Raw Data Plots 

Displaying or Hiding Dyes 

The dyes in use on the plate may be displayed or hidden by using the Dyes shown selection bar at 
the lower left-hand corner of the screen. When the button is depressed (like FAM in the picture 
below), the dye's well assignments are displayed, but when the button is released (like ROX in the 
picture below), the dye's well assignments are hidden from display. Note that using this feature 
does not affect data collection. 

 

Mx3000P™ Real-Time PCR System 122 



How-To (Detailed Protocols) 

Displaying or Hiding Well Type Assignments 

The well types that are displayed on the plate are controlled by using the buttons in the Well 
Types Shown selection bar. Any of the well type buttons may be depressed in order to display the 
information for wells of the indicated type or may released to hide the information. For example, 
if you want to view only the Unknown wells on the plate, depress the Unknown button and 
release all other well type buttons (such as the NTC button in the example below). Note that 
using this feature does not affect data collection. 

 
Setting the Range of the Y-axis 

The minimum and maximum Y-axis values for the plots can be set using the Y-axis display range 
slider controls on the command panel. By adjusting the Y-axis range, the scale can be expanded 
or contracted to a scale more appropriate to the sample/dye of interest. The minimum value is 0 
and the maximum value is 65535. 

 

Viewing Expanded Raw Data Plots for Plate-Read 
Experiments 

When viewing Raw Data Plots for a plate read experiment, an individual well's plot can be 
expanded for a clearer picture of fluorescence readings in that well. To expand a well's plot, 
double-click on the well. The plot will appear as shown: 
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Display Options for Expanded Plots 

Multiple wells can be shown (up to a maximum of 9 wells) by selecting a group of wells and 
then clicking on the Show Plots button on the command panel.  

 

When Consolidate Plots is selected, the selected plots appear together in a single window. 

 

When Consolidate Plots is cleared, the selected plots appear in individual windows, in a tiled 
format by default. To change the arrangement of plots to a cascade format, select Cascade Plots 
from the Window menu. 

A plot can be resized by dragging any side or corner with the cursor.  

A plot can be moved by pressing and holding the left mouse button down in the title bar of the 
plot box and dragging the plot to a different location.  

Using the panel of colored buttons below the plot, an individual dye can be shown in the plot (by 
depressing the corresponding color button) or hidden (by releasing the corresponding color 
button).  

The Y-axis range displayed for the expanded plots can be adjusted using the Y-axis display range 
slider controls on the command panel.  The minimum value is 0 and the maximum value is 
65535. 

To hide a single displayed plot, click the plot's Close button  . To hide all plots, click Hide 
Plots on the command panel. Clicking Clear Selection will clear (deselect) any highlighted wells. 

Mx3000P™ Real-Time PCR System 124 



How-To (Detailed Protocols) 

How to Analyze the Data 

Analyzing the Data 

To begin data analysis for an open experiment, click the Analysis tab or select Analysis from the 
Section menu.  

The Analysis section includes the Analysis Selection/Setup screen, and a series of different Results 
screens that are appropriate to the type of experiment.  

For general information on how to use the Analysis section of the Mx3000P software, see the 
following topics: 

Analysis Selection and Setup 

Treatment of Replicates 

Positive and Negative Calling 

Graphs and Graph Properties 

Adjusting the Threshold Fluorescence Manually 

More detailed information about the specialized aspects of Analysis for each of the experiment 
types is available in the experiment-specific sections: 

Quantitative PCR 

Comparative Quantitation 

SYBR Green  

Allele Discrimination/SNP's Real-Time 

Molecular Beacon Melting Curve 

Quantitative Plate Read 

Plate Read/Allele Discrimination  
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Analysis Selection/Setup 

The first step in data analysis is to use the Analysis Selection/Setup screen to make selections and 
provide settings that will be used for data analysis. These include: 

• Selecting the wells for which collected data should be analyzed 

• Choosing the ramp or plateau for which the collected data will be analyzed 

• Specifying the settings that determine how data are analyzed 

 Note that if you wish to use the default analysis settings, you need only select the wells to 
analyze, choose the data collection ramp or plateau, and click on the Results tab. The specific 
default settings that are in place when the Analysis Selection/Setup screen is opened are 
determined by the contents of the active default set. 

Selecting the Wells to Analyze 

Note Only those dyes and wells selected in the Analysis Selection/Setup screen are used by the 
analysis algorithms. 

To select an individual well, single click in that well.  

An entire row or column of wells can be selected by clicking on the corresponding row header 
(A–H) or column header (1–12). All the wells in the plate can be selected by clicking on the All 
button in the upper left-hand corner of the plate. 

To select a range of adjacent wells, click and hold the left mouse button down and drag the 
cursor across the wells to be selected. A visible marking rectangle will appear. When all of the 
required wells are included in the rectangle, release the left mouse button and the range of wells 
will be selected. 

To select a group of non-contiguous wells, hold down the Control key and click on each of  the 
wells. 

To deselect a well, hold down the Control key and click on the well to be deselected. To deselect 
a selected row or column, click on that row or column's header. To rapidly deselect all wells, 
click the All button twice. This will select and then deselect all wells. 
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Choosing the Data Collection Ramp or Plateau 

Data may be viewed for any ramp or plateau that data was collected on. On the command panel, 
the Select data collection ramp/plateau box shows a summary of the thermal profile, with the 

data collection points indicated with the collection marker icon. (A gray dash  indicates that 
the ramp or plateau was not selected for collection, so there is no data to display.) To choose a 
ramp or plateau for data analysis select it in the Select data collection ramp/plateau box.  

 

For SYBR Green and Comparative Quantitation data analysis, it is necessary to select data 
collection points to be used in two parts of the profile: one data set for the Dissociation curve (set 
by clicking the Dissociation button) and another data set for the rest of the data analysis options 
(set by clicking the Amplification button). 

 

Excluding Individual Dyes from Analysis (Optional) 

Exclude Dyes allows you to exclude individual dyes in specific wells from analysis.  

 

Clicking the Exclude Dyes button will change the display of the wells to include independent 
buttons for each dye in each well, as shown below.  

 

A dye button which is depressed (with colored lettering) signifies that data collected for that dye 
in that well will be used in analysis algorithms. A raised button (with grayed lettering) signifies 
that the well/dye data will not be included in the analysis. When the Exclude Dyes view is first 
accessed in an experiment, all buttons are depressed. To exclude a specific dye in a specific well 
from analysis, release the corresponding dye button in the appropriate well.  

When all dye exclusions have been specified, click the Exclude Dyes button again to return to the 
normal Analysis Selection/Setup view. 
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Specifying Data Analysis Settings  

Replicates 

Wells identified as replicates in Plate Setup may be treated either individually or collectively 
during Analysis. Selecting Treat Individually under Replicates will cause the software to analyze 
each well independently and display or report results for each well separately. Selecting Treat 
Collectively will cause the software to average the data from all wells that make up a replicate set 
and to report a single result for the replicate set, effectively treating the measurements as if they 
came from the same well. See Treatment of Replicates in the How-To (Detailed Protocols) 
section for more details on how this selection affects the reporting of results. 

 

Algorithm Enhancements 

The Algorithm enhancements settings are used to specify whether or not the listed algorithm 
enhancements should be applied in the current round of analysis.  Algorithm enhancements are 
not used in plate read or molecular beacon melting curve experiments.  
Amplification-Based Threshold 

 

The Amplification-based threshold enhancement automatically calculates the threshold 
fluorescence for each dye, based on the amplification properties of the reactions in the specific 
experiment. See Analysis Term Settings-Real Time-Threshold Fluorescence for more 
information. To use this enhancement, select the Amplification-based threshold check box in the 
Algorithm enhancements section. The settings that affect this calculation may be viewed or 
modified in the Analysis Term Settings-Threshold Fluorescence dialog box.  
Baseline-based threshold fluorescence is used for analysis when the Amplification-based 
threshold check box is cleared. This threshold calculation algorithm uses user-defined settings to 
determine the threshold fluorescence based on the background fluorescence in the experiment. 
The settings that affect this calculation may be viewed or modified in the Analysis Term Settings-
Threshold Fluorescence dialog box.  

The threshold fluorescence value may also be manually set or adjusted. 
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Adaptive Baseline 

 

The Adaptive baseline enhancement automatically calculates the best baseline for each plot 
individually, thereby providing the most accurate Ct. Adaptive baseline is activated by checking 
the Adaptive baseline check box in the Algorithm enhancements section.  
When uniform range baseline calculations are used for analysis (by clearing the Adaptive 
baseline check box), the range of cycles delimited for background correction is, by default, 
identical for all amplification plots. The starting and ending cycles for calculating the baseline 
function are specified in the Active Settings section of the Analysis Term Settings-Baseline 
Correction dialog box.  

After using either baseline correction algorithm, the start and end cycle values can be adjusted 
manually for one or more amplification plots by using the Resulting Cycle Range section of the 
Analysis Term Settings-Baseline Correction dialog box. 
Moving Average 

 
Moving average applies curve-smoothing to help reduce Ct variation by decreasing the effect of 
signal noise. When this enhancement is selected, the fluorescence value for each data point in the 
amplification curve represents the average of the values for a specified range of cycles (original 
software settings=3 cycles) surrounding a given point.  
To perform data analysis employing a moving average calculation, select the Moving average 
check box. The number of points averaged during Moving average curve-smoothing can be 
modified in the Analysis Term Settings-Moving Average dialog box. 

Applying a Moving average calculation reduces the resolution of the reported results. Using 
Moving average curve-smoothing also increases the Ct values for a given threshold fluorescence. 

Analysis Term Settings 

 

The Analysis Term Settings button opens the Analysis Term Settings dialog box, allowing 
adjustment of a variety of settings that influence the way data are analyzed. Most of the basic 
settings controlled by the Analysis Term Settings dialog box may be selected or deselected in the 
Replicates and Algorithm Enhancements sections of the Analysis Selection/Setup control panel. 
However, the Analysis Term Settings button provides convenient access to the dialog box in order 
to view or modify the parameters used in the calculations for a given setting selection.  
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Advanced Algorithm Settings 

 

The Adv. Algorithm Settings button opens a dialog box that displays the Read statistic radio 
button selection box. 

 

The Mx3000P instrument may be set up to take more than one fluorescence reading for each 
reported measurement at each cycle in a real-time experiment or at each plate read. The number 
of readings per collection point is specified during Thermal Profile Setup for real-time 
experiments and using the Set Read Properties dialog box for plate read experiments. The Read 
statistic setting allows specification of how the multiple data readings should be analyzed.  

Selecting Minimum will cause the software to use the lowest value collected for each well and 
dye combination in each cycle or each plate read. Selecting Average will cause the software to 
use the average (mean) of the values collected for each well and dye combination in each cycle 
or each plate read. Selecting Maximum will cause the software to use the highest value collected 
for each well and dye combination in each cycle or each plate read. Selecting Last endpoint will 
cause the software to use the last data point collected each well and dye combination in each 
cycle or each plate read. 

See Preferences-Defaults for information about the use of the Defaults menu and the application 
of defaults sets to the settings specified in this dialog box. 

Adding Analysis Comments 

The Analysis comments box allows you to enter comments to be saved with the experiment. 
When printing the Analysis Selection/Setup section, these comments will appear on the printout. 
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Treatment of Replicates 

Replicate wells can be identified by assigning the same replicate symbol to a group of wells 
during Plate Setup. Wells that are identified as replicates can then be treated collectively during 
Analysis. When Treat (replicates) collectively is selected in the Analysis Selection/Setup screen, 
fluorescence values for  all wells that are identified with the same replicate symbol are averaged, 
so that the results for all wells with the same replicate number will be identical. When Treat 
(replicates) individually is selected, fluorescence values for all wells are analyzed and reported 
independently, regardless of any replicate set assignments that had been made in Plate Setup.  

 

Collective Treatment of Replicates in Real-Time Experiments 

When  the Treat Collectively option is selected in real-time experiments, fluorescence data from 
all wells with the same replicate number is averaged cycle-by-cycle. Hence, a single 
amplification plot or dissociation curve is produced for each replicate set. In addition, a single Ct 
value (and any other value derived from the fluorescence data) is reported for the replicate set on 
all of the analysis screens. These values are calculated from the averaged amplification plot. 

Collective Treatment of Replicates in Plate Read Experiments 

When  the Treat Collectively option is selected in plate read experiments, the fluorescence data 
reading from all wells with the same replicate number is averaged for each dye. Hence, all 
members of the set will have the same value (the average value of all set members) reported on 
the Plate Sample Values screen and will have a single value reported in a Text Report.  

On the Final Call Results screen, the averaged value for each Unknown replicate set is compared 
to the averaged value for the Control replicate set. If the average for an unknown set is 
statistically higher (based on p-values) than the average of the control wells, all members of the 
replicate set are called '+'. The user-specified confidence level in the Analysis Term Settings 
dialog box determines how high the p-value must be to yield a "+" final call. 
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Positive and Negative Calling 

Real-Time Experiments 

In real-time experiments, calling in Final Call Results is based on Ct values that are derived from 
either baseline-corrected raw fluorescence or baseline-corrected, normalized raw fluorescence. If 
the derived Ct is less than the last cycle for which data was collected, a positive call is returned. 
If the Ct is greater than or equal to the last cycle for which data was collected, a negative call is 
returned. A plus sign (+) signifies that product accumulation was detected, while a minus sign  
(–) signifies a failure to detect product accumulation. 

Plate Read Experiments 

In plate read experiments, calling in Final Call Results is based on comparing the experimentally 
determined p-value (probability value) for each dye in each well to the user-defined Confidence 
level for calls. The Confidence level for calls stipulates the minimum p-value required (the 
minimum confidence that amplification did occur in the well) for a positive call to be issued.  

 The p-value of a dye in a well is the probability that the amount of sample in that well differs 
from the amount of sample in the controls. For example, a p-value for an Unknown well of 99% 
means that 1% of the time, a measurement of a sample identical to the control wells will produce 
a value at least as great as the actual measurement collected for the Unknown well. In other 
words, the chance of a false positive is 1%. Thus, assuming that the only cause of false positives 
is measurement error, the confidence that amplification did occur is 99%.  

Presuming the user-defined Confidence level for calls setting is 99%, a positive call (+) for an 
Unknown well means that at most 1% of the time a measurement of sample identical to the 
control wells will produce a value as great as the actual measurement collected for the Unknown 
well.  

Conversely, a negative call (–) in an Unknown well  (with a Confidence level for calls setting of 
99%) means the chance that measurement of a sample identical to the control wells would 
produce a value at least as great as the actual measurement in the Unknown well is greater than 
1%. Hence, there is less than 99% confidence that amplification occurred, assuming no other 
sources of experimental error.  

Set the confidence level for making final calls in the Analysis Term Settings-Plate Read dialog 
box. 

The Text Report screen for plate-read experiments reports the p-value for each dye in each well, 
which is the probability that the actual measurement of the dye in the well differs from the 
measurements of the dye in the control wells. Other Results screens report only the Final Call  
(+ or –). 

Note  In order for the Mx3000P software to calculate p-values for positive or negative calling 
in Unknown wells, the plate read experiment must include at least three NTC or dye-
specific negative control wells for each dye. 
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Graphs and Graph Properties 

The Graph Properties dialog box allows you to customize several of the features of graphs 
displayed on Results screens. To access this dialog box, double-click anywhere in the graph. 

 

Graph Title 

The Graph Title box shows the title displayed above the graph on the Results screen. To change 
the title displayed, type the desired title text in the box. 

X-Axis and Y-Axis Controls 

The X-Axis and Y-Axis sections of the dialog box allow you to customize the X- (horizontal) and 
Y- (vertical) axes of the graph. By default, the limits of both axes are determined automatically. 
To change the limits, clear the Use Automatic Limits check box, and then enter the desired Min 
and Max values for the axis. The Orientation and Scale of either axis may also be changed by 
using the radio buttons provided. 

Background Color 

To modify the background color for the graph, click Edit in the Bkgd color box. For Help with 
selecting or defining colors, see Preferences-Color in the Options Menu section. 
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Style 

The Style radio buttons are available only from the Relative Quantity Chart screen of 
Comparative Quantitation experiments. When available, you can select a display graphic of 
either a Bar chart or a line Plot using the corresponding radio buttons. 

Plot Markers 

To view curves as solid lines without plot markers, select the Hide radio button under Plot 
markers. To restore the markers, select the Show radio button. 

Legend 

To show the legend for the graph, select the On radio button under Legend. Select the desired 
position of the legend, relative to the graph, by using the radio buttons under Legend Position. (If 
the legend is Off, Legend Position choices will not be available.)  

To hide the legend for the graph, select the Off radio button under Legend. This setting allows a 
full-sized display of the graph. 

In the image below, the legend is turned On and positioned at Right. For information on changing 
the properties of elements listed in the legend, see Legend Properties, below. 
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Legend Properties 

To modify the appearance of the elements listed in the graph legend, open the Legend Properties 
dialog box by double-clicking on an entry in the legend.  

 
 
To change the basis used for assigning plot colors, use the Plot colors based on radio buttons. For 
example, if you want to distinguish between plots for different well types by color, select the 
Well type radio button. This will cause the curves for all wells with the same well type to be 
shown in the same color. In addition, making this selection will cause the Well type for each plot 
to be listed first in the identifying text in the legend.    
To change the text used to identify the plot, enter the desired text in the Legend text box. 
To change the curve color, click Edit Curve Color. The Color dialog box opens to allow 
specification of a new color.  
To change the plot markers for the curve, select the desired marker shape under Point style. 
To reset all curves to their original colors after color editing, select Reset all manual colors and 
then click OK. 
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Adjusting the Threshold Fluorescence Manually 

The threshold fluorescence level, used to derive Ct values, is automatically determined by the 
Mx3000P software using one of several algorithms based on selections made during Analysis 
Selection/Setup. 

The Mx3000P software also allows you to manually select a threshold fluorescence value during 
Analysis. On an Amplification Plot screen, the Threshold Fluorescence value for each dye is listed 
on the command panel and is marked on the graph by a horizontal line. (Note that if a dye is 
hidden using the Dyes shown controls or if the check box next to the dye is cleared, the line 
corresponding to threshold fluorescence for that dye will not be shown on the graph.) 

Either of the procedures listed below may be used to manually change the threshold fluorescence 
value used for Ct calculation: 

• Position the mouse over the appropriate threshold fluorescence indicator line on the 
graph. The cursor becomes a vertical arrow. Click on the line, and holding down the left 
mouse button, drag the line to the desired position. The corresponding numerical value on 
the command panel will also change. 

• Enter a new threshold fluorescence value in the box adjacent to the dye of interest in the 
command panel by typing the desired value or by using the spin controls to make 
incremental changes. The position of the corresponding horizontal line will change on the 
graph. 

To reset the threshold fluorescence value for a dye to the value calculated automatically by the 
Mx3000P software, click the Reset button adjacent to the dye of interest. Threshold fluorescence 
for each dye is managed independently; to reset all dyes, click the Reset button for each dye.  
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Mx3000P System Experiments: 
Quantitative PCR 
The Quantitative PCR Experiment Type 
Note The Mx3000P software includes the experiment type Quantitative PCR, which refers to a 

specific assay type in which fluorogenic oligonucleotide probes are used to quantitate 
target levels by way of a standard curve. Other specific experiments which fall under the 
general usage of the term quantitative PCR, using different detection chemistries or 
analysis methods, are featured in other experiment types. 

The Quantitative PCR  experiment type uses a standard curve to accurately quantitate the amount 
of target present in Unknown samples using a fluorescence-labeled probe for detection. This 
method is sometimes referred to as absolute quantitation or as standard-curve quantitation in the 
literature.  

In Quantitative PCR experiments, the Mx3000P instrument detects the fluorescence of one or 
more  fluorophores during each cycle of the thermal cycling process and a Fluorescence value is 
reported for each fluorophore at each cycle. Fluorescence readings are generally acquired in the 
annealing stage of thermal cycling. Results are typically displayed in an Amplification plot, which 
reflects the change in fluorescence during cycling.  

The initial copy numbers of RNA or DNA targets can be quantified using real-time PCR analysis 
based on threshold cycle (Ct) determinations. The Ct is defined as the cycle at which a 
statistically-significant increase in fluorescence (above background signal contributed by the 
fluorescence-labeled oligonucleotides within the PCR reaction) is detected. The threshold cycle 
is inversely proportional to the log of the initial copy number. In other words, the more template 
that is present initially, the fewer the number of cycles required for the fluorescence signal to be 
detectable above background. The Mx3000P offers both automatic and manual methods for 
determination of the Threshold fluorescence level that is used to determine Ct values. 

Typical Quantitative PCR experiments use a Standard curve to quantitate the amount of target 
present in an Unknown sample. In this method, a series of Standards, containing a dilution series 
of a known amount of target, are amplified to generate a curve that relates the initial quantity of 
the specific target in the Standard sample to the Ct. The standard curve is then used to derive the 
Initial template quantity in Unknown wells based on their Ct values. 

It is also possible to perform some forms of relative quantitation using Quantitative PCR 
experiments. In one common form, a relative standard curve is generated using a dilution series 
of a reference sample without knowledge of the absolute amount of the specific target in the 
Standard wells. 
Multiplexing Quantitative PCR Experiments 

Fluorescence readings may be taken for each sample using up to four different detection paths 
that are assigned to detect four specific dyes (in the Optics Configuration dialog box of the 
Mx3000P software). In this way, samples may be multiplexed for quantitation of multiple targets 
in the same well, by using spectrally-distinct dyes to detect each target. Each well/dye 
combination is reported separately on amplification plots and other results displays. 
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Quantitative PCR Plate Setup 
In the Setup section of the software, open the Plate Setup tab. Shown below is a typical plate 
setup for Quantitative PCR.  

 

The Mx3000P software features several shortcuts to expedite plate setup including the ability to 
Import an existing setup, to use a Default setup, and to rapidly specify collection of data for all 
dyes in all wells by using Quick Setup.   

Plate Setup is accomplished using the selection boxes and commands on the command panel at 
the right of the screen. The command panel is designed to be followed in a top-to-bottom order, 
beginning with Well type assignment. All other selections are unavailable until after Well type 
has been assigned. 

Mx3000P™ Real-Time PCR System 138 



Mx3000P System Experiments 

Select the well(s) to be assigned using the mouse then assign the well(s) by using the Well type 
menu on the command panel. The well types available in a Quantitative PCR experiment are 
described in the table below. 
Well Type Description 
Unknown  Contains a complete reaction mixture including a test template that 

contains an  unknown amount of the specific target. 
Buffer Contains only buffer, used to monitor the background fluorescence 

attributable to the buffer. 
NAC No amplification control; contains all  reaction components except DNA 

polymerase. 
NPC No probe control; contains all reaction components except the 

fluorescence-labeled probe. 
NTC No template control; contains all reaction components except the template 

nucleic acid. 
Standard Contains a complete reaction mixture including a known concentration of 

target nucleic acid. Used to generate a standard curve, which is then used 
to relate the threshold cycle (Ct) to initial template quantity in Unknown 
wells. 

No RT No reverse transcriptase control; contains all QRT-PCR reaction 
components except reverse transcriptase. 

Not in Use Optional designation for wells that are not in use. It is not necessary to 
define any unused wells. This well type is equivalent to an unassigned 
well. 

Dye-specific 
Negative Control 

Contains all reaction components except the template or target sequence 
detected with the specified dye. Negative control well types available 
correspond to the dyes defined in Optics Configuration. This well type 
assignment is rarely used in Quantitative PCR experiments. (Most QPCR 
experiments will use the NTC well type assignment for reactions lacking 
template.) 

Dye-specific 
Positive Control 

Contains all reaction components including template known to be positive 
for the target sequence that is detected with the specified dye. Positive 
control well types available correspond to the dyes defined in Optics 
Configuration. This well type assignment, which qualitatively designates a 
positive signal for the target without specifying the absolute amount, is 
rarely used in QPCR experiments. (Most QPCR experiments will include 
Standard wells with known amounts of target.) 

After assigning the Well type to the selected well(s), select the dyes for which data should be 
collected in the wells using the Collect fluorescence data check boxes.  

If you are using a passive reference dye in the selected well(s) select the dye from the Reference 
dye menu. If all sample wells on the plate will contain the same passive reference dye, depress 
the All wells button. 
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If the selected well(s) is a Standard, for each dye for which standard curve data will be collected, 
enter the amount of template. To do this, first select the dye from the pulldown menu following 
Standard quantity. Next, enter the quantity of template added to the selected well(s) as a decimal 
number (for example, 400 or 1.234). Specify the units for the quantity in the Standard units 
menu. Instead of assigning quantities to wells on an individual basis, it is also possible to assign 
standard quantities to Standard wells sequentially using the Auto-Increment feature. 

Assign the replicate set number to the selected well(s) by using the Replicate symbol menu. 
Instead of assigning replicate numbers to wells on an individual basis, it is also possible to assign 
replicates sequentially using the Auto-Increment feature. 

Once plate setup is complete, click Next to proceed to the Thermal Profile Setup screen. 

Mx3000P™ Real-Time PCR System 140 



Mx3000P System Experiments 

Quantitative PCR Thermal Profile Setup 
When the Thermal Profile Setup tab is selected in a new Quantitative PCR experiment, a default 
thermal profile opens. The default thermal profile should be modified to the specific 
requirements of the new experiment, as discussed below. It is also possible to Import the thermal 
profile from an existing experiment into the new experiment. 

Shown in the figure below is the default thermal profile for a Quantitative PCR when using the 
software's Original Settings. (If you are using a user-defined default set, the default thermal 
profile stored in that default set will appear when the Thermal Profile Setup screen is opened. See 
Preferences-Defaults for more information about the use and management of Defaults.)     

In the profile below, segment 1 is an activation step of 95°C for 10 minutes that is compatible 
with most hot start reactions. Segment 2 consists of 40 cycles of amplification using a plateau of 
95°C/30 seconds for denaturation, followed by a plateau of 55°C/1 minute for annealing, and a 
plateau of 72°C/30 seconds for extension.  
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Some applications use a  two-step amplification protocol instead of the three-step protocol in the 
default thermal profile. A typical two-step amplification segment consists of 40 cycles of 
amplification using a plateau of 95°C/30 seconds for denaturation, followed by a plateau of 
60°C/1 minute for annealing and extension. 

Data are collected at the end of each annealing plateau in the default thermal profile. These 
collection settings are suitable for a typical Quantitative PCR experiment. See Data Collection 
for more information on data collection options. 

Modify the default thermal profile as necessary. At minimum, ensure that the temperature setting 
for the annealing plateau in Segment 2 is appropriate for the PCR primer pair used in the current 
experiment. The properties of all other plateaus, ramps, and segments may also be adjusted. See 
Thermal Profile Setup in the How-To (Detailed Protocols) section for more information about 
changing the default thermal profile. 
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Quantitative PCR Data Analysis 

Analysis Setup 
On the Analysis Selection/Setup screen: 

1. Select the wells to be included in the analysis. 

2. Select the data collection ramp/plateau from which data should be analyzed. 

3. Specify the desired analysis settings on the command panel.  

 
See Analysis Selection and Setup for more detailed instructions on using the features on this 
screen. 

When all selections and settings are made, click the Results tab. One of several available results 
screens will appear. Use the radio buttons under Area to analyze to navigate to different analysis 
screens. The following screens are available for Quantitative PCR analysis: 
Amplification Plots  
Plate Sample Values 
Standard Curve 
Initial Template Quantity 
Dual Color Scatter Plot 
Text Report 
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Quantitative PCR Amplification Plots 
The Amplification plots screen, accessed through the Results tab, shows a plot of cycles versus 
fluorescence for a ramp or plateau on which data are gathered. Select the ramp or plateau for 
which data should be analyzed using the Analysis Selection/Setup screen. 

 

Analysis Options 

Fluorescence Data Type Plotted 

Select the type of fluorescence data to be plotted from the Fluorescence menu on the command 
panel. Available fluorescence data types are: R (raw fluorescence), dR (baseline-corrected raw 
fluorescence), Rn (normalized fluorescence), and dRn (baseline-corrected normalized 
fluorescence).  

Threshold Fluorescence 

When basing plots on normalized fluorescence (dR or on dRn), the Threshold fluorescence value 
for each dye is listed on the command panel and is marked on the graph by a horizontal line. 
(Note that if a dye is hidden using the Dyes shown controls or if the check box next to the dye is 
cleared, the line corresponding to threshold fluorescence for that dye will not be shown on the 
graph.)  
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Threshold fluorescence is calculated by the Mx3000P software according to the settings provided 
in Analysis Term Settings. If desired, the threshold fluorescence may be adjusted manually. (To 
restore the software-calculated values, click Reset).  

Baseline correction is required to establish a threshold fluorescence. Thus selections related to 
threshold fluorescence are unavailable for R or Rn data plots. 

Last Cycle Setting 

The Last cycle setting specifies the cycle from which the final (last) fluorescence values will be 
reported in the Text Report and Plate Sample Values screens. The position of the last cycle is 
marked on the graph with a solid vertical line.  

This setting also affects the way Ct values are reported on other Results screens. While the Last 
cycle is not directly used to determine Ct, any wells with Ct values greater than the Last cycle 
value will be designated as No Ct in screens that display Ct. 

Excluding Well/Dye Data from Analysis 

To exclude the curve for one or more specific well/dye combinations from analysis, use either of 
the following two methods. (Disabling a particular well/dye combination requires a replicate 
treatment setting of Treat individually, specified on the Analysis Selection/Setup screen.) 

• From the list under Select amplification plots to display, select the curve(s) to be excluded 
and then click Disable Dyes.  

• Double-click on any data point on the plot to be excluded. This action will exclude the 
entire data set for the well/dye corresponding to the plot. 

To restore a plot that was disabled using either of these methods, go to the Analysis 
Selection/Setup screen, click on Exclude Dyes, and then press the button corresponding to the 
specific dye/well combination, restoring the button to a depressed state. 

Display Options 

To restrict the plots shown to a subset of the well/dye combinations, use the Select amplification 
plots to display list near the bottom of the command panel. You may display a single plot or any 
subset of plots by selecting the desired plots from the list. (While selecting plots with the mouse, 
use the Shift key to select a contiguous group or the Ctrl key to select a non-contiguous group.)  

To display information about a specific data point on the plots, place the cursor over the point of 
interest. (Note that Display tooltips must be selected on the Display tab of the Preferences dialog 
box in order for the well information to be displayed.) 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including whether the Legend and Plot Markers are displayed or hidden. See 
Graphs and Graph Properties for more information. 

Mx3000P™ Real-Time PCR System 145 



Mx3000P System Experiments 

Quantitative PCR Plate Sample Values 

The Plate Sample Values screen displays fluorescence values or Ct values for the sampled wells 
in a plate format. 

In each well with a well type assigned, the following information is shown:  
• Well type 
• Either the fluorescence or the Ct value for each dye for which data was collected 
• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 

underlined) 
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Analysis Options 

Display the Values for Fluorescence or Ct 

Under Display the values for, specify the form of the data to be displayed by selecting either the 
Fluorescence or the Ct using radio button. You will also need to specify the type of fluorescence 
data to be either displayed or used in calculations by selecting a data type from the menu below 
the selected radio button. Refer to the tables below for descriptions of the fluorescence data type 
abbreviations in the menus. 

When displaying Fluorescence values, the following fluorescence data types are available:  
Data Type How Calculated 

R Last final fluorescence 
dR Last final fluorescence minus the initial fluorescence 
Rn Last normalized final fluorescence 
dRn Last normalized final fluorescence minus the normalized initial fluorescence
R Last/R First final fluorescence divided by the initial fluorescence 
 

When displaying Ct values, Ct calculations may be based on the following fluorescence data 
types:  
Data Type How Calculated 

dR baseline-corrected fluorescence 
dRn baseline-corrected normalized fluorescence 

 

Last Cycle 

The Last cycle setting specifies the cycle from which the fluorescence values will be reported. By 
default, the cycle shown is the last cycle of the ramp or plateau being analyzed.  

The Last cycle setting also affects the reporting of Ct. Any wells having Ct values greater than the 
Last cycle value will be reported as No Ct. 
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Quantitative PCR Standard Curve 

The Standard Curve is a plot of the initial template quantity in the Standard wells (X-axis), 
versus the Ct (threshold cycle). A least mean squares curve fitting algorithm is used to generate 
the standard curves displayed. Curves are displayed for each dye for which data was collected in 
Standard wells. Unknown wells selected during Analysis Selection/Setup are also plotted on the 
standard curve (using a different data point marker) based on their measured Ct values. 

 

If less than two Standard wells were selected in Analysis Selection/Setup, no data will be plotted 
on this chart. 

Analysis Options 

Fluorescence Data Type for Ct Determinations 

Select the type of fluorescence data to be used for Ct determinations from the Ct based on menu 
on the command panel. Available fluorescence data types are: dR (baseline-corrected raw 
fluorescence), and dRn (baseline-corrected normalized fluorescence).  
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Confidence Interval 

The confidence interval for each standard curve may be displayed by selecting the Show 
confidence interval checkbox. The resulting graph shows the confidence limits as hashed lines. 
The lines show the range of Initial Quantity values at a particular Ct that cannot be statistically 
distinguished from the fit line with more certainty than the confidence level (Level %) selected. 
The width of the confidence interval is an indicator of the quality of the fit of the data to the 
standard curve.  Confidence interval calculations require a Replicates setting of Treat individually. 
Confidence level values may be exported to an Excel file, a text file or an XML file by using the 
Export Chart Data commands on the File menu.  

 

Threshold Fluorescence 

The Threshold fluorescence value for each dye, as calculated by the Mx3000P software 
according to the settings provided in Analysis Term Settings, is listed on the command panel. If 
desired, the threshold fluorescence for a given dye may be adjusted manually by entering a new 
value in the spin control box for the dye. (To restore the software-calculated values, click Reset).  

 

Excluding Well/Dye Data from Analysis 

To exclude a specific well/dye data point from analysis, double click on the data point on the 
chart. Disabling a particular well/dye combination requires a replicate treatment setting of Treat 
individually, specified on the Analysis Selection/Setup screen. To restore an excluded data point, 
go to the Analysis Selection/Setup screen, click on Exclude Dyes, and then press the button 
corresponding to the specific dye/well combination, restoring the button to a depressed state. 
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Display Options 

To display information about a specific data point on the plots, place the cursor over the point of 
interest to display the following information: well location or replicate number, dye name, well 
type, the initial template quantity and the Ct. 

 

If the well is a Standard, the initial template quantity is the amount assigned to the well during 
plate setup. If the well is an Unknown, the initial template quantity is the interpolated amount 
based on the standard curve.   

Note If Display tooltips is cleared (deselected) on the Display tab of the Preferences dialog box, 
this well information will not be displayed. 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including whether the Legend is displayed or hidden. See Graphs and Graph 
Properties for more information. 

Interpretation and Use of Curve Attributes 

RSq Value, Slope, and Amplification Efficiency 

The graph legend displays information about each curve plotted. (If no legend is displayed on the 
screen, open the Graph Properties dialog box by double-clicking on the graph, and then select the 
On radio button under Legend.) Besides correlating plot markers with dyes and well types, the 
legend displays the R Squared (RSq) value and the equation for the line [y = m*log(x) + b, where 
m is the slope of the line]. The amplification efficiency (Eff.), calculated from the slope, is also 
displayed. 

 

The RSq value is an indicator of the quality of the fit of the standard curve to the Standard data 
points plotted. The value will always be between 0 and 1. The closer the value is to 1, the better 
the fit of the line.  
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The slope of the curve is directly related to the average amplification efficiency throughout the 
cycling reaction. The equation that relates the slope to amplification efficiency is: 

PCR Efficiency = 10(-1/slope) – 1 

where PCR Efficiency corresponds to the proportion of template molecules that are doubled 
every cycle. From this equation it follows that a reaction with 100% efficiency will result in a 
slope of –3.322. 

Initial Template Quantity Calculator 

To use the displayed standard curve to calculate an interpolated quantity of template in another 
sample from the run based on the Ct determined for the sample, choose the dye from the Select 
dye menu, then enter a Ct value. The software will calculate and display the interpolated initial 
template quantity (Interpolated qty). Note that initial template quantities are automatically 
determined, based on the standard curves, for all Unknowns in the same experiment, and these 
results may be viewed on the Initial Template Quantity screen. 

 

Amplification Efficiency Calculator 

Enter either a Slope value or an amplification Efficiency value into the Amplification efficiency 
calculator to convert between values, based on the following equation: 

PCR Efficiency = 10(-1/slope) – 1 
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Quantitative PCR Initial Template Quantity 

The Initial Template Quantity screen displays interpolated quantities of template added to 
Unknown wells before thermal cycling in a plate format. 

In each well with a well type assigned, the following information is shown:  
• Well type 
• Initial template quantity (for Unknowns, the value interpolated from the standard curve 

based on the Ct calculated for the Unknown; for Standards, the amounts entered during 
plate setup) 

• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 
underlined) 

If less than two Standard wells were selected in Analysis Selection/Setup, a standard curve cannot 
be plotted and an error message will appear in place of results in the Unknown wells. 

 

Analysis Options 

Fluorescence Data Type for Ct Determinations 

Select the type of fluorescence data to be used to calculate the Ct values to be used for 
interpolation from the Interpolated template quantity based on menu on the command panel. 
Available fluorescence data types are: dR (baseline-corrected raw fluorescence), and dRn 
(baseline-corrected normalized fluorescence).  
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Quantitative PCR Dual Color Scatter Plot 

The Dual Color Scatter Plot screen is useful to compare the amplification properties of two 
different targets (represented by two different dyes) in the same well. In Quantitative PCR 
experiments, this plot is typically used to assess the suitability of a specific control target by 
displaying any correlation between the amplification of a gene of interest and the amplification 
of the control target. 

Each plotted point represents the coordinates of either the fluorescence values or threshold cycle 
(Ct) values for  two dyes in a single well. For example, the X-axis may correspond to HEX Ct 
while the Y-axis corresponds to FAM Ct and the plotted point (x,y) corresponds to the 
coordinates describing the two Ct values determined for a given well. The positions of the 
plotted points provide a convenient indicator of whether the control target quantity is uniform or 
variable across samples. 

Analysis Options 

Dye Selection 

Specify the dye for which data should be plotted on each axis by selecting the dyes of interest 
from the X axis and Y axis menus on the command panel. Any two dyes assigned during Plate 
Setup may be specified.  
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A well will not be included in the scatter plot if the two dyes selected for the plot are not 
assigned to that well. An error message similar to the example shown below will appear if wells 
selected during Analysis Selection/Setup cannot be displayed. 

 

Plot the Values for Fluorescence or Ct 

Under Display the values for, specify the form of the data to be plotted by selecting either the 
Fluorescence or the Ct using radio button. For either of these options, you will need to specify the 
type of fluorescence data to be used in the analysis by selecting a data type from the menu below 
the selected radio button. Refer to the tables below for descriptions of the fluorescence data type 
abbreviations in the menus. 

When plotting Fluorescence values, the following fluorescence data types are available:  
Data Type How Calculated 

R Last final fluorescence 
dR Last final fluorescence minus the initial fluorescence 
Rn Last normalized final fluorescence 
dRn Last normalized final fluorescence minus the normalized initial 

fluorescence 
R Last/R First final fluorescence divided by the initial fluorescence 
 

When plotting Ct values, Ct calculations may be based on the following fluorescence data types:  
Data Type How Calculated 

dR baseline-corrected fluorescence 
dRn baseline-corrected normalized fluorescence 

Note that if no reference dye has been assigned to the wells and dRn, Rn Last or dRn Last is 
selected, a message like the following will appear below the graph: 
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Last Cycle Setting 

The Last cycle setting specifies the cycle from which the fluorescence values will be plotted if 
Fluorescence is selected under Display the values for. By default, the cycle shown is the last cycle 
of the ramp or plateau being analyzed.  

This setting also affects the way Ct values are reported on this and other Results screens. While 
the Last cycle is not directly used to determine Ct, any wells with Ct values greater than the Last 
cycle value will be plotted with a Ct value corresponding to the last cycle for which data was 
collected. The same wells will be designated as No Ct in screens that display Ct values. 

Display Options 

To display information about a specific data point on the scatter plot, place the cursor over the 
point of interest.  (Note that Display tooltips must be selected on the Display tab of the 
Preferences dialog box in order for the well information to be displayed.) 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including the attributes of the axes. See Graphs and Graph Properties for more 
information. 
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Quantitative PCR Text Report 

The Text Report screen shows the data from a run in text format.  

 

Analysis Options 

Last Cycle 

The Last cycle setting specifies the cycle from which the fluorescence values will be reported 
when fluorescence value columns (such as dRn Last) are selected for display. By default, the 
cycle shown is the last cycle of the ramp or plateau being analyzed.  

 

The Last cycle setting also affects the reporting of Ct and the Final Call. Any wells having  
Ct values greater than the Last cycle value will be reported as No Ct and will be called as negative 
(–). 
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Ct and Final Call Based On 

Select the type of fluorescence data that the reported Ct and Final Call should be based on from 
the Ct and final call based on menu on the command panel. Available fluorescence data types 
are: dR (baseline-corrected fluorescence) and dRn (baseline-corrected normalized fluorescence).  

 

Display Options 

Columns Included in the Report 

Select the Columns to be included in the text report by checking the boxes next to the column 
names. To exclude columns that are selected by default, click on the check box to deselect the 
column name. To select all columns for display, click Select All. The default settings for column 
selection can be restored by expanding the Defaults menu and then clicking Get. 

If the included columns will not fit in the screen, a horizontal scroll bar appears at the bottom of 
the window to allow horizontal scrolling. 

 
Column Width 

To facilitate viewing data, columns can be automatically sized. Clicking the Contents Only 
button will cause each column to be automatically resized to the width of the widest data cell in 
that column (some column headers may be only partially displayed using this setting). Clicking 
the Hdr & Contents button will cause each column to be resized to the widest cell in that column, 
including the header cell. 

Columns can also be resized manually by dragging the column dividers with the mouse.  
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Exporting Text Report Data 

Text report data can be exported from the application in text, Microsoft Excel spreadsheet or 
XML format for analysis. Text report exporting options are available from the File menu. See 
Exporting Data to Other Applications in the File Menu section for more information. 
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Mx3000P System Experiments: 
Comparative Quantitation 
The Comparative Quantitation Experiment Type 
The Comparative Quantitation experiment provides an efficient method for comparing levels of 
RNA or DNA across samples when information about the absolute amounts of target in any 
sample is not required. Most common is the comparison of amounts of mRNA in treated versus 
untreated, or normal versus diseased cells or tissues. 

For many gene expression studies it is not necessary to determine the absolute amount of a target 
in a particular sample; evidence of a relative increase or decrease in expression, compared to a 
sample of reference, is sufficient. The sample of reference is referred to as the Calibrator. For 
example, in a study in which a large number of compounds are screened for the ability to induce 
the expression of a certain set of genes in HeLa cells, the Calibrator might be a nucleic acid 
sample isolated from an untreated HeLa cell culture. In a study involving the expression of a 
cancer marker gene, the Calibrator might be a nucleic acid sample isolated from the normal, non-
diseased part of the organ, whereas the test samples (referred to in the Mx3000P software as 
Unknowns) are nucleic acids isolated from the diseased tissue of the same patient. The 
expression level of  the gene of interest (GOI) in the Calibrator is defined as 1× (or 1.0). 
Expression levels for the GOI in all Unknowns are reported relative to this Calibrator benchmark. 

The amount of the GOI present in any sample is subject to many variables such as sample-to-
sample differences in total amount of input nucleic acid and differences in the efficiency of 
 RNA extraction or reverse transcription. A Normalizer target is included in the assay to reduce 
the effect of these spurious variations. Any gene with little to no variance in expression due to 
the treatment can serve as a Normalizer. (Commonly-used examples include GAPDH, 
cyclophilin, GUS, TFIID, or 18S, or 28S ribosomal RNA.) The abundance of the Normalizer and 
the GOI should be similar.  

The Normalizer is necessary to correct for differences in total cDNA input between samples, 
whether the differences be due to efficiency of RNA purification, reverse transcription, or 
pipetting error. In order to use Normalizer levels to correct for spurious differences in GOI across 
samples, the relative amplification efficiencies of the Normalizer and the GOI must be taken into 
account. After either establishing that the Normalizer and GOI have equal amplification 
efficiencies or compensating for any differences in the amplification efficiencies, Normalizer 
target levels may be used to correct the relative quantities of the GOI target, allowing for a direct 
comparison of the GOI levels in Unknowns versus Calibrator wells. 

Another level of correction can be introduced by the use of a passive reference dye such as ROX. 
The Reference dye is not reactive during QPCR and therefore it can be used to normalize slight 
differences in the volume of the QPCR reaction, transparency of the plastic caps and other 
sources of well-to-well differences. Note that references to normalized fluorescence values 
(abbreviated as Rn or dRn in the analysis screens) are normalized using Reference dye 
fluorescence values, not using any measurements of the Normalizer target. 
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For Comparative Quantitation analysis, it is assumed that the amplification efficiency for a given 
target is uniform between Unknown and Calibrator samples. If the experimental treatment affects 
PCR efficiency, Comparative Quantitation is not a valid experiment type. In this situation, 
Quantitative PCR experiments that include relative standard curves for each sample in each 
experiment may be used to compare initial quantities in different samples. 

Comparative Quantitation Analysis using the Mx3000P Software 

In a typical validated Comparative Quantitation assay, a replicate set of Calibrator wells 
containing the reference sample are run alongside a variety of Unknown replicate sets to test the 
effect of some variable on the expression level of one or more genes. The Normalizer target may 
either be measured in the same well as the gene of interest (using multiplexing) or be measured 
in different wells by Identifying associations of wells with the same sample source during plate 
setup.  

During analysis, the Mx3000P software automatically adjusts the levels of the gene of interest in 
both Unknown and Calibrator wells to compensate for differences in the levels of the Normalizer. 
The normalized value for each Unknown sample is then compared to the normalized Calibrator 
value, and the Relative Quantity is reported for each Unknown. (The expression level of the gene 
of interest in the Calibrator is set to 1.0.) 

The validity of using a Normalizer target to compensate for spurious differences in amounts of 
the gene of interest across samples is dependent on first establishing the efficiency of 
amplification for the gene of interest and Normalizer by generating standard curves for both 
targets.  

Use of Standard Curves in Comparative Quantitation Experiments 

In developing a comparative quantitation assay, it is important to show that the 
amplification/detection efficiencies of the GOI and of the Normalizer are reproducible and, 
ideally, very similar. The Amplification efficiency for each target is usually measured by 
generating a standard curve. The Mx3000P software analyzes the standard curve data and 
calculates the Amplification efficiency from the standard curve Slope. 

In Comparative Quantitation, a Standard Curve is based on relative amounts of template, not on 
copy numbers or absolute amounts. The relative amounts are entered in the Mx3000P software 
using arbitrary units. A typical Standard Curve used for validation employs 2× dilutions of a 
reference sample. 

In general, for the Comparative Quantitation experiment type, standard curves for the GOI and 
the Normalizer are prepared only during the initial development and validation of the assay. 
Once the amplification/detection efficiencies of both targets are established, there is no need to 
generate standard curves in subsequent assays, unless assay components or conditions are 
changed.  
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Correcting for Differences in Amplification Efficiencies for the GOI 
and Normalizer  

In an idealized Comparative Quantitation experiment, the amplification efficiencies for the GOI 
and Normalizer targets must be identical in order to allow a direct correction of GOI levels 
across samples. The Mx3000P software allows you to compensate for differences in the 
amplification efficiencies for the GOI and Normalizer when reporting relative quantities by using 
the Analysis Term Settings - Efficiency Settings dialog box.  Entering either the standard curve 
Slopes or the Amplification efficiencies for both the GOI and the Normalizer in this dialog box 
causes the software to compensate for the difference in efficiencies when correcting for 
Normalizer levels. 

Using a Single Dye for Detection of Gene of Interest and Normalizer 

The following considerations and procedures facilitate Comparative Quantitation experiments 
using a single dye (e.g. SYBR Green I dye) to detect both gene of interest and Normalizer 
targets. 

Plate Setup 

When setting up a single-dye experiment, for each template, assign separate wells for detection 
of the gene of interest and the Normalizer. Indicate the association between the two wells 
containing the same template by assigning the same Association symbol to both wells. 
Associations between gene of interest and Normalizer targets in separate wells are designated 
during Plate Setup by using the Identify associations menu. 

Standard Curves 

It is possible to analyze standard curves for two targets, such as the gene of interest and 
Normalizer, using a single dye on a single plate. In this situation, it is beneficial to distinguish the 
two sets of Standard wells corresponding to the two targets during Plate Setup using particular 
replicate symbol assignments or plate configurations. During analysis, either perform separate 
rounds of analysis by selecting the wells corresponding to only one target for each round, or 
reassign the dye detecting the Normalizer target with a unique name, as illustrated in the example 
below. 

Efficiency Settings 

In order to use the Analysis Term Settings - Efficiency Settings dialog box to record amplification 
efficiencies for the two targets detected using the same dye, it is necessary to first reassign the 
wells detecting the Normalizer to a uniquely-named dye. For example, the steps outlined below 
may be used in an experiment using SYBR Green dye for detection of both targets. 
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Example: Distinguishing the Normalizer from the Gene of Interest when using SYBR 
Green Detection 

1. Complete Plate Setup with SYBR Green data collection in all sample wells.   

2. After running the experiment, on the Plate Setup screen, select the wells corresponding to 
the Normalizer. 

3. In the Optics Configuration - Dyes & Filters dialog box, define a mock custom dye with a 
descriptive name, such as NRML, and associate this dye with the FAM filter set. 

4. In the Optics Configuration - Dye Assignment dialog box, assign the NRML dye to the 
FAM filter set. 

5. On the Plate Setup screen, double click on the SYBR checkbox under Collect fluorescence 
data. This will change the dye assignment for the selected wells, detecting the 
Normalizer, to NRML. Unselected wells, detecting the gene of interest, will retain the 
SYBR assignment. 

6. With the wells corresponding to the Normalizer still selected, expand the Normalizing 
dye menu and then select NRML. 

7. If the experiment is being used to generate standard curves for both targets, navigate to 
the Analysis Setup/Selection screen and select the Standard wells for both targets. On the 
Standard Curve screen, separate curves for each target will be displayed with distinctive 
plot markers for SYBR and NRML data.  

8. If the experiment is being used to analyze relative quantities, open the Analysis Term 
Settings - Efficiency Settings dialog box and enter the Efficiency value  for the gene of 
interest in the SYBR field and for the Normalizer in the NRML field. 
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Comparative Quantitation Plate Setup 
In the Setup section of the software, open the Plate Setup tab. Shown below is a typical plate 
setup for Comparative Quantitation using a Normalizer  multiplexed with the gene of interest 
(both targets measured in the same wells). Click here to see a plate setup in which data are 
collected for the gene of interest and the Normalizer in separate wells.  

 

The Mx3000P software features several shortcuts to expedite plate setup including the ability to 
Import an existing setup, to use a Default setup, and to rapidly specify collection of data for all 
dyes in all wells by using Quick Setup. 

Plate Setup is accomplished using the selection boxes and commands on the command panel at 
the right of the screen. The command panel is designed to be followed in a top-to-bottom order, 
beginning with Well type assignment. All other selections are unavailable until after Well type 
has been assigned. 
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Select the well(s) to be assigned using the mouse then assign the well(s) using the Well type 
menu on the command panel. The well types available in a Comparative Quantitation experiment 
are described in the table below. 
Well Type Description 
Unknown  Contains a complete reaction mixture including a test template that contains 

an  unknown amount of the specific target. Quantities of a gene of interest in 
the Unknown wells  is reported relative to the quantity of the same gene in 
the Calibrator wells, after correction for the relative quantities of a 
Normalizer target in the Unknown and Calibrator wells. 

Buffer Contains only buffer, used to monitor the background fluorescence 
attributable to the buffer. 

NAC No amplification control; contains all reaction components except DNA 
polymerase. 

NPC No probe control; contains all reaction components except the fluorescence-
labeled probe. 

NTC No template control; contains all reaction components except the template 
nucleic acid. If  the gene of interest and the Normalizer are detected in 
separate wells, a NTC well is required for each primer/probe set.  

Standard Contains a complete reaction mixture including a known relative amount of 
target nucleic acid. Typically a series of serial dilutions of a reference 
template are included in Standards for the purpose of initial validation of a 
Comparative Quantitation assay. 

Calibrator Contains a complete reaction mixture including a characterized target. The 
level of a gene of interest in the Calibrator wells  is set to 1.0  for 
comparison to the relative quantities in  Unknown samples. 

No RT No reverse transcriptase control; contains all QRT-PCR reaction 
components except reverse transcriptase. 

Not in Use Optional designation for wells that are not in use. It is not necessary to 
define any unused wells. This well type is equivalent to an unassigned well. 

Dye-specific 
Negative Control 

Contains all reaction components except the template or target sequence 
detected with the specified dye. Negative control well types available 
correspond to the dyes defined in Optics Configuration. This well type 
assignment is rarely used in Comparative Quantitation experiments (most 
will use the NTC well type assignment for reactions lacking template). 

Dye-specific 
Positive Control 

Contains all reaction components including template known to be positive 
for the target sequence that is detected with the specified dye. Positive 
control well types available correspond to the dyes defined in Optics 
Configuration.  This well type assignment is rarely used in Comparative 
Quantitation experiments. 

After assigning the Well type to the selected well(s), select the dyes for which data should be 
collected in these wells using the Collect fluorescence data check boxes.  
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If you are using a passive reference dye in the selected well(s) select the dye from the Reference 
dye menu. If all sample wells on the plate will contain the same passive reference dye, depress 
the All wells button. 

If Normalizer data will be collected in the selected well, identify the dye corresponding to the 
Normalizer target from the Normalizing dye menu. 

If the selected well(s) is a Standard, for each dye for which standard curve data will be collected, 
enter the amount of template. To do this, first select the dye name from the pull-down menu 
following Standard quantity. Next, enter the relative amount of template added to the selected 
well(s) as a decimal number with arbitrary units. For example, the sample containing the lowest 
amount in the dilution series may be assigned a value of 1, with the quantity assigned to each 
increasingly-concentrated Standard well in the dilution series multiplied by the dilution factor of 
2. Instead of assigning quantities to wells on an individual basis, it is also possible to assign 
quantities to Standard wells sequentially using the Auto-Increment feature. 

More than one Standard Curve may be generated on a single plate using a single dye. See Using 
a Single Dye for Detection of Gene of Interest and Normalizer. 

Assign the replicate set number to the selected well(s) by using the Replicate symbol menu. 
Instead of assigning replicate numbers to wells on an individual basis, it is also possible to assign 
replicates sequentially using the Auto-Increment feature. 

If the levels of the gene of interest and the Normalizer present in a given sample are to be 
measured in two separate wells, it is necessary to Identify associations between wells containing 
the same template. Select the wells to be associated on the plate, then select the appropriate 
symbol from the Assoc. symbol menu. If the gene of interest and Normalizer are multiplexed in 
all wells, it is not necessary to make any selections in the Identify associations section. 

Once plate setup is complete, click Next to proceed to the Thermal Profile Setup screen. 
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Sample Plate Setup for a Non-multiplexed Comparative Quantitation 
Experiment 

Shown below is a typical plate setup for Comparative Quantitation in which data are collected 
for a Normalizer and a gene of interest in separate wells. In this example, the gene of interest and 
the Normalizer are detected using different dyes. A similar plate setup would be appropriate for 
experiments using a single dye for detection, with the single dye (only) marked for data 
collection.  

The association between wells set up to detect gene of interest or Normalizer levels from the 
same template are indicated by a capital letter Association symbol in the wells.  
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Comparative Quantitation Thermal Profile Setup 
When the Thermal Profile Setup tab is selected in a new Comparative Quantitation experiment, a 
default thermal profile opens. The default thermal profile should be modified to the specific 
requirements of the new experiment, as discussed below. It is also possible to Import the thermal 
profile from an existing experiment into the new experiment. 

Shown in the figure below is the default thermal profile for a Comparative Quantitation 
experiment when using the software's Original Settings. (If you are using a user-defined default 
set, the default thermal profile stored in that default set will appear when the Thermal Profile 
Setup screen is opened. See Preferences-Defaults for more information about the use and 
management of Defaults.) 

In the profile below, segment 1 is an activation step of 95°C for 10 minutes that is compatible 
with a hot start reaction. Segment 2 consists of 40 cycles of amplification using a plateau of 
95°C/30 seconds for denaturation, followed by a plateau of 55°C/1 minute for annealing, and a 
plateau of 72°C/30 seconds for extension.  
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Some applications use a  two-step amplification protocol instead of the three-step protocol in the 
default thermal profile. A typical two-step amplification segment consists of 40 cycles of 
amplification using a plateau of 95°C/30 seconds for denaturation, followed by a plateau of 
60°C/1 minute for annealing and extension. 

Data are collected at the end of each annealing plateau in the default thermal profile. These 
collection settings are suitable for a typical Comparative Quantitation experiment.  

Modify the default thermal profile as necessary. At minimum, ensure that the temperature setting 
for the annealing plateau in Segment 2 is appropriate for the PCR primer pair used in the current 
experiment. The properties of all other plateaus, ramps, and segments may also be adjusted. See 
Thermal Profile Setup in the How-To (Detailed Protocols) section for more information about 
changing the default thermal profile and data collection options. 
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Comparative Quantitation Data Analysis 

Analysis Setup 

On the Analysis Selection/Setup screen: 

1. Select the wells to be included in the analysis. 

2. Select the segment (Amplification or Dissociation), and then the position (either the ramp 
or the plateau) from which data should be analyzed. The Dissociation segment should be 
selected only for viewing the Dissociation Curve. All other Results screens require 
selection of a data set collected during Amplification. 

3. Specify the desired analysis settings on the command panel.  

 

See Analysis Selection and Setup for more detailed instructions on using the features on this 
screen. 
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When all selections and settings are made, click the Results tab. One of several available results 
screens will appear. Use the radio buttons under Area to analyze to navigate to different analysis 
screens. The following screens are available for Comparative Quantitation analysis: 

Amplification Plots 

Dissociation Curve 

Plate Sample Values 

Standard Curve (for validation) 

Relative Quantity Chart 

Relative Quantity Plate 

Text Report 
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Comparative Quantitation Amplification Plots 

The Amplification Plots screen, accessed through the Results tab, shows a plot of cycles versus 
fluorescence for a ramp or plateau on which data are gathered. Select the ramp or plateau for 
which data should be analyzed using the Analysis Selection/Setup screen. 

 

Analysis Options 

Fluorescence Data Type Plotted 

Select the type of fluorescence data to be plotted from the Fluorescence menu on the command 
panel. Available fluorescence data types are: R (raw fluorescence), dR (baseline-corrected raw 
fluorescence), Rn (normalized fluorescence), and dRn (baseline-corrected, normalized 
fluorescence).  

Note that the fluorescence data designated as Rn and dRn refers to data normalized according to 
the passive reference dye (if used). Measurements from the dye defined as the Normalizer do not 
enter into normalization at the level of fluorescence reporting. 

Threshold Fluorescence 

When basing plots on normalized fluorescence (dR or on dRn), the Threshold fluorescence value 
for each dye is listed on the command panel and is marked on the graph by a horizontal line. 
(Note that if a dye is hidden using the Dyes shown controls or if the check box next to the dye is 
cleared, the line corresponding to threshold fluorescence for that dye will not be shown on the 
graph.)  

Mx3000P™ Real-Time PCR System 171 



Mx3000P System Experiments 

Threshold fluorescence is calculated by the Mx3000P software according to the settings provided 
in Analysis Term Settings. If desired, the threshold fluorescence may be adjusted manually. (To 
restore the software-calculated values, click Reset).  

Baseline correction is required to establish a threshold fluorescence. Thus selections related to 
threshold fluorescence are unavailable for R or Rn data plots. 

Last Cycle Setting 

The Last cycle setting specifies the cycle from which the final (last) fluorescence values will be 
reported in the Text Report and Plate Sample Values screens. The position of the last cycle is 
marked on the graph with a solid vertical line.  

This setting also affects the way Ct values are reported on other Results screens. While the Last 
cycle is not directly used to determine Ct, any wells with Ct values greater than the Last cycle 
value will be designated as No Ct in screens that display Ct. 

Excluding Well/Dye Data from Analysis 

To exclude the curve for one or more specific well/dye combinations from analysis, use either of 
the following two methods. (Disabling a particular well/dye combination requires a replicate 
treatment setting of Treat individually, specified on the Analysis Selection/Setup screen.) 

• From the list under Select amplification plots to display, select the curve(s) to be excluded 
and then click Disable Dyes.  

• Double-click on any data point on the plot to be excluded. This action will exclude the 
entire data set for the well/dye corresponding to the plot. 

To restore a plot that was disabled using either of these methods, go to the Analysis 
Selection/Setup screen, click on Exclude Dyes, and then press the button corresponding to the 
specific dye/well combination, restoring the button to a depressed state. 

Display Options 

To restrict the plots shown to a subset of the selected well/dye combinations, use the Select 
amplification plots to display list near the bottom of the command panel. You may display a 
single plot or any subset of plots by selecting the desired plots from the list. (While selecting 
plots with the mouse, use the Shift key to select a contiguous group or the Ctrl key to select a 
non-contiguous group.)  

To display information about a specific data point on the plots, place the cursor over the point of 
interest. (Note that Display tooltips must be selected on the Display tab of the Preferences dialog 
box in order for the well information to be displayed.)  

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including whether the Legend and Plot Markers are displayed or hidden. See 
Graphs and Graph Properties for more information. 
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Comparative Quantitation Dissociation Curve 

For experiments that use SYBR Green detection and that include a Dissociation segment, use the 
Dissociation Curve screen, accessed through the Results tab, to view the dissociation profile. This 
screen shows a plot of the fluorescence (or its first derivative) as a function of temperature. 
Ensure that the data set collected during the Dissociation segment of the experiment is selected 
for analysis using the Analysis Selection/Setup screen. 

The plot shown below is based on the first derivative of the fluorescence reading multiplied by  
–1 [designated –R´(T)]. Plotting results in this way is generally appropriate for complex nucleic 
acid mixtures such as those generated during PCR amplification. In samples with amplicon, this 
type of plot will typically display at least two populations with different transition temperatures. 
Populations with a Tm of 80°C or higher correspond to the larger PCR products, and can usually 
be assigned as specific DNA product. DNA products displaying melting temperatures of < 75°C 
correspond to non-specific DNA products. It is important to note that these populations are not 
necessarily homogeneous, and may contain multiple PCR product species. 

 

Analysis Options 

Fluorescence Data Type Plotted 

Dissociation curves may be based on four different types of fluorescence: R (raw fluorescence), 
Rn (reference dye-normalized fluorescence), –R´(T), (the first derivative of the raw fluorescence 
reading multiplied by –1), and –Rn´(T) (the first derivative of the reference dye-normalized 
fluorescence reading multiplied by –1). Select the desired type of fluorescence data to be plotted 
from the Fluorescence menu on the command panel.  
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Product Melting Temperature Listings Settings 

The Mx3000P software will identify and report Product melting temperatures for up to six 
product populations from each dissociation curve. Set the maximum number of products for 
which a melting temperature should be calculated using the Max number spin controls. This 
setting controls only the maximum number; the software may detect and report a smaller number 
of product populations for a given curve.  

When basing plots on the negative derivative of fluorescence [–R´(T) or –Rn´(T)], you may 
specify the minimum peak height to be used for designating product populations. This peak 
height minimum may be entered in the Min peak height box as a decimal number or may be set 
manually by dragging the horizontal line indicator on the graph to the desired position. 

Display Options 

To restrict the plots shown to a subset of the well/dye combinations, use the Select dissociation 
plots to display list near the bottom of the command panel. You may display a single plot or any 
subset of plots by selecting the desired plots from the list. (While selecting plots with the mouse, 
use the Shift key to select a contiguous group or the Ctrl key to select a non-contiguous group.)  

To exclude the curve for one or more specific well/dye combinations from view, select the 
curve(s) to be excluded and then click Disable Dyes. Disabling a particular well/dye combination 
requires replicates to be treated individually (this may be specified on the Analysis 
Selection/Setup screen). To restore a disabled plot, go to the Analysis Selection/Setup screen, 
click on Exclude Dyes, and then press the button corresponding to the specific dye/well 
combination, restoring the button to a depressed state. 

To display information about a specific data point on the plots, place the cursor over the point of 
interest. (Note that Display tooltips must be selected on the Display tab of the Preferences dialog 
box in order for the well information to be displayed.) 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including whether the Legend and Plot markers are displayed or hidden. See 
Graphs and Graph Properties for more information. 

Reporting of Melting Temperatures (Tm) 

Melting temperatures for each of the product populations are displayed when the cursor is placed 
over any point on the curve of interest.  

 

Melting temperatures will also be reported on the Text Report screen when the appropriate Tm 
Product boxes are selected in the Columns selection on that screen.  
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Comparative Quantitation Plate Sample Values 

The Plate Sample Values screen displays Fluorescence values or Ct values for the sampled wells 
in a plate format. 

In each well with a well type assigned, the following information is shown:  
• Well type 
• Either the fluorescence or the Ct value for each dye for which data was collected 
• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 

underlined) 
• Association symbol, if used 
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Analysis Options 

Display the Values for Fluorescence or Ct 

Under Display the values for, specify the form of the data to be displayed by selecting either the 
Fluorescence or the Ct using radio button. You will also need to specify the type of fluorescence 
data to be either displayed or used in calculations by selecting a data type from the menu below 
the selected radio button. Refer to the tables below for descriptions of the fluorescence data type 
abbreviations in the menus. 

When displaying Fluorescence values, the following fluorescence data types are available:  
Data Type How Calculated 

R Last final fluorescence 
dR Last final fluorescence minus the initial fluorescence 
Rn Last normalized final fluorescence (with normalization based on the 

reference dye) 
dRn Last normalized final fluorescence minus the normalized initial 

fluorescence (with normalization based on the reference dye) 
R Last/R First final fluorescence divided by the initial fluorescence 
 

When displaying Ct values, Ct calculations may be based on the following fluorescence data 
types:  
Data Type How Calculated 

dR baseline-corrected fluorescence 
dRn baseline-corrected normalized fluorescence (with normalization based 

on the reference dye) 

 

Last Cycle 

The Last cycle setting specifies the cycle from which the fluorescence values will be reported. By 
default, the cycle shown is the last cycle of the ramp or plateau being analyzed.  

The Last cycle setting also affects the reporting of Ct. Any wells having Ct values greater than the 
Last cycle value will be reported as No Ct. 
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Comparative Quantitation Standard Curve 

The Standard Curve is a plot of the initial template quantity in the Standard wells (X-axis), 
versus the Ct (threshold cycle). A least mean squares curve fitting algorithm is used to generate 
the standard curves displayed. Curves are displayed for each dye for which data was collected in 
Standard wells. Unknown wells selected during Analysis Selection/Setup are also plotted on the 
standard curve (using a different data point marker) based on their measured Ct values. 

If less than two Standard wells were selected in Analysis Selection/Setup, no data will be plotted 
on this chart. (Note that after validation, many Comparative Quantitation experiments will not 
include a standard curve.)  

 

Analysis Options 

Fluorescence Data Type for Ct Determinations 

Select the type of fluorescence data to be used for Ct determinations from the Ct based on menu 
on the command panel. Available fluorescence data types are: dR (baseline-corrected raw 
fluorescence), and dRn (baseline-corrected, reference dye-normalized fluorescence).  
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Confidence Interval 

The confidence interval for each standard curve may be displayed by selecting the Show 
confidence interval checkbox. The resulting graph shows the confidence limits as hashed lines. 
The lines show the range of Initial Quantity values at a particular Ct that cannot be statistically 
distinguished from the fit line with more certainty than the confidence level (Level %) selected. 
The width of the confidence interval is an indicator of the quality of the fit of the data to the 
standard curve.  Confidence interval calculations require a Replicates setting of Treat individually. 
Confidence level values may be exported to an Excel file, a text file or an XML file by using the 
Export Chart Data commands on the File menu. 

 

Threshold Fluorescence 

The Threshold fluorescence value for each dye, as calculated by the Mx3000P software 
according to the settings provided in Analysis Term Settings, is listed on the command panel. If 
desired, the threshold fluorescence for a given dye may be adjusted manually by entering a new 
value in the spin control box for the dye. (To restore the software-calculated values, click Reset).  
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Excluding Well/Dye Data from Analysis 

To exclude a specific well/dye data point from analysis, double click on the data point on the 
chart. Disabling a particular well/dye combination requires a replicate treatment setting of Treat 
individually, specified on the Analysis Selection/Setup screen. To restore an excluded data point, 
go to the Analysis Selection/Setup screen, click on Exclude Dyes, and then press the button 
corresponding to the specific dye/well combination, restoring the button to a depressed state. 

Display Options 

To display information about a specific data point on the plots, place the cursor over the point of 
interest to display the following information: well location or replicate number, dye name, well 
type, the initial template quantity and the Ct. 

 

If the well is a Standard, the initial template quantity is the amount assigned to the well during 
plate setup. If the well is an Unknown, the initial template quantity is the interpolated amount 
based on the standard curve.   

Note  If Display tooltips is cleared (deselected) on the Display tab of the Preferences dialog box, 
this well information will not be displayed. 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls important 
display features including whether the Legend is displayed or hidden. See Graphs and Graph 
Properties for more information. 
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Interpretation and Use of Curve Attributes 

RSq Value, Slope, and Amplification Efficiency 

The graph legend displays information about each curve plotted. (If no legend is displayed on the 
screen, open the Graph Properties dialog box by double-clicking on the graph, and then select the 
On radio button under Legend.) Besides correlating plot markers with dyes and well types, the 
legend displays the R Squared (RSq) value and the equation for the line  [y = m*log(x) + b, 
where m is the slope of the line]. The amplification efficiency (Eff.), calculated from the slope, is 
also displayed. 

 

The RSq value is an indicator of the quality of the fit of the standard curve to the Standard data 
points plotted. The value will always be between 0 and 1. The closer the value is to 1, the better 
the fit of the line.  

The slope of the curve is directly related to the average amplification efficiency throughout the 
cycling reaction. The equation that relates the slope to amplification efficiency is: 

PCR Efficiency = 10(-1/slope) – 1 

where PCR Efficiency corresponds to the proportion of template molecules that are doubled every 
cycle. From this equation it follows that a reaction with 100% efficiency will result in a slope of 
–3.322. 

Initial Template Quantity Calculator 

To use the displayed standard curve to calculate an interpolated relative quantity of template in 
another sample from the run based on the Ct, choose the dye from the Select dye menu, then 
enter the Ct value. The software will calculate and display the interpolated relative initial 
template quantity (Interpolated qty).  
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Amplification Efficiency Calculator 

Enter either a Slope value or an amplification Efficiency value into the Amplification efficiency 
calculator to convert between values, based on the following equation: 
PCR Efficiency = 10(-1/slope) – 1 

 
Implementing Standard Curve Results in Comparative Quantitation Experiments 

The Standard Curve (for validation) functionality is included in this experiment type to facilitate 
the determination of the efficiencies of amplification for the gene of interest and the Normalizer, 
a critical step in the initial optimization of Comparative Quantitation experiments.  

After a particular assay using a particular Normalizer has been validated, standard curves may be 
omitted from later experiments. Some researchers also include standard curves in optimized 
assays for validation of results.  
Determination of Amplification Efficiencies 

Define a serial dilution set of wells for two different targets as Standards with their 
corresponding initial quantities, and then analyze the results using the Standard Curve (for 
validation) plot. To determine the amplification efficiencies, enter the reported slope of each 
curve into the Amplification efficiency calculator.  
Recording Efficiencies for Use in Relative Quantity Calculations 

Enter the slope or efficiency values for the two targets in the Efficiency Settings tabbed page of 
the Analysis Term Settings dialog box. Changing these values from the default values 
(corresponding to 100% efficiency) will cause the Mx3000P software to automatically 
compensate for differences in efficiencies for the two targets when reporting relative quantities 
on other Results screens. Note that using this feature to compensate for differences in 
amplification efficiency requires that the GOI and Normalizer be detected with different dyes. 

Access the Efficiency Settings page by selecting Analysis Term Settings from the Options menu. 
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Comparative Quantitation Relative Quantity Chart 

The Relative Quantity Chart screen, accessed through the Results tab, shows a graph depicting the 
relative quantity values for each well relative to the Calibrator. The relative quantity of the 
Calibrator is automatically defined as 1.0 and is not displayed on the graph. Relative quantities 
may be displayed in either bar graph (shown) or line plot format. See Display Options, below, 
for more information. 

When replicates are treated individually (in Analysis Selection/Setup), the X-axis displays Well 
Ids (in A1 through H12 format). When replicates are treated collectively, relative quantity values 
are plotted against the Replicate symbol. 

 

Analysis Options 

Relative Quantity Based On 

Under Relative quantity based on, specify the form of the fluorescence data to be used in relative 
quantity calculations. Available fluorescence data types are: dR (baseline-corrected raw 
fluorescence), and dRn (baseline-corrected, reference dye-normalized fluorescence).  
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Display Options  

To change the style of the relative quantity chart from bar graph to line plot, or the reverse, 
double-click on the graph to open the Graph Properties dialog box. In the Style section of the 
dialog, select Plot to display the data as a line plot or Bar to display the data as a bar graph. 

To restrict the results shown to a subset of the replicate set or well/dye combinations, use the 
Select replicate/well dyes to plot list near the bottom of the command panel. You may display a 
single plot or any subset of plots by selecting the desired plots from the list. (While selecting 
plots with the mouse, use the Shift key to select a contiguous group or the Ctrl key to select a 
non-contiguous group.)  

To display information about a specific well or replicate set, place the cursor over the bar or 
point corresponding to the well/replicate set of interest. (Note that Display tooltips must be 
selected on the Display tab of the Preferences dialog box in order for the well information to be 
displayed.) 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including the attributes of the axes. See Graphs and Graph Properties for more 
information. 
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Comparative Quantitation Relative Quantity Plate 

The Relative Quantity Plate screen displays the calculated relative quantities of template present 
in the wells before thermal cycling in a plate format. 

In each well with a well type assigned, the following information is shown:  
• Well type 
• Relative initial template quantity for each dye associated with a gene of interest. For 

Unknowns, the value relative to the Calibrator after correction for Normalizer quantities 
is reported. For all well types, the reference dye (Ref) and the normalizer dye (Norm) are 
not quantified 

• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 
underlined) 

• Association symbol, if used 
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Analysis Options 

Relative Quantity Based On 

Under Relative quantity based on, specify the form of the fluorescence data to be used to in 
relative quantity calculations. Available fluorescence data types are: dR (baseline-corrected raw 
fluorescence), and dRn (baseline-corrected, reference-dye normalized fluorescence).  

Relative quantities are calculated from the Ct values for the gene of interest and the Normalizer 
in both the Unknown wells and in the Calibrator wells. Therefore, normalizing the data for the 
reference dye indirectly affects the relative quantity values through changing the Ct values. 
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Comparative Quantitation Text Report 

The Text Report screen shows the data from a run in text format.  

 

Analysis Options 

Last Cycle 

The Last cycle setting specifies the cycle from which the fluorescence values will be reported 
when fluorescence value columns (such as dRn Last) are selected for display. By default, the 
cycle shown is the last cycle of the ramp or plateau being analyzed.  

 

The Last Cycle setting also affects the reporting of Ct and Relative Quantity. Any wells having Ct 
values greater than the Last cycle value will be reported as No Ct. 
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Ct and Relative Quantity Based On 

 

Select the type of fluorescence data that the reported Ct and Relative Quantity should be based on 
from the Ct and relative quantity based on menu on the command panel. Available fluorescence 
data types are: dR (baseline-corrected fluorescence) and dRn (baseline-corrected, reference dye-
normalized fluorescence).  

Tm Results Based On 

 

Select the type of fluorescence data plot that the reported melting temperature (Tm) should be 
based on from the Melting temperature (Tm) based on menu on the command panel. Available 
designations are: -R'(T), for plots based on raw fluorescence (the negative of the first derivative) 
of  and -Rn'(T), for plots based on the normalized fluorescence (the negative of the first 
derivative).  

Display Options 

Columns Included in the Report 

Select the Columns to be included in the text report by checking the boxes next to the column 
names. To exclude columns that are selected by default, click on the check box to deselect the 
column name. To select all columns for display, click Select All. The default settings for column 
selection can be restored by expanding the Defaults menu and then clicking Get. 

If the included columns will not fit in the screen, a horizontal scroll bar appears at the bottom of 
the window to allow horizontal scrolling. 
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Column Width 

To facilitate viewing data, columns can be automatically sized. Clicking the Contents Only 
button will cause each column to be automatically resized to the width of the widest data cell in 
that column (some column headers may be only partially displayed using this setting). Clicking 
the Hdr & Contents button will cause each column to be resized to the widest cell in that column, 
including the header cell. 

Columns can also be resized manually by dragging the column dividers with the mouse.  

Specialized Comparative Quantitation Text Report Columns 

Rel. Quant. to Norm. The estimated quantities of gene of interest relative 
to the Normalizer target within that well or 
associated to it during Plate Setup, regardless of the 
Calibrator. This value is simply an approximation 
and is not intended as a quantitative result. The 
calculations are done for each individual well (or 
set of replicates), regardless of well type. 

Rel. Quant. to Std. (for validation) The quantitative determination of the (relative) 
initial quantity based on the standard curve for the 
same dye and target. Note that for experiments that 
include two standard curves using the same dye 
(e.g. one for the gene of interest and one for the 
Normalizer), wells for only one standard curve 
should be selected for each round of analysis. 
Alternatively, detection of two targets with the 
same dye may be distinguished by renaming the dye 
used for one target as discussed in Using a Single 
Dye for Detection of Gene of Interest and 
Normalizer. 

Rel. Quant. to Cal. The relative quantity of the gene of interest 
corrected for the quantity of the Normalizer target, 
and relative to the Calibrator sample. (For example, 
a Rel. Quant. to Cal of 2 means that there is twice as 
much target in the Unknown sample as in the 
Calibrator, when the numbers are corrected for the 
Normalizer quantity in each well.) 

A note on standard deviations: Each reported quantity is associated with a standard deviation and 
a coefficient of variation (cv). When replicates are treated collectively, these values are 
calculated as zero, since replicate variability is eliminated in the collective treatment. When 
replicates are treated individually, quantities are calculated for each well based on their 
individual Ct values and on the average Ct values for the respective Normalizer and Calibrator. 
The standard deviation of the calculated relative quantities for a group of replicate wells is 
calculated for each replicate set. The coefficient of variation is calculated as the standard 
deviation divided by the average. 
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Exporting Text Report Data 

Text report data can be exported from the application in text, Microsoft Excel spreadsheet or 
XML format for analysis. Text report exporting options are available from the File menu. See 
Exporting Data to Other Applications in the File Menu section for more information. 
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Mx3000P System Experiments:  
SYBR Green (with Dissociation Curve) 
The SYBR Green Experiment Type 
SYBR Green experiments typically use a Standard Curve to quantitate the amount of target 
present in Unknown samples using SYBR Green I dye for detection of double-stranded DNA 
(dsDNA). The Thermal Profile includes a dissociation curve, used to verify that the majority of 
fluorescence detected can be attributed to the labeling of specific PCR products, and to verify the 
absence of primer-dimers and sample contamination. See Detection using SYBR Green Dye for 
more information on the general properties of SYBR Green I dye. 

The accumulation of dsDNA can be assessed by the incorporation of SYBR Green I dye into a 
PCR reaction. A major advantage of this approach is that no fluorescence-labeled probes are 
required. A limitation is that dye binding to both specific and non-specific PCR products 
generates the same fluorescence signal. Including a dissociation curve in the experiment 
facilitates the process of optimizing the assay for conditions that minimize the formation of non-
specific products, and provides a means for verifying the predominance of specific products in 
each run. Using this approach, SYBR Green dye-based assays have been successfully used for a 
wide variety of QPCR and QRT-PCR applications.  

In SYBR Green experiments, the Mx3000P instrument detects the fluorescence of the SYBR 
Green fluorophore during each cycle of the thermal cycling process and a Fluorescence value is 
reported at each cycle. Fluorescence values are generally acquired in the annealing and extension 
stages of thermal cycling. Fluorescence results are typically displayed in an Amplification plot, 
which reflects the change in fluorescence during cycling.  

The initial copy numbers of RNA or DNA targets can be quantified using real-time PCR analysis 
based on threshold cycle (Ct) determinations. The Ct is defined as the cycle at which a 
statistically-significant increase in fluorescence (above background signal measured in the early 
rounds of amplification) is detected. The threshold cycle is inversely proportional to the log of 
the initial copy number. In other words, the more template that is present initially, the fewer the 
number of cycles required for the fluorescence signal to be detectable above background.  

Typical SYBR Green experiments use a standard curve to quantitate the amount of target present 
in an Unknown sample. In this method, a series of Standards, containing a dilution series of a 
known amount of target, are amplified to generate a curve that relates the initial quantity of the 
specific target in the Standard sample to the Ct. The standard curve is then used to interpolate the 
initial template quantity in Unknown wells based on the Ct values determined for the Unknown 
wells. 
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Use of the Dissociation Curve 

The SYBR Green experiment has two major phases: Amplification and Dissociation. The 
Amplification phase corresponds to the PCR portion of the experiment, and results in the 
generation of dsDNA. In the Dissociation phase, the dsDNA product is melted into ssDNA by a 
stepwise increase in temperature, with fluorescence data being collected at each temperature 
step. The magnitude of the reduction in fluorescence intensity of the SYBR Green dye due to its 
release from dsDNA provides an indicator of the amount of dsDNA dissociated at each step in 
the dissociation curve. For data analysis, Fluorescence (or its first derivative) is plotted as a 
function of Temperature. In thermal denaturation profiles for complex nucleic acid mixtures such 
as those generated during PCR amplification, two semi-discrete populations with different 
transition temperatures can typically be identified in the first derivative plots. Populations with a 
Tm of 80°C or higher correspond to the larger PCR products, and can usually be assigned to the 
specific DNA product. DNA products displaying melting temperatures of < 75°C correspond to 
non-specific DNA products. It is important to note that these populations are not necessarily 
homogeneous, and may contain multiple PCR product species. 

Analysis often includes evaluation of the dissociation curve for no-template-control (NTC) 
reactions in order to monitor the presence of primer-dimers and of contaminating template that 
might be contributing to the fluorescence signal.    
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SYBR Green Plate Setup 
In the Setup section of the software, open the Plate Setup tab. Shown below is a typical plate 
setup for a SYBR Green experiment. 

 

The Mx3000P software features several shortcuts to expedite plate setup including the ability to 
Import an existing setup, to use a Default setup, and to rapidly specify collection of data for all 
dyes in all wells by using Quick Setup. 

Plate Setup is accomplished using the selection boxes and commands on the command panel at 
the right of the screen. The command panel is designed to be followed in a top-to-bottom order, 
beginning with Well type assignment. All other selections are unavailable until after Well type 
has been assigned. 
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Select the well(s) to be assigned using the mouse then assign the well(s) by using the Well type 
menu on the command panel. The well types available in a SYBR Green experiment are described 
in the table below. 
Well Type Description 
Unknown  Contains a complete reaction mixture including a test template that 

contains an  unknown amount of the specific target. 
Buffer Contains only buffer, used to monitor the background fluorescence 

attributable to the buffer. 
NAC No amplification control; contains all  reaction components except DNA 

polymerase. 
NPC No probe control; contains all reaction components except the 

fluorescence-labeled probe. 
NTC No template control; contains all reaction components except the template 

nucleic acid. 
Standard Contains a complete reaction mixture including a known concentration of 

target nucleic acid. Used to generate a standard curve, which is then used to 
relate the threshold cycle (Ct) to initial template quantity in Unknown 
wells. 

No RT No reverse transcriptase control; contains all QRT-PCR reaction 
components except reverse transcriptase. 

Not in Use Optional designation for wells that are not in use. It is not necessary to 
define any unused wells. This well type is equivalent to an unassigned 
well. 

Dye-specific 
Negative Control 

Contains all reaction components except the template or target sequence 
detected with the specified dye. Negative control well types available 
correspond to the dyes defined in Optics Configuration. This well type 
assignment is rarely used in SYBR Green experiments (most will use the 
NTC well type assignment for reactions lacking template). 

Dye-specific 
Positive Control 

Contains all reaction components including template known to be positive 
for the target sequence that is detected with the specified dye. Positive 
control well types available correspond to the dyes defined in Optics 
Configuration. This well type assignment, which qualitatively designates a 
positive signal for the target without specifying the absolute amount, is 
rarely used in SYBR Green experiments (most will include Standard wells 
with known amounts of target). 

After assigning the Well type to the selected well(s), select the dyes for which data should be 
collected in these wells using the Collect fluorescence data check boxes.  SYBR Green I dye data 
are collected using the FAM filter path.  If FAM, rather than SYBR appears on the setup screen, 
SYBR Green dye may be assigned to this path in the Optics Configuration dialog box.  

If you are using a passive reference dye in the selected well(s) select the dye from the Reference 
dye menu. If all sample wells on the plate will contain the same passive reference dye, depress 
the All wells button. 
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If the selected well(s) is a Standard, enter the amount of template. To do this, first select the dye 
from the pulldown menu following Standard quantity. Next, enter the quantity of template added 
to the selected well(s) as a decimal number (for example, 400 or 1.234). Specify the units for the 
quantity in the Standard Units dropdown box. Instead of assigning quantities to wells on an 
individual basis, it is also possible to assign quantities to Standard wells sequentially using the 
Auto-Increment feature. 

Assign the replicate set number to the selected well(s) by using the Replicate symbol menu. 
Instead of assigning replicate numbers to wells on an individual basis, it is also possible to assign 
replicates sequentially using the Auto-Increment feature. 

Once plate setup is complete, click Next to proceed to the Thermal Profile Setup screen. 
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SYBR Green Thermal Profile Setup 
When the Thermal Profile Setup tab is selected in a new SYBR Green experiment, a default 
thermal profile opens. The default thermal profile should be modified to the specific 
requirements of the new experiment, as discussed below. It is also possible to Import the thermal 
profile from an existing experiment into the new experiment. 

Shown in the figure below is the default thermal profile for a SYBR Green experiment when 
using the software's Original Settings. (If you are using a user-defined default set, the default 
thermal profile stored in that default set will appear when the Thermal Profile Setup screen is 
opened. See Preferences-Defaults for more information about the use and management of 
Defaults.)    

In the profile below, segment 1 is an activation step of 95°C for 10 minutes that is compatible 
with a hot start reaction. Segment 2 is the PCR Amplification phase of the experiment and 
consists of 40 cycles of amplification using a plateau of 95°C/30 seconds for denaturation, 
followed by a plateau of 55°C/1 minute for annealing, and a plateau of 72°C/30 seconds for 
extension. Amplification data are collected at the end of each annealing plateau. Segment 3 
contains the Dissociation curve. The default profile dissociation curve begins with a 1-minute 
incubation at 95°C to melt the DNA and then a 30-second incubation at 55°C. This is followed 
by a ramp up to 95°C with Allpoints data collection performed during the ramp. Data collection 
during the ramp slows the ramp rate to 0.01°C/sec to allow for a slow melt of the PCR product. 
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Modify the default thermal profile as necessary. At minimum, ensure that the Amplification 
(Segment 2) annealing temperature setting is appropriate for the PCR primer pair used in the 
current experiment. The properties of all other plateaus, ramps, and segments may also be 
adjusted. See Thermal Profile Setup in the How-To (Detailed Protocols) section for more 
information about changing the default thermal profile. 
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SYBR Green Data Analysis 

Analysis Setup 

On the Analysis Selection/Setup screen: 

1. Select the wells to be included in the analysis. 

2. Select the segment (Amplification or Dissociation), and then the position (either the ramp 
or the plateau) from which data should be analyzed. The Dissociation segment should be 
selected only for viewing the Dissociation curve. All other Results screens require 
selection of a data set collected during amplification. 

3. Specify the desired analysis settings on the command panel.  

 

See Analysis Selection and Setup for more detailed instructions on using the features on this 
screen. 
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When all selections and settings are made, click the Results tab. The first of several available 
results screens will appear. Use the radio buttons under Area to analyze to navigate to different 
analysis screens. The following screens are available for SYBR Green analysis: 

Amplification Plots 
Dissociation Curve 
Plate Sample Values 
Standard Curve 
Initial Template Quantity 
Text Report 

Selecting the Data Collection Ramp/Plateau 

The SYBR Green Dissociation Curve experiment typically has two phases: Amplification and 
Dissociation (or melting curve). Data can be collected for each of these parts. Prior to data 
analysis, it is necessary to select which data set will be used in the Dissociation Curve analysis 
(Dissociation data set) and which data set will be used for quantitative analyses (Amplification 
data set).  

To select the data set to be used in the Amplification analysis (Amplification plots, Plate sample 
values, Standard curve, Initial template quantity, and Text report), click Amplification from the 
Select Data Collection Ramp/Plateau box in Analysis Selection/Setup. Then select the appropriate 
ramp/plateau.  

 

 

To assign a data set to use in the Dissociation Curve analysis, click Dissociation from the Select 
Data Collection Ramp/Plateau box and choose the appropriate data set.  
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SYBR Green Amplification Plots 

The Amplification Plots screen, accessed through the Results tab, shows a plot of cycles versus 
fluorescence for a ramp or plateau on which data are gathered. Select the ramp or plateau for 
which data should be analyzed using the Analysis Selection/Setup screen. 

 

Analysis Options 

Fluorescence Data Type Plotted 

Select the type of fluorescence data to be plotted from the Fluorescence menu on the command 
panel. Available fluorescence data types are: R (raw fluorescence), dR (baseline-corrected raw 
fluorescence), Rn (normalized fluorescence), and dRn (baseline-corrected normalized 
fluorescence).  

Threshold Fluorescence 

When basing plots on normalized fluorescence (dR or on dRn), the Threshold fluorescence value 
for each dye is listed on the command panel and is marked on the graph by a horizontal line. 
(Note that if a dye is hidden using the Dyes shown controls or if the check box next to the dye is 
cleared, the line corresponding to threshold fluorescence for that dye will not be shown on the 
graph.)  
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Threshold fluorescence is calculated by the Mx3000P software according to the settings provided 
in Analysis Term Settings. If desired, the threshold fluorescence may be adjusted manually. (To 
restore the software-calculated values, click Reset).  

Baseline correction is required to establish a threshold fluorescence. Thus selections related to 
threshold fluorescence are unavailable for R or Rn data plots. 

Last Cycle Setting 

The Last cycle setting specifies the cycle from which the final (last) fluorescence values will be 
reported in the Text Report and Plate Sample Values screens. The position of the last cycle is 
marked on the graph with a solid vertical line.  

This setting also affects the way Ct values are reported on other Results screens. While the Last 
cycle is not directly used to determine Ct, any wells with Ct values greater than the Last cycle 
value will be designated as No Ct in screens that display Ct. 

Excluding Well/Dye Data from Analysis 

To exclude the curve for one or more specific well/dye combinations from analysis, use either of 
the following two methods. (Disabling a particular well/dye combination requires a replicate 
treatment setting of Treat individually, specified on the Analysis Selection/Setup screen.) 

• From the list under Select amplification plots to display, select the curve(s) to be excluded 
and then click Disable Dyes.  

• Double-click on any data point on the plot to be excluded. This action will exclude the 
entire data set for the well/dye corresponding to the plot. 

To restore a plot that was disabled using either of these methods, go to the Analysis 
Selection/Setup screen, click on Exclude Dyes, and then press the button corresponding to the 
specific dye/well combination, restoring the button to a depressed state. 

Display Options 

To restrict the plots shown to a subset of the selected well/dye combinations, use the Select 
amplification plots to display list near the bottom of the command panel. You may display a 
single plot or any subset of plots by selecting the desired plots from the list. (While selecting 
plots with the mouse, use the Shift key to select a contiguous group or the Ctrl key to select a 
non-contiguous group.)  

To display information about a specific data point on the plots, place the cursor over the point of 
interest. (Note that Display tooltips must be selected on the Display tab of the Preferences dialog 
box in order for the well information to be displayed.) 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including whether the Legend and Plot Markers are displayed or hidden. See 
Graphs and Graph Properties for more information. 
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SYBR Green Dissociation Curve 

The Dissociation Curve screen, accessed through the Results tab, shows a plot of  fluorescence (or 
its first derivative) as a function of temperature for the Dissociation segment of the experiment. 
Ensure that the data set collected during the Dissociation segment of the experiment is selected 
for analysis using the Analysis Selection/Setup screen. 

The plot shown below is based on the first derivative of the normalized fluorescence reading 
multiplied by –1 [designated –Rn´(T)]. Plotting results in this way is generally appropriate for 
complex nucleic acid mixtures such as those generated during PCR amplification. In samples 
with amplicon, this type of plot will typically display at least two populations with different 
transition temperatures. Populations with a Tm of 80°C or higher correspond to the larger PCR 
products, and can usually be assigned as specific DNA product. DNA products displaying 
melting temperatures of < 75°C correspond to non-specific DNA products. It is important to note 
that these populations are not necessarily homogeneous, and may contain multiple PCR product 
species. 

 

Mx3000P™ Real-Time PCR System 201 



Mx3000P System Experiments 

Analysis Options 

Fluorescence Data Type Plotted 

Dissociation curves may be based on four different types of fluorescence: R (raw fluorescence), 
Rn (normalized fluorescence), –R´(T), (the first derivative of the raw fluorescence reading 
multiplied by –1), and –Rn´(T) (the first derivative of the normalized fluorescence reading 
multiplied by –1). Select the desired type of fluorescence data to be plotted from the 
Fluorescence menu on the command panel.  

Product Melting Temperature Listings Settings 

The Mx3000P software will identify and report Product melting temperatures for up to six 
product populations from each dissociation curve. Set the maximum number of products for 
which a melting temperature should be calculated using the Max number spin control box. This 
setting controls only the maximum number; the software may detect and report a smaller number 
of product populations for a given curve.  

When basing plots on the negative derivative of fluorescence [–R´(T) or –Rn´(T)], you may 
specify the minimum peak height to be used for designating product populations.  This peak 
height minimum may be entered in the Min peak height box as a decimal number or may be set 
manually by dragging the horizontal line indicator on the graph to the desired position. 

Display Options 

To restrict the plots shown to a subset of the selected well/dye combinations, use the Select 
dissociation plots to display list near the bottom of the command panel. You may display a single 
plot or any subset of plots by selecting the desired plots from the list. (While selecting plots with 
the mouse, use the Shift key to select a contiguous group or the Ctrl key to select a non-
contiguous group.)  

To exclude the curve for one or more specific well/dye combinations from view, select the 
curve(s) to be excluded and then click Disable Dyes. Disabling a particular well/dye combination 
requires replicates to be treated individually (this may be specified on the Analysis 
Selection/Setup screen). To restore a disabled plot, go to the Analysis Selection/Setup screen, 
click on Exclude Dyes, and then press the button corresponding to the specific dye/well 
combination, restoring the button to a depressed state. 

To display information about a specific data point on the plots, place the cursor over the point of 
interest. (Note that Display tooltips must be selected on the Display tab of the Preferences dialog 
box in order for the well information to be displayed.) 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including whether the Legend and Plot markers are displayed or hidden. See 
Graphs and Graph Properties for more information. 
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Reporting of Melting Temperatures (Tm) 

Melting temperatures for each of the identified product populations are displayed when the 
cursor is placed over any point on the curve of interest.  

Melting temperatures will also be reported on the Text Report screen when the appropriate Tm 
Product boxes are selected in the Columns selection on that screen.    

 

 

Mx3000P™ Real-Time PCR System 203 



Mx3000P System Experiments 

SYBR Green Plate Sample Values 

The Plate Sample Values screen displays Fluorescence values or Ct values for the sampled wells 
in a plate format. 

In each well with a well type assigned, the following information is shown:  
• Well type 
• Either the fluorescence or the Ct value for each dye for which data was collected 
• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 

underlined) 

 

Analysis Options 

Display the Values for Fluorescence or Ct 

Under Display the values for, specify the form of the data to be displayed by selecting either the 
Fluorescence or the Ct using radio button. You will also need to specify the type of fluorescence 
data to be either displayed or used in calculations by selecting a data type from the menu below 
the selected radio button. Refer to the tables below for descriptions of the fluorescence data type 
abbreviations in the menus. 
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When displaying Fluorescence values, the following fluorescence data types are available:  
Data Type How Calculated 

R Last final fluorescence 
dR Last final fluorescence minus the initial fluorescence 
Rn Last normalized final fluorescence 
dRn Last normalized final fluorescence minus the normalized initial 

fluorescence 
R Last/R First final fluorescence divided by the initial fluorescence 
 

When displaying Ct values, Ct calculations may be based on the following fluorescence data 
types:  
Data Type How Calculated 

dR baseline-corrected fluorescence 
dRn baseline-corrected normalized fluorescence 

 

Last Cycle 

The Last cycle setting specifies the cycle from which the fluorescence values will be reported. By 
default, the cycle shown is the last cycle of the ramp or plateau being analyzed.  

The Last cycle setting also affects the reporting of Ct. Any wells having Ct values greater than the 
Last cycle value will be reported as No Ct. 
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SYBR Green Standard Curve 

The Standard Curve is a plot of the initial template quantity in the Standard wells (X-axis), 
versus the Ct (threshold cycle). A least mean squares curve fitting algorithm is used to generate 
the standard curves displayed. Curves are displayed for each dye for which data was collected in 
Standard wells. Unknown wells selected during Analysis Selection/Setup are also plotted on the 
standard curve (using a different data point marker) based on their measured Ct values. 

 

If less than two Standard wells were selected in Analysis Selection/Setup, no data will be plotted 
on this chart. 

Analysis Options 

Fluorescence Data Type for Ct Determinations 

Select the type of fluorescence data to be used for Ct determinations from the Ct based on menu 
on the command panel. Available fluorescence data types are: dR (baseline-corrected raw 
fluorescence), and dRn (baseline-corrected normalized fluorescence).  
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Confidence Interval 

The confidence interval for each standard curve may be displayed by selecting the Show 
confidence interval checkbox. The resulting graph shows the confidence limits as hashed lines. 
The lines show the range of Initial Quantity values at a particular Ct that cannot be statistically 
distinguished from the fit line with more certainty than the confidence level (Level %) selected. 
The width of the confidence interval is an indicator of the quality of the fit of the data to the 
standard curve.  Confidence interval calculations require a Replicates setting of Treat individually. 
Confidence level values may be exported to an Excel file, a text file or an XML file by using the 
Export Chart Data commands on the File menu. 

 

Threshold Fluorescence 

The Threshold fluorescence value for each dye, as calculated by the Mx3000P software 
according to the settings provided in Analysis Term Settings, is listed on the command panel. If 
desired, the threshold fluorescence for a given dye may be adjusted manually by entering a new 
value in the spin control box for the dye. (To restore the software-calculated values, click Reset).  

 

Excluding Well/Dye Data from Analysis 

To exclude a specific well/dye data point from analysis, double click on the data point on the 
chart. Disabling a particular well/dye combination requires a replicate treatment setting of Treat 
individually, specified on the Analysis Selection/Setup screen. To restore an excluded data point, 
go to the Analysis Selection/Setup screen, click on Exclude Dyes, and then press the button 
corresponding to the specific dye/well combination, restoring the button to a depressed state. 
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Display Options 

To display information about a specific data point on the plot, place the cursor over the point of 
interest to display the following information: well location or replicate number, dye name, well 
type, the initial template quantity and the Ct. 

 

If the well is a Standard, the initial template quantity is the amount assigned to the well during 
plate setup. If the well is an Unknown, the initial template quantity is the interpolated amount 
based on the standard curve.   

Note  If Display tooltips is cleared (deselected) on the Display tab of the Preferences dialog box, 
this well information will not be displayed. 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including whether the Legend is displayed or hidden. See Graphs and Graph 
Properties for more information. 

Interpretation and Use of Curve Attributes 

RSq Value, Slope, and Amplification Efficiency 

The graph legend displays information about each curve plotted. (If no legend is displayed on the 
screen, open the Graph Properties dialog box by double-clicking on the graph, and then select the 
On radio button under Legend.) Besides correlating plot markers with dyes and well types, the 
legend displays the R Squared (RSq) value and the equation for the line  [y = m*log(x) + b, 
where m is the slope of the line]. The amplification efficiency (Eff.), calculated from the slope, is 
also displayed. 

  

The RSq value is an indicator of the quality of the fit of the standard curve to the Standard data 
points plotted. The value will always be between 0 and 1. The closer the value is to 1, the better 
the fit of the line.  
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The slope of the curve is directly related to the average amplification efficiency throughout the 
cycling reaction. The equation that relates the slope to amplification efficiency is: 

PCR Efficiency = 10(-1/slope) – 1 

where PCR Efficiency corresponds to the proportion of template molecules that are doubled 
every cycle. From this equation it follows that a reaction with 100% efficiency will result in a 
slope of –3.322. 

Initial Template Quantity Calculator 

To use the displayed standard curve to calculate an interpolated quantity of template in another 
sample from the run based on the Ct determined for the sample, choose the dye from the Select 
dye menu, then enter a Ct value. The software will calculate and display the interpolated initial 
template quantity (Interpolated qty). Note that initial template quantities are automatically 
determined, based on the standard curves, for all Unknowns in the same experiment, and these 
results may be viewed on the Initial Template Quantity results screen. 

 

Amplification Efficiency Calculator 

Enter either a Slope value or an amplification Efficiency value into the Amplification efficiency 
calculator to convert between values, based on the following equation: 

PCR Efficiency = 10(-1/slope) – 1 
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SYBR Green Initial Template Quantity 
The Initial Template Quantity screen displays interpolated quantities of template added to 
Unknown wells before thermal cycling in a plate format. 

In each well with a well type assigned, the following information is shown:  
• Well type 
• Initial template quantity (for Unknowns, the value interpolated from the standard curve 

based on the Ct calculated for the Unknown; for Standards, the amounts entered during 
plate setup) 

• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 
underlined) 

If less than two Standard wells were selected in Analysis Selection/Setup, a standard curve cannot 
be plotted and an error message will appear in place of results in the Unknown wells. 

 

Analysis Options 

Fluorescence Data Type for Ct Determinations 

Select the type of fluorescence data to be used to calculate the Ct values to be used for 
interpolation from the Interpolated template quantity based on menu on the command panel. 
Available fluorescence data types are: dR (baseline-corrected raw fluorescence), and dRn 
(baseline-corrected normalized fluorescence).  
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SYBR Green Text Report 

The Text Report screen shows the data from a run in text format.  

 

Analysis Options 

Last Cycle 

The Last cycle setting specifies the cycle from which the fluorescence values will be reported 
when fluorescence value columns (such as dRn Last) are selected for display. By default, the 
cycle shown is the last cycle of the ramp or plateau being analyzed.  

 

The Last cycle setting also affects the reporting of Ct and the Final Call. Any wells having  
Ct values greater than the Last cycle value will be reported as No Ct and will be called as negative 
(–). 
Ct and Final Call Based On 

Select the type of fluorescence data that the reported Ct and Final Call should be based on from 
the Ct and final call based on menu on the command panel. Available fluorescence data types 
are: dR (baseline-corrected fluorescence) and dRn (baseline-corrected normalized fluorescence).  
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Tm Results Based On 

Select the type of fluorescence data plot that the reported melting temperature (Tm) should be 
based on from the Melting temperature (Tm) results based on menu on the command panel. 
Available designations are: -R'(T), for plots based on raw fluorescence (the negative of the first 
derivative) and -Rn'(T), for plots based on normalized fluorescence (the negative of the first 
derivative).  

 

Display Options 

Columns Included in the Report 

Select the Columns to be included in the text report by checking the boxes next to the column 
names. To exclude columns that are selected by default, click on the check box to deselect the 
column name. To select all columns to display, click Select All. The default settings for column 
selection can be restored by expanding the Defaults menu and then clicking Get. 

If the included columns will not fit in the screen, a horizontal scroll bar appears at the bottom of 
the window to allow horizontal scrolling. 

 
Column Width 

To facilitate viewing data, columns can be automatically sized. Clicking the Contents Only 
button will cause each column to be automatically resized to the width of the widest data cell in 
that column (some column headers may be only partially displayed using this setting). Clicking 
the Hdr & Contents button will cause each column to be resized to the widest cell in that column, 
including the header cell. 

Columns can also be resized manually by dragging the column dividers with the mouse.  
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Exporting Text Report Data 

Text report data can be exported from the application in text,  Microsoft Excel spreadsheet or 
XML format for analysis. Text report exporting options are available from the File menu. See 
Exporting Data to Other Applications in the File Menu section for more information. 
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Mx3000P System Experiments:  
Allele Discrimination/SNP's Real-Time 
The Allele Discrimination/SNP's Real-Time Experiment 
Type 
The Allele Discrimination/SNP's Real-Time experiment type uses fluorogenic probes to determine 
the allelic composition of DNA samples. Two fluorogenic probes, labeled with two spectrally 
distinct dyes, are used to discriminate between two alleles. For example, if amplification in an 
unknown DNA sample is detected for the dye identifying the wild-type allele but not for the dye 
identifying a mutant allele, the sample can be designated as wild-type homozygous. If 
amplification in an unknown DNA sample is detected for the dye identifying the mutant allele 
but not for the dye identifying the wild-type allele, the sample can be designated as mutant 
homozygous. If amplification is detected for both dyes, the unknown sample is designated as 
heterozygous for the two alleles. With properly designed probes, this assay is sensitive enough to 
detect a single-base difference (single-nucleotide-polymorphism or SNP) between two alleles.  

Molecular beacons can be used in a variety of PCR applications, but are commonly used in 
Allele Discrimination assays due to the high specificity of the molecular beacons in recognizing 
nucleotide sequence mismatches in DNA and RNA. The hairpin shape of the molecular beacon 
causes mismatched probe/target hybrids to easily dissociate at significantly lower temperatures 
than exactly complementary hybrids. This thermal instability of mismatched hybrids increases 
the specificity of molecular beacons. See Molecular Beacons Probes in the Getting Started  
section for more information on the mechanism of action of molecular beacons in QPCR assays. 

Monitoring PCR reactions in real-time produces a fluorescence signal during each cycle. Results 
are displayed as an Amplification plot that reflects the change in fluorescence during cycling. For 
Allele Discrimination/SNP's Real-Time experiments, fluorescence is typically monitored and 
reported during each annealing step when the molecular beacon is bound to its complementary 
target. 

In the analysis of Allele Discrimination/SNP's Real-Time experiments, the Mx3000P software uses 
the threshold cycle (Ct) value for each dye in each sample to determine the genotypes of the 
samples. The threshold cycle is the cycle at which the fluorescence signal is first detectable 
above background. A Ct value of 24–32 is expected for a sample that contains the specific allele 
recognized by the probe. A Ct value equal to the final cycle of the PCR reaction (typically 40) 
indicates the absence of a specific allele.  Results are conveniently displayed in the Dual Color 
Scatter Plot, which shows the Ct for the dye specific to one allele plotted against the Ct for the 
dye specific to the other allele. Plotted points are grouped according to their positions on the 
scatter plot, providing a convenient visualization of samples which share the same genotype 
(allelic composition).  

For applications in which a highly quantitative measurement of copy number is not required, the 
Mx3000P system also offers the Plate Read/Allele Discrimination experiment type, in which 
fluorescence is monitored when cycling is complete.  
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Allele Discrimination/SNP's Real-Time Plate Setup 
In the Setup section of the software, open the Plate Setup tab. Shown below is a typical plate 
setup for Allele Discrimination/SNP's Real-Time.  

 

The Mx3000P software features several shortcuts to expedite plate setup including the ability to 
Import an existing setup, to use a Default setup, and to rapidly specify collection of data for all 
dyes in all wells by using Quick Setup. 

Plate Setup is accomplished using the selection boxes and commands on the command panel at 
the right of the screen. The command panel is designed to be followed in a top-to-bottom order, 
beginning with Well type assignment. All other selections are unavailable until after Well type 
has been assigned. 
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Select the well(s) to be assigned using the mouse then assign the well(s) by using the Well type 
menu on the command panel. The well types available in an Allele Discrimination/SNP's Real-
Time experiment are described in the table below. 

Well Type Description 
Unknown  Contains a complete reaction mixture including a test template that 

contains an  unknown amount of the specific target. 
Buffer Contains only buffer, used to monitor the background fluorescence 

attributable to the buffer. 
NAC No amplification control; contains all  reaction components except DNA 

polymerase. 
NPC No probe control; contains all reaction components except the 

fluorescence-labeled probe. 
NTC No template control; contains all reaction components except the template 

nucleic acid. 
No RT No reverse transcriptase control; contains all QRT-PCR reaction 

components except reverse transcriptase. 
Not in Use Optional designation for wells that are not in use. It is not necessary to 

define any unused wells. This well type is equivalent to an unassigned 
well. 

Dye-specific 
Negative Control 

Contains all reaction components except the template or target sequence 
detected with the specified dye. Negative control well types available 
correspond to the dyes defined in Optics Configuration. Used in 
combination with NTC wells to calculate positive and negative calls. 

Dye-specific 
Positive Control 

Contains all reaction components including template known to be positive 
for the target sequence that is detected with the specified dye. Positive 
control well types available correspond to the dyes defined in Optics 
Configuration. Used to validate the reaction mixture. 

After assigning the Well type to the selected well(s), select the dyes for which data should be 
collected in these wells using the Collect fluorescence data check boxes.  

If you are using a passive reference dye in the selected well(s) select the dye from the Reference 
dye menu. If all sample wells on the plate will contain the same passive reference dye, depress 
the All wells button. 

Assign the replicate set number to the selected well(s) by using the Replicate symbol menu. 
Instead of assigning replicate numbers to wells on an individual basis, it is also possible to assign 
replicates sequentially using the Auto-Increment feature. 

Once plate setup is complete, click Next to proceed to the Thermal Profile Setup screen. 
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Allele Discrimination/SNP's Real-Time Thermal Profile 
Setup 
When the Thermal Profile Setup tab is selected in a new Allele Discrimination/SNP's Real-Time 
experiment, a default thermal profile opens. The default thermal profile should be modified to 
the specific requirements of the new experiment, as discussed below. It is also possible to Import 
the thermal profile from an existing experiment into the new experiment. 

Shown in the figure below is the default thermal profile for an Allele Discrimination/SNP's Real-
Time experiment when using the software's Original Settings. (If you are using a user-defined 
default set, the default thermal profile stored in that default set will appear when the Thermal 
Profile Setup screen is opened. See Preferences-Defaults for more information about the use and 
management of Defaults.)   

In the profile below, segment 1 is an activation step of 95°C for 10 minutes that is compatible 
with a hot start reaction. Segment 2 consists of 40 cycles of amplification using a plateau of 
95°C/30 seconds for denaturation, followed by a plateau of 55°C/1 minute for annealing, and a 
plateau of 72°C/30 seconds for extension.  

 
Some applications use a  two-step amplification protocol instead of the three-step protocol in the 
default thermal profile. A typical two-step amplification segment consists of 40 cycles of 
amplification using a plateau of 95°C/30 seconds for denaturation, followed by a plateau of 
60°C/1 minute for annealing and extension. 
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Data are collected at the end of each annealing plateau in the default thermal profile. These 
collection settings are suitable for a typical Allele Discrimination/SNP's Real-Time experiment. 

Modify the default thermal profile as necessary. At minimum, ensure that the temperature setting 
for the annealing plateau in Segment 2 is appropriate for the PCR primer pair used in the current 
experiment. The properties of all other plateaus, ramps, and segments may also be adjusted. See 
Thermal Profile Setup in the How-To (Detailed Protocols) section for more information about 
changing the default thermal profile and data collection options. 
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Allele Discrimination/SNP's Real-Time Data Analysis 

Analysis Setup 

On the Analysis Selection/Setup screen: 

1. Select the wells to be included in the analysis. 

2. Select the data collection ramp/plateau from which data should be analyzed. 

3. Specify the desired analysis settings on the command panel.  

 

See Analysis Selection and Setup for more detailed instructions on using the features on this 
screen. 

When all selections and settings are made, click the Results tab. One of several available results 
screens will appear. Use the radio buttons under Area to analyze to navigate to different analysis 
screens. The following screens are available for Allele Discrimination/SNP's Real-Time analysis: 

Amplification Plots 
Plate Sample Values 
Dual Color Scatter Plot 
Final Call Results 
Text Report 
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Allele Discrimination/SNP's Real-Time Amplification Plots 

The Amplification Plots screen, accessed through the Results tab, shows a plot of cycles versus 
fluorescence for a ramp or plateau on which data are gathered. Select the ramp or plateau for 
which data should be analyzed using the Analysis Selection/Setup screen. 

 

Analysis Options 

Fluorescence Data Type Plotted 

Select the type of fluorescence data to be plotted from the Fluorescence menu on the command 
panel. Available fluorescence data types are: R (raw fluorescence), dR (baseline-corrected raw 
fluorescence), Rn (normalized fluorescence), and dRn (baseline-corrected normalized 
fluorescence).  

Threshold Fluorescence 

When basing plots on normalized fluorescence (dR or on dRn), the Threshold fluorescence value 
for each dye is listed on the command panel and is marked on the graph by a horizontal line. 
(Note that if a dye is hidden using the Dyes shown controls or if the check box next to the dye is 
cleared, the line corresponding to threshold fluorescence for that dye will not be shown on the 
graph.)  
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Threshold fluorescence is calculated by the Mx3000P software according to the settings provided 
in Analysis Term Settings. If desired, the threshold fluorescence may be adjusted manually. (To 
restore the software-calculated values, click Reset).  

Baseline correction is required to establish a threshold fluorescence. Thus selections related to 
threshold fluorescence are unavailable for R or Rn data plots. 

Last Cycle Setting 

The Last cycle setting specifies the cycle from which the final (last) fluorescence values will be 
reported in the Text Report and Plate Sample Values screens. The position of the last cycle is 
marked on the graph with a solid vertical line.  

This setting also affects the way Ct values are reported on other Results screens. While the Last 
cycle is not directly used to determine Ct, any wells with Ct values greater than the Last cycle 
value will be designated as No Ct in screens that display Ct. 

Excluding Well/Dye Data from Analysis 

To exclude the curve for one or more specific well/dye combinations from analysis, use either of 
the following two methods. (Disabling a particular well/dye combination requires a replicate 
treatment setting of Treat individually, specified on the Analysis Selection/Setup screen.) 

• From the list under Select amplification plots to display, select the curve(s) to be excluded 
and then click Disable Dyes.  

• Double-click on any data point on the plot to be excluded. This action will exclude the 
entire data set for the well/dye corresponding to the plot. 

To restore a plot that was disabled using either of these methods, go to the Analysis 
Selection/Setup screen, click on Exclude Dyes, and then press the button corresponding to the 
specific dye/well combination, restoring the button to a depressed state. 

Display Options 

To restrict the plots shown to a subset of the selected well/dye combinations, use the Select 
amplification plots to display list near the bottom of the command panel. You may display a 
single plot or any subset of plots by selecting the desired plots from the list. (While selecting 
plots with the mouse, use the Shift key to select a contiguous group or the Ctrl key to select a 
non-contiguous group.)  

To display information about a specific data point on the plots, place the cursor over the point of 
interest. (Note that Display tooltips must be selected on the Display tab of the Preferences dialog 
box in order for the well information to be displayed.) 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including whether the Legend and Plot Markers are displayed or hidden. See 
Graphs and Graph Properties for more information. 
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Allele Discrimination/SNP's Real-Time Plate Sample Values 

The Plate Sample Values screen displays Fluorescence values or Ct values for the sampled wells 
in a plate format. 

In each well with a well type assigned, the following information is shown:  
• Well type 
• Either the fluorescence or the Ct value for each dye for which data was collected 
• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 

underlined) 
 

 

Analysis Options 

Display the Values for Fluorescence or Ct 

Under Display the values for, specify the form of the data to be displayed by selecting either the 
Fluorescence or the Ct using radio button. For either of these options, you will need to specify the 
type of fluorescence data to be used in the analysis by selecting a data type from the menu below 
the selected radio button. Refer to the tables below for descriptions of the fluorescence data type 
abbreviations in the menus. 
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When displaying Fluorescence values, the following fluorescence data types are available:  
Data Type How Calculated 

R Last final fluorescence 
dR Last final fluorescence minus the initial fluorescence 
Rn Last normalized final fluorescence 
dRn Last normalized final fluorescence minus the normalized initial 

fluorescence 
R Last/R First final fluorescence divided by the initial fluorescence 
 

When displaying Ct values, Ct calculations may be based on the following fluorescence data 
types:  
Data Type How Calculated 

dR baseline-corrected fluorescence 
dRn baseline-corrected normalized fluorescence 

 

Last Cycle 

The Last cycle setting specifies the cycle from which the fluorescence values will be reported. By 
default, the cycle shown is the last cycle of the ramp or plateau being analyzed.  

The Last Cycle setting also affects the reporting of Ct. Any wells having Ct values greater than 
the Last cycle value will be reported as No Ct. 
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Allele Discrimination/SNP's Real-Time Dual Color Scatter Plot 

The Dual Color Scatter Plot screen is useful to compare the amplification properties of two 
different targets (represented by two different dyes) in the same well. This form of analysis is 
especially useful for allele discrimination experiments, where the quantity of each of two 
possible alleles is indicated by a different dye.   

Each plotted point represents the coordinates of either the fluorescence values or threshold cycle 
(Ct) values for the two dyes in a single well. For example, the X-axis may correspond to TET Ct 
while the Y-axis corresponds to FAM Ct and the plotted point (x,y) corresponds to the 
coordinates describing the two Ct values determined for a given well. The position of the data 
point for a given well on the scatter plot indicates the presence or absence of each allele. Colored 
rectangles on the plot are used to group wells with a common genotype (allelic composition). 
The shapes of the genotype-marking rectangles may be changed, and individual data points may 
also be excluded from the genotype group. The two alleles may be named on this screen, with 
the user-provided allele names reflected in the genotype descriptions of the wells on this and 
other Results screens. 
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Analysis Options 

Last Cycle Setting 

 

The Last cycle setting specifies the cycle from which the fluorescence values will be plotted if 
Fluorescence is selected under Display the values for. By default, the cycle shown is the last cycle 
of the ramp or plateau being analyzed.  

This setting also affects the way Ct values are reported on this and other Results screens. While 
the Last cycle is not directly used to determine Ct, any wells with Ct values greater than the Last 
cycle value will be plotted with a Ct value corresponding to the last cycle for which data was 
collected. The same wells will be designated as No Ct in screens that display Ct values. 

Plot the Values for Fluorescence or Ct 

Under Display the values for, specify the form of the data to be plotted by selecting either the 
Fluorescence or the Ct using radio button. For either of these options, you will need to specify the 
type of fluorescence data to be used in the analysis from the menu below the selected radio 
button. Refer to the tables below for descriptions of the fluorescence data type abbreviations in 
the menus. 

 

When plotting Fluorescence values, the following fluorescence data types are available:  
Data Type How Calculated 

R Last final fluorescence 
dR Last final fluorescence minus the initial fluorescence 
Rn Last normalized final fluorescence 
dRn Last normalized final fluorescence minus the normalized initial 

fluorescence 
R Last/R First final fluorescence divided by the initial fluorescence 
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When plotting Ct values, Ct calculations may be based on the following fluorescence data types:  
Data Type How Calculated 

dR baseline-corrected fluorescence 
dRn baseline-corrected normalized fluorescence 

Note that if no reference dye has been assigned to the wells and dRn, Rn Last or dRn Last is 
selected, a message like the following will appear below the graph: 

 

Allele Associations 

The Allele associations section of the command panel is used to identify the association between 
each of the plotted dyes and the allele detected by the dye. The allele/dye specified in the top 
menu will be plotted on the X axis, and the allele/dye specified in the bottom menu will be 
plotted on the Y axis. Any two dyes assigned during Plate Setup may be selected in these menus. 

 

By default, alleles are named Allele A and Allele B. The allele names also correspond to the 
genotypes assigned to wells in which a single allele is detected. Both is the default name for the 
genotype group in which both alleles are detected. Each of these allele/genotype names may be 
changed to user-specified names by clicking Rename Alleles/Genotypes. When the following 
dialog box appears, enter the desired allele/genotype names and then click OK.  

 

The new allele names will appear in the Allele associations section of the command panel. The 
specified allele or genotype names are also displayed on some other Results screens. 
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Display Options 

Display of Genotype Groups on the Scatter Plot 

Wells with a common genotype (allelic composition) are grouped on the scatter plot in color-
coded rectangles. The genotype corresponding to each group is indicated in the graph legend (see 
Graph Properties below). If a single allele was detected in a well, the genotype designation 
corresponds to the allele name. If both alleles were detected, the genotype is designated Both by 
default; this designation may be changed by clicking Rename Alleles/Genotypes on the command 
panel. If neither allele was detected, the genotype is designated None.  

The size and shape of each rectangle may be changed by dragging any side of the rectangle with 
the mouse. The color of the rectangle and the enclosed group of data points may be changed for 
any genotype by double-clicking on the genotype’s entry in the legend. 

Note  The size and shape of a rectangle does not convey information about dye intensity, data 
quality, or any other measured data attribute. The rectangles are only intended to identify 
and group the data points which fit the positive/negative calling result criteria that define 
each genotype. 

Any well may be manually excluded from the genotype groups by double-clicking on the data 
point for the well. The following dialog box will appear.  

 

Once Yes is selected, the symbol for the affected data point will change to the color and point 
style assigned to excluded data points. In addition, the Genotype for the well will change in the 
Text Report. 

To restore any manually removed data points to their original genotype assignments, click Reset 
Genotypes on the command panel.  

 

Graph Properties 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including whether the legend is shown or hidden and the attributes of the axes. 
See Graphs and Graph Properties for more information. 

To display information about a specific data point on the scatter plot, place the cursor over the 
point of interest. (Note that Display tooltips must be selected on the Display tab of the Preferences 
dialog box in order for the well information to be displayed.) 
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Allele Discrimination/SNP's Real-Time Final Call Results 

The Final Call Results screen provides a simple depiction of whether product was accumulated 
for each dye in each well in a plate format. A plus sign (+) signifies accumulation of product for 
the indicated dye, while a minus sign (–) signifies that product accumulation was not detected. 
Calling is based on Ct, where + is returned if the Ct is less than the last cycle for which data was 
collected and – is returned if the Ct is equal to the last cycle for which data was collected, 
indicating that the threshold fluorescence value was not attained during amplification. 

In each well with a well type assigned, the following information is shown:  
• Well type 
• The final call for each dye for which data was collected. [For all well types, the reference 

dye (Ref) is not associated with a final call] 
• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 

underlined) 
The allele associated with each dye is shown under Allele associations on the command panel. 
Allele names may be changed on the Dual color scatter plot screen. 
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Analysis Options 

Fluorescence Data Type for Ct Determinations 

Select the type of fluorescence data to be used to calculate the Ct values to be used for 
interpolation from the Results based on Ct calculated from menu on the command panel. 
Available fluorescence data types are: dR (baseline-corrected raw fluorescence), and dRn 
(baseline-corrected normalized fluorescence). If dRn is selected, but no reference dye was 
assigned during Plate Setup, the final call result will be replaced with the error indicator of No 
Ref. 

Effect of Threshold Fluorescence 

Positive and negative calls are based on threshold cycle (Ct), the cycle at which the fluorescence 
signal first exceeds or equals the threshold fluorescence for the experiment. The settings that 
determine how threshold fluorescence is calculated may be accessed and adjusted on the 
Threshold Fluorescence tabbed page of the Analysis Term Settings dialog box. Threshold 
fluorescence may also be adjusted manually. 
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Allele Discrimination/SNP's Real-Time Text Report 
The Text Report screen shows the data from a run in text format.  

 

Analysis Options 

Last Cycle 

The Last cycle setting specifies the cycle from which the fluorescence values will be reported 
when fluorescence value columns (such as dRn Last) are selected for display. By default, the 
cycle shown is the last cycle of the ramp or plateau being analyzed.  

 

The Last cycle setting also affects the reporting of Ct and the Final Call. Wells having Ct values 
greater than the Last cycle value will be reported as No Ct and will be called as negative (–). 
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Ct and Final Call Based On 

Select the type of fluorescence data that the reported Ct and Final Call should be based on from 
the Ct and final call based on menu on the command panel. Available fluorescence data types 
are: dR (baseline-corrected fluorescence) and dRn (baseline-corrected normalized fluorescence).  

 
Display Options 

Columns Included in the Report 

Select the Columns to be included in the text report by checking the boxes next to the column 
names. To exclude columns that are selected by default, click on the check box to deselect the 
column name. To select all columns to display, click Select All. The default settings for column 
selection can be restored by expanding the Defaults menu and then clicking Get. 

If the included columns will not fit in the screen, a horizontal scroll bar appears at the bottom of 
the window to allow horizontal scrolling. 

 
Column Width 

To facilitate viewing data, columns can be automatically sized. Clicking the Contents Only 
button will cause each column to be automatically resized to the width of the widest data cell in 
that column (some column headers may be only partially displayed using this setting). Clicking 
the Hdr & Contents button will cause each column to be resized to the widest cell in that column, 
including the header cell. 

Columns can also be resized manually by dragging the column dividers with the mouse.  
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Exporting Text Report Data 

Text report data can be exported from the application in text, Microsoft Excel spreadsheet or 
XML format for analysis. Text report exporting options are available from the File menu. See 
Exporting Data to Other Applications in the File Menu section for more information. 
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Mx3000P System Experiments: 
Molecular Beacon Melting Curve 
The Molecular Beacon Melting Curve  Experiment 
Type 
After a molecular beacon is manufactured, its melting characteristics are verified by melting 
curve analysis to determine the molecular beacon's target specificity, experimental melting 
temperature (Tm), and the appropriate annealing temperature for subsequent PCR experiments. 
Melting curves are typically performed with the molecular beacon alone (MB) and in the presence 
of either a perfectly-matched (MBO) or a mismatched (MBMO) oligonucleotide target in order to 
determine the temperature that results in maximum specificity. 

A melting curve displays the fluorescence of the molecular beacon at various temperatures in the 
presence or absence of the diagnostic single-stranded oligonucleotide targets. At high 
temperatures, the molecular beacon will assume an unstructured conformation and will fluoresce. 
In the absence of the single-stranded oligonucleotide target, as the temperature decreases the 
molecular beacon will assume a hairpin conformation, and fluorescence will be quenched. The 
temperature at which half-maximum fluorescence is obtained gives the Tm for that molecular 
beacon. 

In the presence of either single-stranded oligonucleotide, as temperature decreases the molecular 
beacon will hybridize to the target, physically separating the fluorophore and quencher, and 
allowing fluorescence. At higher temperatures in the curve, the perfectly matched 
oligonucleotide (Well type of MBO) is expected to demonstrate greater binding (and therefore 
greater fluorescence) compared to the mismatched oligonucleotide (Well type of MBMO). The 
temperature window displaying a significant difference in Fluorescence between the MBO and 
MBMO wells represents the range of acceptable annealing temperatures to achieve discrimination 
between the two target oligonucleotides. 

Selecting the Optimal Annealing Temperature 

An annealing temperature should be chosen at which the molecular beacon will bind efficiently 
to its complementary target, and at which the molecular beacon will adopt a stem-loop 
conformation when unbound to target. For allele discrimination or other assays requiring 
specificity, the annealing temperature should be chosen according to the temperature at which 
the molecular beacon binds to its completely complementary target but binds minimally to a 
mismatched target. 
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The figure below illustrates a typical molecular beacon melting profile performed in the 
development of an allele discrimination assay. Three melting curves are shown: molecular 
beacon alone (MB) (blue curve), molecular beacon plus its complementary single stranded 
oligonucleotide target (MBO) (red curve), and molecular beacon plus a single stranded 
oligonucleotide target containing a single mismatch (MBMO) (green curve). To ensure PCR assay 
specificity in discrimination, an annealing temperature at which the molecular beacon will bind 
to its completely complementary target but not to a mismatched target should be chosen. In this 
example, an annealing temperature of 60°C will provide low background fluorescence, high 
fluorescence when the perfectly matched target is present and low fluorescence when a target 
containing a single mismatch is present.  
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Molecular Beacon Melting Curve Plate Setup 
In the Setup section of the software, open the Plate Setup tab. Shown below is a typical Molecular 
Beacon Melting Curve plate setup. In this example, the melting curve for a single molecular 
beacon labeled with TET is analyzed. 

 

The Mx3000P software features several shortcuts to expedite plate setup including the ability to 
Import an existing setup, to use a Default setup, and to rapidly specify collection of data for all 
dyes in all wells by using Quick Setup. 

Plate Setup is accomplished using the selection boxes and commands on the command panel at 
the right of the screen. The command panel is designed to be followed in a top-to-bottom order, 
beginning with Well type assignment. All other selections are unavailable until after Well type 
has been assigned. 
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Select the well(s) to be assigned using the mouse then assign the well(s) by using the Well type 
menu on the command panel. The well types available in a Molecular Beacon Melting Curve 
experiment are described in the table below. 

 
Well Type Description 
MBO Contains the molecular beacon plus its perfectly matched oligonucleotide. 
MB Contains the molecular beacon only. 
MBMO Contains the molecular beacon plus a single-base mismatched oligonucleotide. 
Not in Use Optional designation for wells that are not in use. It is not necessary to define any 

unused wells. This well type is equivalent to an unassigned well. 

 

The Active dye menu is used to specify which dye will be displayed in the Analysis screens. If the 
experiment is analyzing the melting curve for more than one molecular beacon, select the dye 
corresponding to the molecular beacon that you want to analyze first. After the experiment has 
been run, the Active dye assignment may be changed in this menu to allow analysis of the other 
molecular beacons labeled with other dyes.  

Select the dye(s) for which data should be collected for the selected wells using the Collect 
fluorescence data check boxes. Typically, only the dye(s) used to label the molecular beacon(s) 
will have data collected. 

Assign replicate set numbers to selected well(s) by using the Replicate symbol menu. Instead of 
assigning replicate numbers to wells on an individual basis, it is also possible to assign replicates 
sequentially using the Auto-Increment feature. 

Once plate setup is complete, click Next to proceed to the Thermal Profile Setup screen. 
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Molecular Beacon Melting Curve Thermal Profile 
Setup 
When the Thermal Profile Setup tab is selected in a new Molecular Beacon Melting Curve 
experiment, a default thermal profile opens. The default thermal profile should be modified to 
the specific requirements of the new experiment, as discussed below. It is also possible to Import 
the thermal profile from an existing experiment into the new experiment. 

Shown in the figure below is the default thermal profile for a Molecular Beacon Melting Curve 
when using the software's Original Settings. (If you are using a user-defined default set, the 
default thermal profile stored in that default set will appear when the Thermal Profile Setup 
screen is opened. See Preferences-Defaults for more information about the use and management 
of Defaults.)     

Segment 1 contains a plateau of  95°C for 3 minutes, which is used to denature the molecular 
beacon prior to the melting curve. The melting curve, in Segment 2, consists of 56 successive  
1-minute plateaus in which the temperature is decreased by 1.0°C for each plateau (from 80°C to 
25°C). This cycle-by-cycle decrease in temperature is indicated by the downward pointing arrow 
adjacent to the data collection marker for this plateau. 

 
Data are collected throughout each plateau during the melting curve (Segment 2) in the default 
thermal profile. These settings are suitable for a typical Molecular Beacon Melting Curve. 

If necessary, modify the default thermal profile according to the specific requirements of the 
current experiment. The properties of any of the plateaus, ramps, and segments may be adjusted. 
See Thermal Profile Setup in the How-To (Detailed Protocols) section for more information 
about changing the default thermal profile and data collection options. 
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Molecular Beacon Melting Curve Data Analysis 

Analysis Setup 

If more than one molecular beacon was assayed in the experiment, navigate to the Plate Setup 
screen and select the dye to be analyzed from the Active Dye menu.  

 

On the Analysis Selection/Setup screen: 

1. Select the wells to be included in the analysis. 

2. Select the data collection ramp/plateau from which data should be analyzed. 

3. Specify the desired analysis settings on the command panel. For Molecular Beacon 
Melting Curve experiments, the only analysis settings that are available are Replicates 
(controlling replicate treatment) and Adv. Algorithm Settings (controlling the statistical 
basis for reporting read data). The remainder of the settings on the command panel 
concern analysis of amplification data only. 
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See Analysis Selection/Setup for more detailed instructions on using the features on this screen. 

When all selections and settings are made, click the Results tab. One of two available results 
screens will appear. Use the radio buttons under Area to analyze to navigate between analysis 
screens. The following screens are available for Molecular Beacon Melting Curve analysis: 

Molecular Beacon Melting Curve Annealing Range 

Molecular Beacon Melting Curves/Temperature 
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Molecular Beacon Melting Curve Annealing Range 

The Annealing Range screen displays the optimal annealing range for the beacon(s) tested. The 
optimal range is the temperature range in which the molecular beacon plus perfectly-matched 
oligo (MBO) has a greater fluorescence than the beacon plus mismatched oligo (MBMO) and in 
which the background fluorescence is low. 

The Suggested Annealing Temperature Range, calculated using the algorithm described below, is 
reported on the command panel at the right of the screen, and is indicated on the plot by two 
vertical lines. 
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Suggested Annealing Temperature Range Calculations 

The Mx3000P system software uses the algorithm below to calculate the annealing temperature 
range. 
Note  The annealing temperature algorithm does not incorporate data points collected below 

40°C or above 85°C. 
Suggested Minimum Annealing Temperature 

1. The minimum fluorescence value of the MBMO melting curve (green curve in the plot 
above) is determined. 

2. The temperature at this minimum MBMO fluorescence value is determined. 

3. The difference between the MBO (red curve in the plot above) and the MBMO curve 
fluorescence values at the temperature corresponding to the MBMO minimum is 
calculated. 

4. 10% of the difference between the MBO and the MBMO fluorescence values (MBO 
value minus MBMO value) is added to the MBMO minimum fluorescence value. 

5. This adjusted fluorescence value corresponds to two temperatures on the MBMO curve. 
The lower of these two temperatures is the minimum temperature of the Suggested 
Annealing Temperature Range.  

Suggested Maximum Annealing Temperature 

1. Following steps 1–3 above, the difference between the MBO curve (red curve above) and 
the MBMO (green curve above) fluorescence values at the temperature corresponding to 
the MBMO minimum is calculated. 

2. 60% of the difference between the MBO and the MBMO fluorescence values is added to 
the MBMO minimum fluorescence value. 

3. This adjusted fluorescence value corresponds to one temperature on the MBO curve. This 
is the maximum temperature of the Suggested Annealing Temperature Range. 
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Molecular Beacons Melting Curve Melting 
Curves/Temperature 

The Melting Curves/Temperature screen calculates and displays the melting temperature for the 
beacon(s) tested. 
The Melting Temperature, calculated using the algorithm described below, is reported on the 
command panel at the right of the screen, and is indicated on the plot by a vertical line. 

 

Calculating the Suggested Melting Temperature 

The Mx3000P system software uses the algorithm below to calculate the melting temperature. 

1. The range of fluorescence of the MBO curve (red curve in the plot above) is calculated. 

2. The value from step 1 is multiplied by 0.5. 

3. The resulting value is added to the MBO curve minimum fluorescence value. 

4. The temperature at which the fluorescence value of the MBO curve equals the result of 
step3 is the reported Melting Temperature. 
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Mx3000P System Experiments: 
Quantitative Plate Read 
The Quantitative Plate Read Experiment Type 
The Quantitative Plate Read experiment type uses a standard curve to estimate the amount of 
target present in an Unknown sample using a fluorescence-labeled probe or SYBR Green dye for 
detection. A series of Standard samples, containing dilutions of a known amount of target, are 
included in the experiment to generate a Standard Curve that relates the quantity of the specific 
target to the final fluorescence reading. The standard curve is then used to estimate the template 
quantity in Unknown wells based on the fluorescence reading for each well. 

In contrast to the Mx3000P system's real-time Quantitative PCR experiment type, which uses 
threshold cycle (Ct) values to calculate initial quantities, Quantitative Plate Read experiments use 
only endpoint fluorescence values for calculating the initial quantities in Unknowns. Thus, 
although this experiment type reports Initial template quantity on analysis screens, the plate read 
measurements are taken at a phase in PCR amplification where the amplification efficiency can 
be influenced by limiting reagents and other spurious factors and this form of analysis should not 
be assumed to provide an accurate quantification of starting copy number of a target sequence.  
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Quantitative Plate Read Plate Setup 
In the Setup section of the software, open the Plate Setup tab. Shown below is a typical plate 
setup for Quantitative Plate Read.  

 

The Mx3000P software features several shortcuts to expedite plate setup including the ability to 
Import an existing setup, to use a Default setup, and to rapidly specify collection of data for all 
dyes in all wells by using Quick Setup. 

Note  In order for the Mx3000P software to calculate p-values for positive or negative calling 
in Unknown wells, the Quantitative Plate Read experiment must include at least three NTC 
or dye-specific negative control wells for each dye. 

Plate Setup is accomplished using the selection boxes and commands on the command panel at 
the right of the screen. The command panel is designed to be followed in a top-to-bottom order, 
beginning with Well type assignment. All other selections are unavailable until after Well type 
has been assigned. 
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Select the well(s) to be assigned using the mouse then assign the well(s) by using the Well type 
menu on the command panel. The well types available in a Quantitative Plate Read experiment 
are described in the table below. 

 
Well Type Description 
Unknown  Contains a complete reaction mixture including a test template that contains 

an  unknown amount of the specific target. 
Buffer Contains only buffer, used to monitor the background fluorescence 

attributable to the buffer. 
NAC No amplification control; contains all  reaction components except DNA 

polymerase. 
NPC No probe control; contains all reaction components except the fluorescence-

labeled probe. 
NTC No template control; contains all reaction components except the template 

nucleic acid. 
Standard Contains a complete reaction mixture including a known concentration of 

target nucleic acid. Used to generate a standard curve, which is then used to 
relate fluorescence to initial template quantity in Unknown wells. 

No RT No reverse transcriptase control; contains all QRT-PCR reaction 
components except reverse transcriptase. 

Not in Use Optional designation for wells that are not in use. It is not necessary to 
define any unused wells. This well type is equivalent to an unassigned well. 

Dye-specific 
Negative Control 

Contains all reaction components except the template or target sequence 
detected with the specified dye. Negative control well types available 
correspond to the dyes defined in Optics Configuration. This well type 
assignment is rarely used in Quantitative Plate Read experiments.  

Dye-specific 
Positive Control 

Contains all reaction components including template known to be positive 
for the target sequence that is detected with the specified dye. Positive 
control well types available correspond to the dyes defined in Optics 
Configuration. This well type assignment, which qualitatively designates a 
positive signal for the target without specifying the absolute amount, is 
rarely used in Quantitative Plate Read experiments. 

 

After assigning the Well type to the selected well(s), select the dyes for which data should be 
collected in the wells using the Collect fluorescence data check boxes.  

If you are using a passive reference dye in the selected well(s) select the dye from the Reference 
dye menu. If all sample wells on the plate will contain the same passive reference dye, depress 
the All wells button. 

Mx3000P™ Real-Time PCR System 245 



Mx3000P System Experiments 

If the selected well(s) is a Standard, for each dye for which standard curve data will be collected, 
enter the amount of template. To do this, first select the dye from the pulldown menu following 
Standard quantity. Next, enter the quantity of template added to the selected well(s) as a decimal 
number (for example, 400 or 1.234). Specify the units for the quantity in the Standard units 
menu. Instead of assigning quantities to wells on an individual basis, it is also possible to assign 
quantities to Standard wells sequentially using the Auto-Increment feature. 

Assign the replicate set number to the selected well(s) by using the Replicate symbol menu. 
Instead of assigning replicate numbers to wells on an individual basis, it is also possible to assign 
replicates sequentially using the Auto-Increment feature. 

To run the experiment, set the read properties and then click Start Run to initiate the run. 
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Quantitative Plate Read Data Analysis 
Analysis Setup 
On the Analysis Selection/Setup screen: 

1. Select the wells to be included in the analysis. 
2. Specify the desired analysis settings on the command panel. (Algorithm Enhancements 

apply only to real-time experiments and the settings in this section are unavailable for 
plate read experiments.) 

 
See Analysis Selection/Setup for more detailed instructions on using the features on this screen. 

When all selections and settings are made, click the Results tab. One of several available results 
screens will appear. Use the radio buttons under Area to analyze to navigate to different analysis 
screens. The following screens are available for Quantitative Plate Read analysis: 
Plate Sample Values 
Standard Curve 
Initial Template Quantity 
Dual Color Scatter Plot 
Fluorescence Intensity Values 
Final Call Results 
Text Report 
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Quantitative Plate Read Plate Sample Values 

The Plate Sample Values screen displays fluorescence values for the sampled wells in a plate 
format. 

In each well with a well type assigned, the following information is shown:  
• Well type 
• Fluorescence value for each dye for which data was collected 
• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 

underlined) 
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Analysis Options 

Select the type of fluorescence data to be displayed from the Fluorescence menu on the command 
panel. Available fluorescence data types are:  

 
Data Type How Calculated 

Rpre initial fluorescence (use also for single reading initiated with Pre-Read) 
Rpost final fluorescence (use also for single reading initiated with Post-Read) 
Rn,pre normalized initial fluorescence (use also for single reading initiated with Pre-

Read)  
Rn,post normalized final fluorescence (use also for single reading initiated with Post-

Read) 
Rpost–Rpre total change in fluorescence (final fluorescence minus initial fluorescence) 
Rn,post–Rn,pre total change in normalized fluorescence (normalized final fluorescence minus 

normalized initial fluorescence) 
Rpost/Rpre fold-change in fluorescence (final fluorescence divided by initial fluorescence) 
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Quantitative Plate Read Standard Curve 

The Standard Curve is a plot of the initial template quantity in the Standard wells (X-axis), 
versus Fluorescence. A least mean squares curve fitting algorithm is used to generate the standard 
curves displayed. Curves are displayed for each dye for which data was collected in Standard 
wells. Unknown wells selected during Analysis Selection/Setup are also plotted on the standard 
curve (using a different data point marker) based on their measured Fluorescence values. 

If less than two Standard wells were selected in Analysis Selection/Setup, no data will be plotted 
on this chart. 

 

Analysis Options 

Fluorescence Data Type 

Select the type of fluorescence data to be plotted from the Fluorescence menu on the command 
panel. Available fluorescence data types are:  
Data Type How Calculated 

Rpre initial fluorescence (use also for single reading initiated with Pre-Read) 
Rpost final fluorescence (use also for single reading initiated with Post-Read) 
Rn,pre normalized initial fluorescence (use also for single reading initiated with Pre-Read)
Rn,post normalized final fluorescence (use also for single reading initiated with Post-Read)
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Confidence Interval 

The confidence interval for each standard curve may be displayed by selecting the Show 
confidence interval checkbox. The resulting graph shows the confidence limits as hashed lines. 
The lines show the range of Initial Quantity values at a particular Fluorescence that cannot be 
statistically distinguished from the fit line with more certainty than the confidence level (Level %) 
selected. The width of the confidence interval is an indicator of the quality of the fit of the data to 
the standard curve. Confidence interval calculations require a Replicates setting of Treat 
individually. Confidence level values may be exported to an Excel file, a text file or an XML file 
by using the Export Chart Data commands on the File menu.  

 
Display Options 

To display information about a specific data point on the plot, place the cursor over the point of 
interest to display the following information: the well location, the well type, the dye associated 
with the well, the initial template quantity and the fluorescence. If the well is a Standard, the 
initial template quantity is the amount assigned to the well during plate setup. If the well is an 
Unknown, the initial template quantity is the interpolated amount based on the standard curve.   

Note  If Display tooltips is cleared (deselected) on the Display tab of the Preferences dialog box, 
this well information will not be displayed. 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including whether the Legend is displayed or hidden. See Graphs and Graph 
Properties for more information. 

To exclude a specific well/dye data point, double click on the data point on the chart. (Disabling 
a particular well/dye combination requires a replicate treatment setting of Treat individually, 
specified on the Analysis Selection/Setup screen). To restore an excluded data point, go to the 
Analysis Selection/Setup screen, click on Exclude Dyes, and then press the button corresponding 
to the specific dye/well combination, restoring the button to a depressed state. 
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Interpretation and Use of Curve Attributes 

The graph legend displays information about each curve plotted. (If no legend is displayed on the 
screen, open the Graph Properties dialog box by double-clicking on the graph, and then select the 
On radio button under Legend.) Besides correlating plot markers with dyes and well types, the 
legend displays the R Squared (RSq) value and the equation for the line (y = mx + b).  

  

The RSq value is an indication or the quality of the fit of the standard curve to the Standard data 
points plotted. The value will always be between 0 and 1. The closer the value is to 1, the better 
the fit of the line.  

Using the Initial Template Quantity Calculator 

To use the displayed standard curve to calculate an interpolated quantity of template in another 
sample from the run based on the fluorescence reading, choose the dye from the Select dye menu, 
then enter the fluorescence value. The software will calculate and display the interpolated initial 
template quantity (Interpolated qty). Note that initial template quantities are automatically 
determined, based on the standard curves, for all Unknowns in the same experiment, and these 
results may be viewed on the Initial Template Quantity results screen. 

 

Mx3000P™ Real-Time PCR System 252 



Mx3000P System Experiments 

Quantitative Plate Read Initial Template Quantity 

The Initial Template Quantity screen displays interpolated quantities of template added to 
Unknown wells before thermal cycling in a plate format. 

In each well with a well type assigned, the following information is shown:  
• Well type 
• Initial template quantity (for Unknowns, the value interpolated from the standard curve 

based on the fluorescence measured for the Unknown; for Standards, the amounts entered 
during plate setup) 

• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 
underlined) 

If less than two Standard wells were selected in Analysis Selection/Setup, a standard curve cannot 
be plotted and an error message will appear in place of results in the Unknown wells. 
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Analysis Options 

Fluorescence Data Type 

Select the type of fluorescence data to be used for interpolation from the Fluorescence menu on 
the command panel. Available fluorescence data types are:  

 
Data Type How Calculated 

Rpre initial fluorescence (use also for single reading initiated with Pre-Read) 
Rpost final fluorescence (use also for single reading initiated with Post-Read) 
Rn,pre normalized initial fluorescence (use also for single reading initiated with 

Pre-Read) 
Rn,post normalized final fluorescence (use also for single reading initiated with 

Post-Read) 
Rpost–Rpre total change in fluorescence (final fluorescence minus initial 

fluorescence) 
Rn,post–Rn,pre total change in normalized fluorescence (normalized final fluorescence 

minus normalized initial fluorescence) 
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Quantitative Plate Read Dual Color Scatter Plot 

The Dual Color Scatter Plot screen is useful to compare the final quantities of two different 
targets (represented by two different dyes) in the same well.  

Each plotted point represents the coordinates of the fluorescence values for two dyes in a single 
well. For example, the X-axis may correspond to FAM fluorescence while the Y-axis 
corresponds to TET fluorescence and the plotted point (x,y) corresponds to the coordinates 
describing the two fluorescence values determined for a given well.  

 
 

Analysis Options 

Dye Selection 

Specify the dye for which data should be plotted on each axis by selecting the dyes of interest 
from the X axis and Y axis menus on the command panel. Any two dyes assigned during Plate 
Setup may be specified.  
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A well will not be included in the scatter plot if the two dyes selected for the plot are not 
assigned to that well. An error message similar to the example shown below will appear if wells 
selected during Analysis Selection/Setup cannot be displayed. 

 

Fluorescence Data Type Plotted 

Select the type of fluorescence data to be plotted from the Fluorescence menu on the command 
panel. Available fluorescence data types are:  

Data Type How Calculated 

Rpre initial fluorescence (use also for single reading initiated with Pre-Read) 
Rpost final fluorescence (use also for single reading initiated with Post-Read) 
Rn,pre normalized initial fluorescence (use also for single reading initiated with 

Pre-Read) 
Rn,post normalized final fluorescence (use also for single reading initiated with 

Post-Read) 
Rpost–Rpre total change in fluorescence (final fluorescence minus initial 

fluorescence) 
Rn,post–Rn,pre total change in normalized fluorescence (normalized final fluorescence 

minus normalized initial fluorescence) 
Rpost/Rpre fold-change in fluorescence (final fluorescence divided by initial 

fluorescence) 
 

Note that if no reference dye has been assigned to the wells and a normalized data type (Rn) is 
selected, a message like the following will appear below the graph: 

 

 

Display Options 

To display information about a specific data point on the scatter plot, place the cursor over the 
point of interest. (Note that Display tooltips must be selected on the Display tab of the Preferences 
dialog box in order for the well information to be displayed.) 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including the attributes of the axes. See Graphs and Graph Properties for more 
information. 

Mx3000P™ Real-Time PCR System 256 



Mx3000P System Experiments 

Quantitative Plate Read Fluorescence Intensity Values 

The Fluorescence Intensity Values screen displays a colorized image of final calls and 
fluorescence intensities. A plus sign (+) indicates a positive call and a minus sign (–) indicates a 
negative call. 

A spectrum of colors, displayed at the bottom of the screen, is used to indicate the relative 
fluorescence readings for each dye in each well. 

 The circle for each well is divided into arcs which correspond to the dyes selected for analysis in 
the Analysis Selection/Setup screen.  An R in a portion of the circle indicates that portion refers to 
a reference dye. The replicate set number, if any, appears in the lower right corner of the well. 

 

Interpreting the Intensity Values Display 

The accumulation of product can be interpolated by comparing the color in the arc to the 
horizontal color bar at the bottom of the screen. On the color bar, as fluorescence values 
increase, the corresponding color shifts from blue towards red. Note that the bar only covers the 
fluorescence range measured on the plate. For example, in the example shown above, the range 
of fluorescence measured in the run was between 2202 and 4699, and this is the range that is 
covered by the color bar. 
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Interpreting Final Calls 

The p-value is the probability that the mean of one set of sample data is different from the mean 
of another set of sample data. The first set of sample data is always the control wells in the 
analysis selection. When replicates are being treated individually, the second set of sample data 
consists of a single well (usually an Unknown well). When replicates are being treated 
collectively, the second set of sample data consists of all of the replicates. If the p-value exceeds 
the user-specified confidence level, the well/dye is called as positive and signified with a plus 
sign (+); otherwise, the well is called as negative (no difference detected) and signified with a 
minus sign (–). The confidence level for positive calling is displayed on the command panel. 
This value may be changed using the Analysis Term Settings dialog box that may be accessed by 
clicking the corresponding button on the Analysis Selection/Setup screen. 

Analysis Options 

Fluorescence Data Type Displayed and Used for Calculations 

Under p-values and final calls based on, specify the form of the fluorescence data to be 
displayed and used in calculating the p-values used for making final calls.  

 

Available fluorescence data types are:  

Data Type How Calculated 

Rpre initial fluorescence (use also for single reading initiated with Pre-Read) 
Rpost final fluorescence (use also for single reading initiated with Post-Read) 
Rn,pre normalized initial fluorescence (use also for single reading initiated with 

Pre-Read) 
Rn,post normalized final fluorescence (use also for single reading initiated with 

Post-Read) 
Rpost–Rpre total change in fluorescence (final fluorescence minus initial fluorescence) 
Rn,post–Rn,pre total change in normalized fluorescence (normalized final fluorescence 

minus normalized initial fluorescence) 
Rpost/Rpre fold-change in fluorescence (final fluorescence divided by initial 

fluorescence) 

 

Mx3000P™ Real-Time PCR System 258 



Mx3000P System Experiments 

Display Options 

Adjusting the Fluorescence Intensity Range 

The range of fluorescence intensity covered by the color spectrum can be manually specified by 
clicking the Edit False Color Limits button to open the False Color Limits dialog box.  

The minimum value for the Low Fluorescence Limit is 0 and the maximum value for the High 
Fluorescence Limit is 65535. A range of at least 4 must be specified. Manually specifying a 
narrow range of values is helpful when attempting to discern small differences in fluorescence 
values among samples. 

 

False Colors Versus Grayscale 

By default, the Mx3000P software uses a multi-hued spectrum of colors to depict differences in 
fluorescence values on this screen. The depiction may be changed to grayscale by deselecting the 
Use false colors checkbox. All colors will turn to shades of gray and the color bar will display a 
gradient of gray from black (lowest fluorescence) to white (highest fluorescence). 
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Quantitative Plate Read Final Call Results 

The Final Call Results screen provides a simple depiction of whether product was accumulated 
for each dye in each well in a plate format. A plus sign (+) signifies detection of product 
accumulation for the indicated dye, while a minus sign (–) signifies that product accumulation 
was not detected. See below for more information on how final calls are made.  

In each well with a well type assigned, the following information is shown:  
• Well type 
• The final call for each dye for which data was collected. [For all well types, the reference 

dye (Ref) is not associated with a final call] 
• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 

underlined) 
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Interpreting Final Calls 

The p-value is the probability that the mean of one set of sample data is different from the mean 
of another set of sample data. The first set of sample data is always the control wells in the 
analysis selection. When replicates are being treated individually, the second set of sample data 
consists of a single well (usually an Unknown well). When replicates are being treated 
collectively, the second set of sample data consists of all of the replicates. If the p-value exceeds 
the user-specified confidence level, the well/dye is called as positive and signified with a plus 
sign (+); otherwise, the well is called as negative (no difference detected) and signified with a 
minus sign (–). The Confidence level is displayed on the command panel. This value may be 
changed using the Analysis Term Settings dialog box.. 

Analysis Options 

p-Values and Final Calls Based On 

Under p-values and final calls based on, specify the form of the fluorescence data to be used in 
calculating the p-values used for making final calls.  

 

Available fluorescence data types are:  

Data Type How Calculated 

Rpre initial fluorescence (use also for single reading initiated with Pre-Read) 
Rpost final fluorescence (use also for single reading initiated with Post-Read) 
Rn,pre initial fluorescence (use also for single reading initiated with Pre-Read) 
Rn,post normalized final fluorescence (use also for single reading initiated with 

Post-Read) 
Rpost–Rpre total change in fluorescence (final fluorescence minus initial 

fluorescence) 
Rn,post–Rn,pre total change in normalized fluorescence (normalized final fluorescence 

minus normalized initial fluorescence) 
Rpost/Rpre fold-change in fluorescence (final fluorescence divided by initial 

fluorescence) 

Note that if no reference dye has been assigned to the wells and a normalized data type (Rn) is 
selected, a No Ref error designation will replace the final call entry on the plate. 
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Quantitative Plate Read Text Report 

The Text Report screen shows the data from a run in text format.  

 

Analysis Options 

p-Values and Final Calls Based On 

 

Under p-values and final calls based on, specify the form of the fluorescence data to be used in 
calculating the p-values used for making final calls.  
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Available fluorescence data types are:  

Data Type How Calculated 

Rpre initial fluorescence (use also for single reading initiated with Pre-Read) 
Rpost final fluorescence (use also for single reading initiated with Post-Read) 
Rn,pre normalized initial fluorescence (use also for single reading initiated with 

Pre-Read) 
Rn,post normalized final fluorescence (use also for single reading initiated with 

Post-Read) 
Rpost–Rpre total change in fluorescence (final fluorescence minus initial fluorescence) 
Rn,post–Rn,pre total change in normalized fluorescence (normalized final fluorescence 

minus normalized initial fluorescence) 
Rpost/Rpre fold-change in fluorescence (final fluorescence divided by initial 

fluorescence) 

Note that if no reference dye has been assigned to the wells and a normalized data type (Rn) is 
selected, a No Reference error designation will replace the p-value and final call entries in the 
report. 

Display Options 

Columns Included in the Report 
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Select the Columns to be included in the text report by checking the boxes next to the column 
names. To exclude columns that are selected by default, click on the check box to deselect the 
column name. To select all columns to display, click Select All. The default settings for column 
selection can be restored by expanding the Defaults menu and then clicking Get. 

If the included columns will not fit in the screen, a horizontal scroll bar appears at the bottom of 
the window to allow horizontal scrolling. 

Column Width 

To facilitate viewing data, columns can be automatically sized. Clicking the Contents Only 
button will cause each column to be automatically resized to the width of the widest data cell in 
that column (some column headers may be only partially displayed using this setting). Clicking 
the Hdr & Contents button will cause each column to be resized to the widest cell in that column, 
including the header cell. 

Columns can also be resized manually by dragging the column dividers with the mouse.  

Exporting Text Report Data 

Text report data can be exported from the application in text, Microsoft Excel spreadsheet or 
XML format for analysis. Text report exporting options are available from the File menu. See 
Exporting Data to Other Applications in the File Menu section for more information. 
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Mx3000P System Experiments: Plate 
Read/Allele Discrimination 
The Plate Read/Allele Discrimination Experiment Type 
The Plate Read/Allele Discrimination experiment type is used both for general plate-reading tasks 
and for allele discrimination assays with endpoint detection. In both cases, samples may be 
called as positive or negative for the presence of a specific sequence based on whether the 
endpoint fluorescence readings meet user-defined statistical criteria.   

This experiment type may be used for any application that requires a single round of plate 
readings or pre- and post-cycling readings collected at a single temperature. The simplest 
application of the plate read function of the Mx3000P instrument is qualitative detection, or 
detection of the presence or absence of a specific PCR product. In experiments of this type, a 
fluorogenic probe is added to PCR reactions along with the other PCR components. PCR is 
carried out on any thermal cycler and then the fluorescence is detected at the end of cycling 
using the plate read mode of the Mx3000P instrument. This reading provides a measure of the 
amount of specific product that has accumulated at the end of the PCR reaction and can be used 
to detect the presence or absence of a particular sequence. Note that plate read measurements are 
taken at a phase in PCR amplification where the amplification efficiency can be influenced by 
limiting reagents, small differences in reaction components, or cycling conditions and do not 
provide an accurate quantification of starting copy number of a target sequence. 

The Allele Discrimination assay with endpoint detection is a commonly used application of the 
plate read function of the Mx3000P system. For example, two fluorogenic probes, labeled with 
two spectrally distinct dyes, might be used to discriminate between the wild-type allele and a 
mutant allele. If Fluorescence of the unknown DNA sample is statistically higher than 
background for the dye identifying the wild-type allele but not for the dye identifying the mutant 
allele, the sample can be designated as wild-type homozygous. If Fluorescence is above 
background for the dye identifying the mutant allele but not for the dye identifying the wild-type 
allele, the sample can be designated as mutant homozygous. If the sample generates intermediate 
values for both dyes, it is designated as heterozygous for the two alleles. Results are 
conveniently displayed to highlight the allelic composition of the samples on the Dual Color 
Scatter Plot, the Fluorescence Intensity Values and the Final Call Results analysis screens. 

The Mx3000P system also features the Allele Discrimination/SNP's Real Time experiment type, 
which should be used for allele discrimination assays that require maximum accuracy and 
sensitivity. 
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Plate Read/Allele Discrimination Plate Setup 
In the Setup section of the software, open the Plate Setup tab. Shown below is a typical plate 
setup for an allele discrimination assay performed using a Plate Read/Allele Discrimination 
experiment. 

 

The Mx3000P software features several shortcuts to expedite plate setup including the ability to 
Import an existing setup, to use a Default setup, and to rapidly specify collection of data for all 
dyes in all wells by using Quick Setup. 

Note  In order for the Mx3000P software to calculate p-values for positive or negative calling 
in Unknown wells, the Plate Read/Allele Discrimination experiment must include at least 
three NTC or dye-specific negative control wells for each dye. 

Plate Setup is accomplished using the selection boxes and commands on the command panel at 
the right of the screen. The command panel is designed to be followed in a top-to-bottom order, 
beginning with Well type assignment. All other selections are unavailable until after Well type 
has been assigned. 
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Select the well(s) to be assigned using the mouse then assign the well(s) by using the Well type 
menu on the command panel. The well types available in an Allele Discrimination Plate Read 
experiment are described in the table below. 

Well Type Description 
Unknown  Contains a complete reaction mixture including a test template that contains 

an unknown amount of the specific target. 
Buffer Contains only buffer, used to monitor the background fluorescence 

attributable to the buffer. 
NAC No amplification control; contains all reaction components except DNA 

polymerase. 
NPC No probe control; contains all reaction components except the fluorescence-

labeled probe. 
NTC No template control; contains all reaction components except the template 

nucleic acid. 
No RT No reverse transcriptase control; contains all QRT-PCR reaction 

components except reverse transcriptase. 
Not in Use Optional designation for wells that are not in use. It is not necessary to 

define any unused wells. This well type is equivalent to an unassigned well. 
Dye-specific 
Negative Control 

Contains all reaction components except the template or target sequence 
detected with the specified dye. Negative control well types available 
correspond to the dyes defined in Optics Configuration.  

Dye-specific 
Positive Control 

Contains all reaction components including template known to be positive 
for the target sequence that is detected with the specified dye. Positive 
control well types available correspond to the dyes defined in Optics 
Configuration.  

 

After assigning the Well type to the selected well(s), select the dyes for which data should be 
collected in the wells using the Collect fluorescence data check boxes.  

If you are using a passive reference dye in the selected well(s) select the dye from the Reference 
dye menu. If all sample wells on the plate will contain the same passive reference dye, depress 
the All wells button. 

Assign the replicate set number to the selected well(s) by using the Replicate symbol menu. 
Instead of assigning replicate numbers to wells on an individual basis, it is also possible to assign 
replicates sequentially using the Auto-Increment feature. 

To run the experiment, set the read properties and then click Start Run to initiate the run. 
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Plate Read/Allele Discrimination Data Analysis 

Analysis Setup 

On the Analysis Selection/Setup screen: 

1. Select the wells to be included in the analysis. 

2. Specify the desired analysis settings on the command panel. (Algorithm Enhancements 
apply only to real-time experiments and the settings in this section are unavailable for 
plate read experiments.) 

 

See Analysis Selection/Setup for more detailed instructions on using the features on this screen. 

When all selections and settings are made, click the Results tab. One of several available results 
screens will appear. Use the radio buttons under Area to analyze to navigate to different analysis 
screens. The following screens are available for Plate Read/Allele Discrimination analysis: 
Plate Sample Values 
Dual Color Scatter Plot 
Fluorescence Intensity Values 
Final Call Results 
Text Report
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Plate Read/Allele Discrimination Plate Sample Values 
The Plate Sample Values screen displays fluorescence values for the sampled wells in a plate 
format. 

In each well with a well type assigned, the following information is shown:  
• Well type 
• Fluorescence value for each dye for which data was collected 
• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 

underlined) 
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Analysis Options 

Select the type of fluorescence data to be displayed from the Fluorescence menu on the command 
panel. Available fluorescence data types are:  

Data Type How Calculated 

Rpre initial fluorescence (use also for single reading initiated with Pre-Read) 
Rpost final fluorescence (use also for single reading initiated with Post-Read) 
Rn,pre normalized initial fluorescence (use also for single reading initiated with 

Pre-Read)  
Rn,post normalized final fluorescence (use also for single reading initiated with  

Post-Read) 
Rpost–Rpre total change in fluorescence (final fluorescence minus initial fluorescence) 
Rn,post–Rn,pre total change in normalized fluorescence (normalized final fluorescence 

minus normalized initial fluorescence) 
Rpost/Rpre fold-change in fluorescence (final fluorescence divided by initial 

fluorescence) 
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Plate Read/Allele Discrimination Dual Color Scatter Plot  
The Dual Color Scatter Plot screen is useful to compare the final quantities of two different 
targets (represented by two different dyes) in the same well. This form of analysis is especially 
useful for allele discrimination experiments, where the quantity of each of two possible alleles is 
indicated by a different dye.   

Each plotted point represents the coordinates of the fluorescence values for two dyes in a single 
well. For example, the X-axis may correspond to TET fluorescence while the Y-axis corresponds 
to FAM fluorescence and the plotted point (x,y) corresponds to the coordinates describing the 
two fluorescence values determined for a given well. The position of the data point for a given 
well on the scatter plot indicates the presence or absence of each allele. Colored rectangles on the 
plot are used to group wells with a common genotype (allelic composition). The shapes of the 
genotype-marking rectangles may be changed, and individual data points may also be excluded 
from the genotype group. The two alleles may be named on this screen, with the user-provided 
allele names reflected in the genotype descriptions of the wells on this and other Results screens. 
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Analysis Options 

Fluorescence Data Type Plotted 

Select the type of fluorescence data to be plotted from the Fluorescence menu on the command 
panel. Available fluorescence data types are:  

Data Type How Calculated 

Rpre initial fluorescence (use also for single reading initiated with Pre-Read) 
Rpost final fluorescence (use also for single reading initiated with Post-Read) 
Rn,pre normalized initial fluorescence (use also for single reading initiated with 

Pre-Read)  
Rn,post normalized final fluorescence (use also for single reading initiated with 

Post-Read) 
Rpost–Rpre total change in fluorescence (final fluorescence minus initial fluorescence) 
Rn,post–Rn,pre total change in normalized fluorescence (normalized final fluorescence 

minus normalized initial fluorescence) 
Rpost/Rpre fold-change in fluorescence (final fluorescence divided by initial 

fluorescence) 
Note that if no reference dye has been assigned to the wells and a normalized data type (Rn) is 
selected, a message like the following will appear below the graph: 

 

Allele Associations  

The Allele associations section of the command panel is used to identify the association between 
each of the plotted dyes and the allele detected by the dye. The allele/dye specified in the top 
menu will be plotted on the X axis, and the allele/dye specified in the bottom menu will be 
plotted on the Y axis. Any two dyes assigned during Plate Setup may be selected in these menus. 

 

By default, alleles are named Allele A and Allele B. The allele names also correspond to the 
genotypes assigned to wells in which a single allele is detected. Both is the default name for the 
genotype group in which both alleles are detected. Each of these allele/genotype names may be 
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changed to user-specified names by clicking Rename Alleles/Genotypes. When the following 
dialog box appears, enter the desired allele/genotype names and then click OK.  

 

The new allele names will appear in the Allele associations section of the command panel. The 
specified allele or genotype names are also displayed on some other Results screens. 

Display Options 

Display of Genotype Groups on the Scatter Plot 

Wells with a common genotype (allelic composition) are grouped on the scatter plot in color-
coded rectangles. The genotype corresponding to each group is indicated in the graph legend (see 
Graph Properties below). If a single allele was detected in a well, the genotype designation 
corresponds to the allele name. If both alleles were detected, the genotype is designated Both by 
default; this designation may be changed by clicking Rename Alleles/Genotypes on the command 
panel. If neither allele was detected, the genotype is designated None.  

The size and shape of each rectangle may be changed by dragging any side of the rectangle with 
the mouse. The color of the rectangle and the enclosed group of data points may be changed for 
any genotype by double-clicking on the genotype’s entry in the legend. 

Note  The size and shape of a rectangle does not convey information about dye intensity, data 
quality, or any other measured data attribute. The rectangles are only intended to identify 
and group the data points which fit the positive/negative calling result criteria that define 
each genotype. 

Any well may be manually excluded from the genotype groups by double-clicking on the data 
point for the well. The following dialog box will appear.  

 

Once Yes is selected, the symbol for the affected data point will change to the color and point 
style assigned to excluded data points. In addition, the Genotype for the well will change in the 
Text Report. 
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To restore any manually removed data points to their original genotype assignments, click Reset 
Genotypes on the command panel.  

 

Graph Properties 

The Graph Properties dialog box, accessed by double-clicking on the graph, controls several 
display features including whether the legend is shown or hidden and the attributes of the axes. 
See Graphs and Graph Properties for more information. 

To display information about a specific data point on the scatter plot, place the cursor over the 
point of interest. (Note that Display tooltips must be selected on the Display tab of the Preferences 
dialog box in order for the well information to be displayed.) 
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Plate Read/Allele Discrimination Fluorescence Intensity 
Values 

The Fluorescence Intensity Values screen displays a colorized image of final calls and 
fluorescence intensities. A plus sign (+) indicates a positive call and a minus sign (–) indicates a 
negative call.  

A spectrum of colors, displayed at the bottom of the screen, is used to indicate the relative 
fluorescence readings for each dye in each well. 

 The circle for each well is divided into arcs which correspond to the dyes selected for analysis in 
the Analysis Selection/Setup screen. An R in a portion of the circle indicates that portion refers to 
a reference dye. The replicate set number, if any, appears in the lower right corner of the well. 

 

Interpreting the Intensity Values Display 

The accumulation of product can be interpolated by comparing the color in the arc to the 
horizontal color bar at the bottom of the screen. On the color bar, as fluorescence values 
increase, the corresponding color shifts from blue towards red. Note that the bar only covers the 
fluorescence range measured on the plate. For example, in the example shown above, the range 
of fluorescence measured in the run was between 3857 and 21946, and this is the range that is 
covered by the color bar. 
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Interpreting Final Calls 

The p-value is the probability that the mean of one set of sample data is different from the mean 
of another set of sample data. The first set of sample data is always the control wells in the 
analysis selection. When replicates are being treated individually, the second set of sample data 
consists of a single well (usually an Unknown well). When replicates are being treated 
collectively, the second set of sample data consists of all of the replicates. If the p-value exceeds 
the user-specified confidence level, the well/dye is called as positive and signified with a plus 
sign (+); otherwise, the well is called as negative (no difference detected) and signified with a 
minus sign (–). The confidence level for positive calling is displayed on the command panel. 
This value may be changed using the Analysis Term Settings dialog box that may be accessed by 
clicking the corresponding button on the Analysis Selection/Setup screen. 

Analysis Options 

Fluorescence Data Type Displayed and Used for Calculations 

Under p-values and final calls based on, specify the form of the fluorescence data to be 
displayed and used in calculating the p-values used for making final calls.  

 

Available fluorescence data types are:  

Data Type How Calculated 

Rpre initial fluorescence (use also for single reading initiated with Pre-
Read) 

Rpost final fluorescence (use also for single reading initiated with Post-
Read) 

Rn,pre normalized initial fluorescence (use also for single reading initiated 
with Pre-Read)  

Rn,post normalized final fluorescence (use also for single reading initiated 
with Post-Read) 

Rpost–Rpre total change in fluorescence (final fluorescence minus initial 
fluorescence) 

Rn,post–Rn,pre total change in normalized fluorescence (normalized final 
fluorescence minus normalized initial fluorescence) 

Rpost/Rpre fold-change in fluorescence (final fluorescence divided by initial 
fluorescence) 
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Display Options 

Adjusting the Fluorescence Intensity Range 

 

The range of fluorescence intensity covered by the color spectrum can be manually specified by 
clicking the Edit False Color Limits button to open the False Color Limits dialog box. The 
minimum value for the Low Fluorescence Limit is 0 and the maximum value for the High 
Fluorescence Limit is 65535. A range of at least 4 must be specified. Manually specifying a 
narrow range of values is helpful when attempting to discern small differences in fluorescence 
values among samples. 

 

False Colors Versus Grayscale 

By default, the Mx3000P software uses a multi-hued spectrum of colors to depict differences in 
fluorescence values on this screen. The depiction may be changed to grayscale by deselecting the 
Use false colors checkbox. All colors will turn to shades of gray and the color bar will display a 
gradient of gray from black (lowest fluorescence) to white (highest fluorescence). 
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Plate Read/Allele Discrimination Final Call Results 

The Final Call Results screen provides a simple depiction of whether product was accumulated 
for each dye in each well in a plate format. A plus sign (+) signifies detection of product 
accumulation for the indicated dye, while a minus sign (–) signifies that product accumulation 
was not detected. See below for more information on how final calls are made.  

In each well with a well type assigned, the following information is shown:  
• Well type 
• The final call for each dye for which data was collected. [For all well types, the reference 

dye (Ref) is not associated with a final call] 
• Replicate symbol, if used (when replicates are treated collectively, the replicate symbol is 

underlined) 
The allele associated with each dye is shown under Allele associations on the command panel. 
Allele names may be changed on the Dual color scatter plot screen. 
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Interpreting Final Calls 

The p-value is the probability that the mean of one set of sample data is different from the mean 
of another set of sample data. The first set of sample data is always the control wells in the 
analysis selection. When replicates are being treated individually, the second set of sample data 
consists of a single well (usually an Unknown well). When replicates are being treated 
collectively, the second set of sample data consists of all of the replicates. If the p-value exceeds 
the user-specified confidence level, the well/dye is called as positive and signified with a plus 
sign (+); otherwise, the well is called as negative (no difference detected) and signified with a 
minus sign (–). The Confidence level is displayed on the command panel. This value may be 
changed using the Analysis Term Settings dialog box.. 

Analysis Options 

p-Values and Final Calls Based On 

Under p-values and final calls based on, specify the form of the fluorescence data to be used in 
calculating the p-values used for making final calls.  

 

Available fluorescence data types are:  

Data Type How Calculated 

Rpre initial fluorescence (use also for single reading initiated with Pre-Read) 
Rpost final fluorescence (use also for single reading initiated with Post-Read) 
Rn,pre normalized initial fluorescence (use also for single reading initiated with 

Pre-Read)  
Rn,post normalized final fluorescence (use also for single reading initiated with 

Post-Read) 
Rpost–Rpre total change in fluorescence (final fluorescence minus initial 

fluorescence) 
Rn,post–Rn,pre total change in normalized fluorescence (normalized final fluorescence 

minus normalized initial fluorescence) 
Rpost/Rpre fold-change in fluorescence (final fluorescence divided by initial 

fluorescence) 

Note that if no reference dye has been assigned to the wells and a normalized data type (Rn) is 
selected, a No Ref error designation will replace the final call entry on the plate. 
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Plate Read/Allele Discrimination Text Report 

The Text Report screen shows the data from a run in text format.  

 

Analysis Options 

p-Values and Final Calls Based On 

 

Under p-values and final calls based on, specify the form of the fluorescence data to be used in 
calculating the p-values used for making final calls.  
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Available fluorescence data types are:  

Data Type How Calculated 

Rpre initial fluorescence  (use also for single reading initiated with Pre-Read) 
Rpost final fluorescence (use also for single reading initiated with Post-Read) 
Rn,pre normalized initial fluorescence (use also for single reading initiated with 

Pre-Read) 
Rn,post normalized final fluorescence (use also for single reading initiated with Post-

Read) 
Rpost–Rpre total change in fluorescence (final fluorescence minus initial fluorescence) 
Rn,post–Rn,pre total change in normalized fluorescence (normalized final fluorescence 

minus normalized initial fluorescence) 
Rpost/Rpre fold-change in fluorescence (final fluorescence divided by initial 

fluorescence) 

Note that if no reference dye has been assigned to the wells and a normalized data type (Rn) is 
selected, a No Reference error designation will replace the p-value and final call entries in the 
report. 

Display Options 

Columns Included in the Report 

 

Select the Columns to be included in the text report by checking the boxes next to the column 
names. To exclude columns that are selected by default, click on the check box to deselect the 
column name. To select all columns to display, click Select All. The default settings for column 
selection can be restored by expanding the Defaults menu and then clicking Get. 
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If the included columns will not fit in the screen, a horizontal scroll bar appears at the bottom of 
the window to allow horizontal scrolling. 

Column Width 

To facilitate viewing data, columns can be automatically sized. Clicking the Contents Only 
button will cause each column to be automatically resized to the width of the widest data cell in 
that column (some column headers may be only partially displayed using this setting). Clicking 
the Hdr & Contents button will cause each column to be resized to the widest cell in that column, 
including the header cell. 

Columns can also be resized manually by dragging the column dividers with the mouse.  

Exporting Text Report Data 

Text report data can be exported from the application in text, Microsoft Excel spreadsheet or 
XML format for analysis. Text report exporting options are available from the File menu. See 
Exporting Data to Other Applications in the File Menu section for more information. 
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Maintaining the Mx3000P Instrument 
Hardware Information 

Replacement Parts 

It is important to use only Stratagene-supplied replacement parts in the maintenance of the 
Mx3000P system (excluding fuses). 

Fuses  

The Mx3000P instrument uses a single slow-acting fuse. The fuse housing is located adjacent to 
the power cord inlet in the power entry module.  

To replace the fuse, disconnect the Mx3000P instrument from the power source, open the fuse 
housing cover and remove the fuse holder from the power entry module. Replace the fuse with 
the appropriate fuse type from the table below, and then replace the fuse holder.  
Instrument Type (Voltage) Replacement Fuse 

110-V 10-A, 250-V, 5×20-mm slow-acting fuse 

230-V  5-A, 250-V, 5×20-mm slow-acting fuse 

Warning:  High voltage present. Turn off the power switch and remove the power cord from 
the power entry module prior to replacing the fuse.   
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Changing the Lamp 
The lamp of the Mx3000P system has an average life expectancy of 2000 hours. Replacement 
bulb assemblies are available from Stratagene (Catalog #401411). 

Important: Never touch the glass portions of the quartz-tungsten halogen lamp! 

The lamp is located in the excitation housing, on the left-hand side of the instrument. Before 
changing the lamp, be sure to turn off the instrument. The lamp is replaced, along with the lamp 
housing, as follows: 

1.   Remove the two screws securing the excitation housing cover panel and remove the panel. 

2.   Disconnect the wire connector for the lamp housing. This is located near the bottom of the 
module towards the front of the instrument. 

3.   Loosen the thumbscrew that holds the lamp housing in the excitation module. 

4.   Remove the old lamp housing and lamp. 

5.   Insert the new lamp housing and lamp. A keyway on the lamp housing allows the housing to 
be placed in its holder in only one orientation. Push the housing in as far as it will go. 

6.   Tighten the thumbscrew. 

7.   Connect the wire connector. 

8.   Replace the cover panel and the two cover screws.  

9.  After the lamp has been changed, reset the lamp timer to 0. To do this, access the Lamp Reset 
and Utilities dialog box (from the Instrument  menu) and click the Reset button. The Total 
time will be set to 0 and the current date will be entered in the Last date reset field. 

Cleaning the Instrument 
Clean the exterior housing of the Mx3000P system using only mild soap and warm water on a 
soft cloth. Do not use alcohol or solvent-based cleaners. 
The wells of the thermal block should be cleaned with cotton swabs and isopropyl alcohol. 
Ensure the block is at room temperature before cleaning.  
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Appendix 
Mx3000P System Troubleshooting 

Observation Suggestion 

“Communication Error” 
appears in software 

Instrument has not finished warming up, wait for both front panel 
LED’s to become steady lights and for the instrument 
communication icon in the bottom right corner of the screen to 
turn from red to green. 

Verify that the Mx3000P instrument is powered on. 

Verify that the RS-232 cable between the PC and Mx3000P 
instrument is attached. If the "Communication Error” warning 
persists, connect the cable to the other USB port on the PC. 

Lamp On or other 
instrument-related software 
commands are not 
available  

Make sure the software version running is not a Standalone 
version. If using software installed for analysis only or if multiple 
copies of the software are open, Standalone will appear in the 
upper left corner of the Mx3000P software title bar.  

When communication between the PC and the instrument is 
established, the communication icon in the lower right corner is 
green. 

Software locks up or shuts 
down during a run 

Turn off the sleep mode for the monitor and disable the screen 
saver. This can be accessed in the Microsoft Windows software 
Control Panel. 

Lower LED power indicator 
light never comes on 

Verify that the instrument is plugged into the power source or 
surge protector and that power is getting to the instrument. 

Check fuse on back panel near the power cord. If fuse is burned 
out, replace the fuse. See Fuses for more information. 

After switching on the 
instrument, the upper LED 
status indicator light does 
not indicate Ready status 
(steadily lit) 

During instrument power-up, the upper LED should remain off for 
2-3 minutes while the instrument warms up. The instrument will 
perform a self-test, which is indicated by a blinking upper LED. If 
the LED does not light continuously after the self-test is 
completed, reboot the instrument (power off the instrument, wait 
30 seconds, and then switch the instrument power on). If this 
does not address the problem, contact Stratagene Technical 
Services.  

Very low amplification 
signal 

May indicate that the lamp is starting to fail. Check lamp, and 
replace if necessary. See Changing the Lamp. 
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Sudden amplification 
signal loss or downward 
drift during run 

Check lamp, replace if necessary. See Changing the Lamp. 

Signal fluctuates during run Check lamp, replace if necessary. See Changing the Lamp. 

Verify that the fluorescence signal is below the recommended maximum 
of 35000. If necessary, adjust the Filter Gain Settings to bring the 
signal into the recommended range. 

Consistently unexpected 
results in one sample 

Check the sample container for contaminating material. 

Check optical clarity of sample container cap. 

Clean the thermal block. 

Decreased volume in 
sample containers at end 
of run 

Sample containers are not vapor tight. Ensure caps are tightly 
sealed and containers are not malformed. 

Software font difficult to 
read/Poor resolution of text 

Microsoft Windows software display settings are incorrect. 
Required minimum settings are 16 bit high color and 1024x768 
resolution. 

Chart printing is low quality Check the status of the High resolution chart printing option on the
Print Page Setup dialog box. Chart printing using most printers 
will be enhanced by selecting the High resolution chart printing 
option.  Limitations of certain printer drivers cause 
incompatibilities with this setting; try deselecting the High 
resolution chart printing checkbox.  

Difficulty in manually 
setting baseline 

When running samples with a broad dynamic range, use the 
adaptive baseline algorithm.  

Increased signal noise for 
run 

Use the moving average algorithm.  

Ct value reported for NTC 
(no-target control) sample 
is less than the total 
number of cycles but the 
amplification plot curve is 
horizontal 

Examine variation in fluorescence intensity during the run. Review 
amplification plot and adjust the threshold accordingly. 
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Low increase in 
fluorescence with cycling 

The probe or beacon is not binding the target efficiently. Lower 
annealing temperature and verify melting temperature. 

Target PCR product is too long, redesign primers to yield a PCR 
product <150 bp in length. 

Magnesium concentration is too low; run a titration to optimize 
concentration. 

Insufficient or non-specific product, verify product formation 
through gel electrophoresis. 

Increase in fluorescence in 
control reactions without 
template 

The reaction has been contaminated. 

Excess condensation in 
reaction tubes 

When using single tubes or strip tubes, install the Perfect Fit frame 
on the thermal block to optimize contact between the sample 
tubes and the hot top. 

 

Mx3000P™ Real-Time PCR System 287 



Appendix 

Getting Support for the Mx3000P Real-Time PCR 
System 
Email: tech_services@stratagene.com 

          QPCRSystemsSupport@stratagene.com 

World Wide Web: www.stratagene.com 
 

United States and Canada 
Stratagene 
11011 North Torrey Pines Road 
La Jolla, CA 92037 
USA 
Telephone: (858) 535-5400 
Order Toll Free: (800) 424-5444 
Technical Services: (800) 894-1304 

Europe 
Location Telephone Fax Technical Services 

Austria 0800 292 499 0800 292 496 0800 292 498 

00800 7000 7000 00800 7001 7001 00800 7400 7400 Belgium 

0800 15775 0800 15740 0800 15720 

00800 7000 7000 00800 7001 7001 00800 7400 7400 France 

0800 919 288 0800 919 287 0800 919 289 

00800 7000 7000 00800 7001 7001 00800 7400 7400 Germany 

0800 182 8232 0800 182 8231 0800 182 8234 

00800 7000 7000 00800 7001 7001 00800 7400 7400 Netherlands 

0800 023 0446 +31 (0)20 312 5700 0800 023 0448 

00800 7000 7000 00800 7001 7001 00800 7400 7400 Switzerland 

0800 563 080 0800 563 082 0800 563 081 

00800 7000 7000 00800 7001 7001 00800 7400 7400 United Kingdom 

0800 917 3282 0800 917 3283 0800 917 3281 

Japan Technical Services  
Telephone: 03-5159-2070 
Email: jtech@stratagene.com 

All Other Countries 

Please contact your local distributor. A complete list of distributors is available at 
www.stratagene.com. 
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QPCR Glossary 

Experiment Type and QPCR Detection Chemistry Terms 

Real-Time Experiments: Experiments that monitor and report the accumulation of PCR product, 
as detected by increased fluorescence, during thermal cycling. This allows data collection during 
the early exponential phase of PCR so that results may be calculated from Ct values. 

Plate-Read Experiments: A one-time fluorescence reading taken on a plate. Experiments can be 
performed including pre- and post- thermal cycling readings in the same experiment. Results are 
evaluated as + or –. 

Quantitative PCR Experiment Type: Experiments of this type typically use a standard curve to 
quantitate the amount of target present in an Unknown sample with high accuracy using a 
fluorescence-labeled probe for detection. A series of Standard samples, containing dilutions of a 
known amount of target, are amplified to generate a curve that relates the initial quantity of the 
specific target to the Ct. The standard curve is then used to derive the initial template quantity in 
Unknown wells based on their Ct values. This method is sometimes referred to as absolute 
quantitation or as standard-curve quantitation in the literature. This experiment type is also useful 
for primer/probe optimization experiments in the absence of a standard curve. 

Comparative Quantitation Experiment Type: This experiment type is a form of relative 
quantitation, comparing the levels of a target gene in test samples (referred to as Unknowns) 
relative to a sample of reference (referred to as the Calibrator). For example, the Calibrator 
sample might contain RNA from untreated cells, while the Unknowns might contain RNA from 
cells treated with different agents of interest. This experiment type provides an efficient method 
for comparing levels of RNA or DNA across samples when information about the absolute 
amounts of target in any sample is not required.  This method is used for establishing relative 
quantitation without the need for repeatedly performing a dilution series standard curve. 

SYBR Green Experiment Type: Experiments of this type typically use a standard curve to 
quantitate the amount of target present in an Unknown sample using SYBR Green I dye for 
detection. This experiment type is also useful for SYBR Green assay optimization experiments in 
the absence of a standard curve. The thermal profile includes a dissociation curve, used to 
discriminate between specific and non-specific PCR products.  

Allele Discrimination/SNP's Real Time Experiment Type: .This experiment type uses fluorescence-
labeled probes to determine the allelic composition of DNA samples. Two fluorogenic probes, 
labeled with two spectrally distinct dyes, are used to discriminate between two different alleles 
that may differ by as little as a single nucleotide. The presence or absence of a given allele is 
based on the Ct value determined for the allele-specific probe.  

Molecular Beacon Melting Curve Experiment Type: This experiment type analyzes the melting 
characteristics of a molecular beacon for the determination of the experimental melting 
temperature (Tm) and optimal annealing temperature for subsequent PCR experiments. Melting 
curves are typically performed with the molecular beacon alone and in the presence of both 
perfectly-matched and mismatched oligonucleotide targets in order to determine the temperature 
that exhibits the best discrimination. 
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Plate Read/Allele Discrimination Experiment Type: This experiment type is used both for general 
plate-reading tasks and for allele discrimination assays with endpoint detection. In both cases, 
samples may be called as positive or negative for the presence of a specific sequence based on 
whether the endpoint fluorescence readings meet user-defined statistical criteria.   

Quantitative Plate Read: This experiment type uses a standard curve to estimate the amount of 
target present in an Unknown sample using a fluorescence-labeled probe for detection. A series 
of Standard samples, containing dilutions of a known amount of target, are included in the 
experiment to generate a curve that relates the quantity of the specific target to the final 
fluorescence reading. The standard curve is then used to estimate the template quantity in 
Unknown wells based on their fluorescence readings. 

Reference Dye: Passive dye used for normalization of the fluorescence signal of the reporter 
fluorophore. The reference dye fluoresces at a constant level during the reaction.  

Reporter Dye: Fluorescent dye that increases in fluorescence signal as the amount of PCR 
product increases. 

Normalizer: Available only in Comparative Quantitation to designate the dye corresponding to 
the target used for normalization of the fluorescence signal across samples. 

Molecular Beacon Probes: Hairpin-shaped fluorescence-labeled probes that can be used to 
monitor PCR product formation either during or after the amplification process. The free probe 
will maintain its hairpin structure, which causes the quenching of the fluorophore. In the bound 
form the fluorophore is separated from the quencher and is thereby able to fluoresce. 

TaqMan Probes: linear FRET fluorescence-labeled probes that can be used to monitor PCR 
product formation either during or after the amplification process. As the DNA polymerase 
extends the upstream primer and encounters the downstream probe, the exonuclease activity of 
the polymerase cleaves the probe. In this event, the reporter fluorophore is released into the 
reaction solution and is able to fluoresce. 

Quencher: a moiety that absorbs the energy of the reporter dye in its excited state. The quencher 
can emit its own fluorescence signal (TAMRA) or emit no fluorescence signal (DABCYL, 
BHQ). 

Well-Types 

Unknown: Contains a complete reaction mixture including a test template that contains an 
unknown amount of the specific target. 

Buffer: Contains only buffer, used to monitor the background fluorescence attributable to the 
buffer. 

NAC: No amplification control; contains all  reaction components except DNA polymerase. 

NPC: No probe control; contains all reaction components except the fluorescence-labeled probe. 

NTC: No template control; contains all reaction components except the template nucleic acid. 
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Standard: Contains a complete reaction mixture including a known concentration of target 
nucleic acid. Used to generate a standard curve, which is then used to relate the threshold cycle 
(Ct) to initial template quantity in Unknown wells. 

No RT: No reverse transcriptase control; contains all QRT-PCR reaction components except 
reverse transcriptase. 

Negative Control: Contains all reaction components except the template or target sequence 
detected with the specified dye. Negative control well types available correspond to the dyes 
defined in Optics Configuration. In allele discrimination experiments, Negative Control wells are 
used in combination with NTC wells to calculate positive and negative calls. 

Positive Control: Contains all reaction components including template known to be positive for 
the target sequence that is detected with the specified dye. Positive control well types available 
correspond to the dyes defined in Optics Configuration. Typically used in allele discrimination 
experiments to validate the reaction mixture. 

Calibrator: Available only in Comparative Quantitation as the reference sample to which 
Unknowns are compared. Contains a complete reaction mixture including a characterized target. 
The level of a gene of interest in the Calibrator wells  is set to 1.0  for comparison to the relative 
quantities in  Unknown samples. 

MBO: Available only in Molecular Beacon Melting Curve experiments. Sample type that contains 
the molecular beacon plus an oligonucleotide corresponding to its perfectly matched target. 

MB: Available only in Molecular Beacon Melting Curve experiments. Sample type that contains 
the molecular beacon only (in the absence of target). 

MBMO: Available only in Molecular Beacon Melting Curve experiments. Sample type that 
contains the molecular beacon plus an oligonucleotide corresponding to a  target with a single-
base mismatch. 

Analysis Terms 

Standard Curve: The Standard Curve is a plot of the initial template quantity added to standard 
wells on the X-axis, versus the Ct (threshold cycle) on the Y-axis. A best-fit curve is displayed 
for each dye with data collected in Standard wells.  

Amplification Plot: The Amplification Plots view shows a plot of cycles versus fluorescence for 
each ramp or plateau on which data are gathered. 

Dual Color Scatter Plot: The Dual Color Scatter Plot view is used to compare the amplification 
properties of two different targets (represented by two different dyes) in the same well. Each 
plotted point represents the coordinates of either the fluorescence values or threshold cycle (Ct) 
values for the two dyes in a single well.  

Initial Template Quantity: Provides interpolated quantities of template added to Unknown wells 
before thermal cycling. The quantities are interpolated from a standard curve based on the 
calculated Ct  values determined for the known quantities of template in the Standard wells.  
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Baseline Correction: For each well and each path the raw fluorescence data are fit over the 
specified range of cycles using a linear least mean squares algorithm to produce a baseline. The 
value of the baseline function is calculated for every cycle and subtracted from the raw 
fluorescence to produce the baseline corrected fluorescence (dR). 

Threshold Cycle (Ct): The cycle at which fluorescence is determined to be statistically significant 
above background signal contributed by the fluorescently labeled oligonucleotides within the 
PCR reaction. The threshold cycle is inversely proportional to the log of the initial copy number.  

Background Cycle Range: Specifies the range of cycles of fluorescence data the software uses to 
calculate the background noise level when using the Background-based threshold algorithm to 
set the threshold fluorescence. The region specified is typically in the cycle range before 
exponential amplification occurs. The standard deviation of the raw fluorescence for the 
specified cycles is calculated and is multiplied by the constant Sigma multiplier for threshold 
fluorescence. 

Replicates: Allows specifying sets of  replicated wells as the basis for the software to average 
results from those wells when the Treat Collectively setting is used. (Selecting Treat Individually 
in the Analysis Selection/Setup screen will cause the program to analyze each well independent 
of any replicate definitions.) 

Collective Replicate Treatment: Will cause the program to analyze all wells with the same 
replicate symbol as a group, effectively treating the measurements as all coming from the same 
well. 

R squared: The RSq value is an indication of the fit of the standard curve to the standard data 
points plotted. The value will always be between 0 and 1. The closer the value is to 1, the better 
the fit of the line. 

Sigma: Measurement of the variability (standard deviation) of the fluorescence measured from 
all wells and more than one cycle. Typically its value is determined from the first few cycles, 
before the PCR reaction starts to affect the measurement. The Sigma multiplier is a user-defined 
number that is used to multiply by sigma to create a threshold value for determination of Ct. 

p-value: The probability that the mean of one set of sample data is different than the mean of 
another set of sample data. The first set of sample data is always the control wells in the analysis 
selection. When replicates are being treated individually, the second set of sample data consists 
of a single well (usually an Unknown well). When replicates are being treated collectively, the 
second set of sample data consists of all of the replicates. If the p-value exceeds the user-
specified confidence level, the well/dye is given a (+) call, whereas if the p-value does not 
exceed the user-specified confidence level, the well/dye is given a (–) call. 

Confidence Level: The user-defined confidence level for calls is the statistical probability 
required before the algorithm will call amplification occurrence in a well. The default is 99%. 

Multicomponent: A term used for distinguishing the contribution that each dye and the 
background makes to the total fluorescence spectra detected. 
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Fluorescence Data Terms 

R: fluorescence reading in arbitrary units 

dR: baseline subtracted fluorescence reading 

Rn: fluorescence reading normalized to the reference dye 

dRn: baseline subtracted fluorescence reading normalized to the reference dye 

R Last: the final fluorescence reading in a real-time experiment 

dR Last: the final fluorescence reading minus the initial fluorescence reading in a real-time 
experiment 

Rn Last: the final fluorescence normalized to a reference dye in a real-time experiment  

dRn Last: the normalized final fluorescence reading minus the normalized first fluorescence 
reading in a real-time experiment 

R Last/R First: the final fluorescence reading divided by the initial fluorescence reading in a real-
time experiment 

Rpre: initial fluorescence reading in a plate-read experiment 

Rpost: final fluorescence reading in a plate-read experiment 

Rn, pre: fluorescence before thermal cycling normalized to the reference dye in a plate-read 
experiment 

Rn, post: fluorescence after thermal cycling normalized to the reference dye in a plate-read 
experiment 

Rpost–Rpre: the total change in fluorescence in a plate-read experiment 

Rn, post–Rn, pre: the total change in normalized fluorescence in a plate-read experiment 

Rpost/Rpre: the final fluorescence reading divided by the initial fluorescence reading in a plate-
read experiment 
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Selected QPCR Links 

Stratagene Webpages 

www.Mx3000P.com 

Stratagene QPCR Links (Provides links for primer/probe design applications and links for other 
QPCR-related topics.) 

Stratagene Lab Tools (See the PCR Designer section.) 

Stratagene QPCR Products 

Other Websites 

http://www-genome.wi.mit.edu/cgi-bin/primer/primer3_www.cgi 

http://www.pitt.edu/~rsup/oligocalc.html 

http://searchlauncher.bcm.tmc.edu/ 

http://www.ncbi.nlm.nih.gov/blast/ 
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Trademark Information 
Mx4000® and PicoFuge® are registered trademarks of Stratagene in the United States. 

Mx3000P is a trademark of Stratagene. 

SYBR® is a registered trademark of Molecular Probes, Inc. 

TaqMan® is a registered trademark of Roche Molecular Systems, Inc. 

Microsoft®, Outlook®, PowerPoint® and Windows® are registered trademarks of Microsoft 
Corporation. 
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